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1 Introduction to Hydro GeoAnalyst

Hydro GeoAnalyst (HGA) is the most comprehensive, and yet easy-to-use, environmental
data management system, providing data validation, analysis, and visualization. The HGA
package integrates a list of flexible and customizable database structures used around the
world, complimented by state-of-the-art tools for data interpretation, statistical analysis, GIS
mapping, data charting, and two- and three-dimensional visualizations.

For most environment-related projects, whether they are contaminated sites or municipal
water supply projects, there is often an abundance of data that has been collected over the
years. How many times have you had to sift through several paper reports for that one piece
of information when compiling monthly summaries on a project? Can you be sure that you
have not misplaced a report or failed to mention an important piece of data?

The HGA package addresses these and many other needs in the industry. The system
enables you to create a project specific database, or enhance and build upon your existing
database. It can collect all of your previous data and reports and consolidate them into a
powerful relational database system that can be queried and referenced with ease.

HGA operates as a desktop application based on Microsoft SQL Server technology. 

Some typical applications for HGA include:

· Regional water well management
· Contaminant site inventory
· Regulatory compliance
· Geologic cross sections
· Public access to information
· Environmental site assessment
· Monitored natural attenuation
· Regional aquifer characterization and management
· Cross-boundary data sharing
· Aquifer vulnerability mapping

HGA is implemented through a number of modules, each performing a specific task. This
approach allows HGA to be memory efficient, flexible, and expandable. 

The following modules are for the purposes of Data Management: 
· Template Manager 
· Data Transfer System 
· EDD Workflow
· Event Planning
· Query Builder 
· Lab QA/QC 
· List Editor 
· Material Specification 

Interpretation of geologic and hydrogeologic data is made easy with the visualization modules
that are provided in HGA. Using these tools, raw data can be transformed into meaningful
spatial data sets. HGA offers a collection of standard and custom modules for interpreting
vast amounts of spatial data. Some of these modules are briefly described in the following
sections.The following modules are for the purposes of Analysis and Visualization: 
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· Time Series Plot 
· Well Profile 
· Map Manager 
· Cross Section Editor 
· Scene Viewer 
· Online Sharing

Additionally, HGA has several options for generating reports from the various modules. 

1.1 Installation and Licensing
For information regarding the Installation and Licensing of HGA please refer to the HGA
Getting Started page.

If you have any problems with your particular system configuration, please make sure that
you followed the installation instructions precisely. If the problem is still unresolved, contact
your hardware experts. Finally, if you are still having trouble, you may consider contacting our
Support team support@waterloohydrogeolgic.com .

1.2 Updating Old Projects
HGA is fully compatible with projects created in earlier versions of HGA. The first time you
open a project from a previous version you may be prompted to convert your database to the
new format. A dialog similar to the one shown below will display.

At this time, you will have the option to create a back up copy of your database, which is 
highly recommended. 
Click the Yes button to create a back up copy of your database. Otherwise, click No to
continue with the database upgrade without creating a backup (Not Recommended).
Selecting the Cancel  button will cancel opening the project.

In addition, it is recommended that you create a backup of the "Projects" directory before you
open projects in the new version of HGA. This can be done using the options in "My
Computer", or "Windows Explorer".

Please Note: Waterloo Hydrogeologic is not responsible for any direct or indirect damages,
however caused, if project data has not been securely and independently backed up. You are
strongly encouraged to frequently back-up your HGA project folder and the SQL Server
database.

http://www.waterloohydrogeologic.com/resources/hydro-geoanalyst-resources/hydro-geoanalyst-getting-started
http://www.waterloohydrogeologic.com/resources/hydro-geoanalyst-resources/hydro-geoanalyst-getting-started
mailto:support@waterloohydrogeolgic.com
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2 Demo Project Tutorial

The Demo Project is loaded with data and saved outputs like queries, maps, cross sections
and more! This tutorial will show you how to install the Demo Project and then guide you
through it so you can become familiar with HGA and what you can accomplish with the
program!

You install the Demo Project from within the program by selecting Project / Install the Demo
Project (there is also an option to do this from the Start Page). 

Select the Data source type - the simplest option is the Local Database which is installed on
your machine when you install HGA. Simply select Waterloo as the instance and provide a
Database name (e.g. demo) and then select Finish to Install the Demo Project.

If you prefer you can install the Demo Project to other SQL Servers running on your machine
or network - but you must ensure you have appropriate permissions.

The Demo Project files will be installed to the location designated under Project / HGA
Settings (the Project tab). 
The default location is under Documents / Hydro GeoAnalyst.

Once the Demo Project is finished installing it will automatically open and you can see it is
populated with data.
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2.1 Navigating the Interface

General Tab Layout
The HGA interface includes a menu and toolbar on the top as well as a project tree to the left
and the data tabs on the right. Additionally several of the modules will launch as a tab. Within
HGA the concept of Stations is used throughout - these are simply a location - often including
an x and y coordinate. The Station Picker can be found below the Project Tree. 
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When first opening HGA the default window displays will appear. There are two tab groups
one with the Project Tree and Station Picker (on the left) and one with 4 tabs; Station List,
Station Data, Data Query, and Data Filter (on the right). The tabs provide you with different
ways of viewing the data in the database. 
However, the HGA interface is adjustable - you can change the layout to suit your needs. You
can find more information About the Interface and about the Adjustable Windows in the
Fundamental Concepts section of the help.

All spatial data in the Demo Project is projected according to the NAD1983 UTM Zone 17N
coordinate system. This information is defined during project creation and can be viewed by
selecting Project / Properties, from the menu.

The Project Tree can be easily expanded to see all the nodes and entities of the Demo
project. Take a moment to inspect the items under each node in the Project Tree. 

Station Groups
In HGA, stations can be sorted into groups allowing for efficient management and quick
retrieval of data stored in the database. All station groups created for a project are listed in
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the Project Tree under the Station Groups node. Double clicking on any of the branches
corresponding to a station group will load the Station List tab, and display the appropriate
stations belonging to that group.
In the Demo Project, there are several station groups (for example; All Stations, Boreholes,
Monitoring Wells etc.). 

There are three kinds of Station Groups in HGA:

 All Stations: This station group is in all projects and all stations that are entered
(imported or manually) into the project will be found in this station group. You can not delete
or rename this station group.

Static: Select one or more stations directly in the Station List tab, right-mouse click, and
select the Add to Station Group option from the pop up menu.

Dynamic: Using the query builder, define a more advanced search criteria, and build a
station group with those stations that satisfy the query criteria.

 Once the stations in a group are displayed, a number of operations can be applied based on
the selection. 
To find out more about Station Groups please refer to Station Groups. 

Sorting & Filtering Records

Using the sorting and filtering options, you can also select different views for the data. For
example, it may be helpful to view just the stations at specific elevation.

To do this:

• Double click the All Stations from the Station Groups branch of the tree
• Select the Elevation column in the Station List

This will sort the values in the elevation column from lowest to highest (arrow is displayed in
the column header) and you can see station GB-34 has the lowest elevation at 321.09m. If
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you select the Elevation column again it will sort the values from highest to lowest. And now
you will see that the highest elevation is 340.49m and this occurs at station GB-33.

Additionally you will find the first row in the data grids is a filter row. You may want to find all
the stations in your project that begin with GB. To do this enter GB in the filter row of the
Station Name column.

You will see that only the stations which name begin with GB are in the station list.

To clear the filter, simple select the   button in the Station name column. 
To get the stations back into the original order you can sort on the ID field. 

List Editor

For some fields - like Station Type - you will find there is a drop down menu you can select
from. This list is generated by the List Editor.
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The List Editor provides the ability to create and customize lists for just about any field -
allowing for efficient and effective data entry. A list in HGA may be considered as a lookup
table.
To find out more about how to use the List Editor to create and edit lists please refer to List
Editor.

Template Manager

If you are wondering about the different fields (columns) you are finding in the Station List and
Station Data tab and thinking you would like to be able to add new field - or make
adjustments to the existing fields (or tables) in your database - you can! This is done in the
Template Manager and you can find more information about this module here: Template
Manager.

Please be aware that the Template Manager is a very powerful tool and making changes to
the database structure can have impacts on your existing data and your ability to enter or
import new data. It is advisable that you have database management understanding to make
large scale changes to the database structure. However - for the purpose of this tutorial you
can play around within the Template Manager as much as you like to see the effects - as you
can always go back to the beginning of the tutorial and re-install the Demo Project which will
restore the project and all the data in it!

2.2 Entering Data
You can enter data into a project either manually one record (row) at a time or by importing
multiple records at a time.

Manual Data Entry
You can manually enter/edited data in the Station List, Station Data, or Non Station Data

tabs. To add a new record (or row) use the  button found at the top of the tabs. You can
edit existing data right within the data grids found in the tabs.



Demo Project Tutorial 9

© 2017 by Waterloo Hydrogeologic

You will notice that as soon as you move your cursor out of a newly created record or edited
record that the entire row is highlighted yellow. This means that the are edits that need to be
saved (use the save button at the top of the tab). 

If you need to delete a record you must highlight the entire row and then select the 
button.

Data Transfer System (DTS)
It may be more efficient to import the data using the Data Transfer System (DTS). 

The DTS give you several options for importing your data:
· General
· EDD
· Mobile EDD
· Chemical
· Diver
· LAS
· Images

For more details on how to import data using the DTS, please refer to Importing Data.

EDD Workflow
If you have several spreadsheets of data you need to import the EDD (Electronic Data
Deliverable) workflow would be your best choice. The EDD  workflow provides an efficient way
of getting validated data into HGA. The workflow includes the following three steps:

1. EDD Template Designer
2. HGA QuickChecker
3. EDD Import

Additionally, we also have an option to make your EDD mobile so you can use it on mobile
devices like tablets and smart phones.

For more details on the EDD Workflow please refer to EDD Workflow.

2.3 Querying
HGA goes beyond simply storing your data. HGA also provides practical search/query tools
to help you access and interact with your data, using the industry-standard 'Structured Query
Language' (SQL). Retrieving your data has never been easier! 

Query Builder

Several queries have been created for you in the Demo Project - they are saved in the Project
Tree. You will notice that you can group your queries into folders to make it easier to find the
query you are looking for. 
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To run a query and see the results simply double click on the query. For example, double
click on the Lithology query and you will see the results displayed on the Data Query tab.

The results of a query can be used in other modules - like Quality Control, 3D Interpolation,
Well Profile, Map Manager etc. or can be used to push to Excel or PowerPoint to create
tables, pivot tables, time series charts, or presentations for reporting purposes.
Review the option on the menu bar of the Data Query tab to discover all the options available
to you.

To understand how a query was designed, right-click on the desired query in the Project Tree
and select Edit Query. The Query Builder will open showing you the query design. Here for
example is the Lithology query:
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The fields you wish to see are in the Display Fields section and the conditions in the
Conditions section. For this query there is only a Source Condition - indicating that it should
only be run against the data associated with stations that are in the Boreholes station group.

Feel free to review the design of other queries to see what options are available to you. The
names and organization of the queries should give you an idea of their purpose. 

For more details on the Query Builder please refer to Query Builder

2.4 Review Lithology Data
Lithology data (intervals of soil/material found during the drilling process) is stored within the
Lithology table (Geologic Description category) within HGA. The different soil/material
encountered during drilling is associated with specific images when displaying this data within
modules (for example the Well Profile, Cross Section Editor and Scene Viewer). You may
have noticed the images when you ran the Lithology query in the previous section. You can
also review each individual station's lithology data by selecting the Station Data tab and then
selecting the Geologic Description category. By default the Lithology table is displayed and
the data for the currently selected station is shown. You can change the station by selecting
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another station name from within the Station Picker. Here for example is the lithology data
from station GB-05:

If you are having difficulties finding stations with lithology data try doubling clicking on the
Boreholes station group in the Project tree. This will activate the Station List tab and update it
with only the stations in the Boreholes station group. You will also see that the list of stations
in the Station Picker has been updated with these stations. Now go back to the Station Data
tab and go through the stations to review the lithology data.

The lithology data is stored as an interval with from and to depths along with the soil type and
other potential descriptions (color, odor etc).

The Demo Project within HGA is using the DIN 4023 specification for associating images to
the material stored in the soil type field of the lithology table. HGA comes with several
different specifications including:

· USCS
· USDA
· DIN 4023
· IAH
· Compton
· Dunham Carbonate Classification
· Shell Standard

However, you may find you want to create your own specifications that indicates the valid
soils/material and associated images for your project. You can do this within the Material
Specification module.

Material Specification

Select the Material Specifications option from the Modules menu, or click on the  
button in the main toolbar.
The Material Specifications Editor will appear as a tab as shown below.
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Here you can see the DIN 4023 specification used for the Demo Project including all the valid
soil/material names and the associated images.
You can review other specifications that are provided within HGA by selecting them from
Select a Specification drop down. For instance below is the USCS specification which uses
black and white images.
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The right side of the tab provides the options for creating a new specification as well as
editing an existing custom specification. When creating new specifications you can use
names and images from any existing specification by selecting them from the left side and
selecting the blue right arrow to copy them to your new custom specification. Or you can
create new names and use your own images.

Please Note: You are not able to edit the specifications that come with HGA - you can only
edit a custom made specification.

For more details on the Material Specification Editor please refer to Material Specifications
Editor.

2.5 Review Well Construction Data
Well Construction data is stored within several tables in HGA found under the Well
Construction category. If you haven't already done so - double click on the Boreholes station
group in the Project Tree. This will activate the Station List tab and update it with only the
stations in the Boreholes station group. You will also see that the list of stations in the
Station Picker has been updated with these stations. Now select the Station Data tab and
then select the Well Construction category from the the drop down. You will see there are
several tables in this Data Category including:

· Drilling Protocol
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· Casing
· Screen
· Annular Fill
· Monitoring Points
· Abandonment

For this Demo Project tutorial we will focus on the first four tables. 

Drilling Protocol - this table stores the information regarding the drilling of a station or well.
The from and to values are entered as depths and the diameter of the auger used for drilling is
entered. The method used to drill the hole can also be entered. A typical vertical well will
likely just have one record in this table. However, if you have an angled or deviated hole you
can have one or more records in this table. For example select station GB-09 from the station
picker and review the Drilling Protocol data for this station.

Here you will see there are two records showing the hole was drilling with an inclination of 30
degrees (and an azimuth of 25) for the first 50 m and then at an inclination of 40 degrees for
the second 50 m.

Casing - this table stores the information regarding the casing installed for your well. The
from and from values are entered as depths. The diameter and material of the casing can also
be entered. Some simple wells will only have a single record in this table - however, if you
have a cluster well (also known as a nested well) you can find multiple records in this table.
For example select station GB-01 from the station picker and review the Casing data for this
station.
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Here you will see there are three records. The first two records have the same Casing ID -
they belong to the same installation. That installation has a steel casing for the first 60 m and
then a PVC casing for the last 40 m. The third record has a different Casing ID - so this is a
separate installation. It is using Piezometer material, has a smaller diameter and only goes to
40 m. 

Screen - this table stores the information regarding the screen installed for your well. The
from and from values are entered as depths. You can see that station GB-01 has two
screens. One from 10 - 20m and a second one from 20 - 30m. These relate to the two
different casings mentioned above.

Annular Fill - this table stores the information regarding the annular fill (or backfill) for your
well. The from and to values are entered as depths. The Filling Type field is a list that is
maintained by the List Editor that includes not only the name of the filling type but also
images associated with the filling type.
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Feel free to review the different tables for the different stations to get familiar with the data.
However, it might be helpful to use the Well Profile module to visualize all this data. In fact
many people find it helpful to view the Well Profile while entering this data (if they need to
enter the data manually from old reports) as they can visualize the data as they enter it and
are more likely to notice typos and errors.

Well Profile

The Well Profile can be launched by selecting the  icon from the main toolbar or by
selecting Modules/Well Profile or by simply double clicking on an existing Well Profile
template found in the Project tree. It will be loaded with the last template that was used.

The Well Profile module can also be used as a data entry assistant in HGA, by displaying for
example the well construction details we just reviewed within the Station Data tab.

Select the  icon from the main toolbar now so that the Well Profile tab launches and
then select the Cluster Well Template from the dropdown. This is a simple template with only
a scale and a well construction column. It displays the data reviewed above for station GB-01
including the two different casing and two different screens.
Now select the edit button so the designer portion of the Well Profile is reveled. The designer
portion allows you to see and edit the settings for the columns within the template.
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Select the Well Construction branch of the Design Tree and all the setting for this column can
be found below. Select the Cluster wells option under the Data section to see how the casing
and screen settings allow for displaying this kind of data.

Let's take a look at another template - select the Well Construction TVD template from the
dropdown and then select GB-07 from the Station Picker. You will notice under the Columns
section the option for Display True Vertical Depth has been set to Yes for this template. This
will automatically calculate the True (actual) Vertical Depth based on the inclination values
entered in the Drilling protocol table.
As mentioned above - it can be helpful to view the Well Profile at the same time as the data.
You can do this by right clicking on the Well Profile tab at the top and selecting New Vertical
Tab Group. Now you should be able to see both the Station Data tab and the Well Profile tab
beside one another.
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Take some time to review other templates and stations and the data associated with the
stations to see how they are displayed on the Werll Profile.

For more details on the Well Profile please refer to Well Profile.

2.6 Maps
The Map Manager is packed with an abundance of mapping features that seamlessly
connects your project maps with the HGA database. However, the Map Manager goes far
beyond simple mapping, it also acts as a fundamental source for producing cross-sections
and developing contour maps (elevations, concentrations, water table, etc.). The Map
Manager is an integral part of HGA and is ideally suited for analyzing and presenting your
environmental project data.

We are going to create a new map and load some data onto it and then contour that data.

Select the Map Manager  icon from the main toolbar and in the dialog that appears
enter the name My Map for the new map you will be creating and then select OK.
An empty map will appear in its own window so you are able to go back and forth between
the main HGA interface and the Map Manager.

Now select Layer / Load HGA data and then select the Data Query option and select the
Concentrations\max_btex_concentration.
HGA allows you to set the precision of the field - for this you can leave the default and simply
select OK.
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The query loads as a set of points on the map and becomes a layer in the layer manager (on
the left side of the map).
The data associated with this query (the maximum BTEX values recorded at those points) is
now available for you to use for further analysis.
We are going to create contours and a color shade of the data. But first we are going to load
a shape file of the boundary of our area of interest.
Select Layer / Open / Shapefile and browse to the Map sub folder of this Demo Project. You
will find a Boundary.shp file there select it and then select open. The boundary is loaded and
displayed on the map (over the points) and becomes a layer in the layer manager. If you
select the polygon beside the Boundary layer (in the layer manager you can access the
settings to set the style for this polygon.
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Select the no pattern option from the drop down (second option) and then make the Border
black and thicker by entering 3 (as shown above).
When you select OK the boundary is updated in the map.

This would be a good time to save our work - select Project / Save.
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Now we will create the Contours and Color Shade. First ensure you have selected the
max_btex_concentration layer in the Layer Manager - you know it have been selected when it
becomes bold. Then select Layer / Create Contours and then select with HGA. The Contours
dialog box appears.

We want to have both contour lines and color shade of this data so make sure to select both
options.
You need to provide a name for each of the layers that will be generated and displayed in the
layer manager. For example enter My_Contours and My_Color_Shade.

You have options to adjust the Interpolation method the following are available:

· Inverse Distance
· Natural Neighbours
· Krigging

as well as Advanced Settings for each of the methods. For this tutorial we will leave Natural
Neighbours and the defaults advanced settings for this interpolation method. However, you
can take some time to become familiar with what options are available to you.

Now select the Settings button beside the Contour Line to access these settings. Under the
Intervals section select the Contour Interval option and enter 5000 for the value. We also want
a contour line at 1000 - so select the green plus button and enter 1000 in the Custom Interval
option.
Under the Contour Line Settings section adjust the Contour Line Style to use Black and
check on the Label Renderer option (so the contour lines will have value labels. And finally
change the decimal places to 0. Your dialog box should look something like:
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Select OK and you are brought back to the Contours dialog. Now select the Settings button
beside the Color Shade to access these settings. This shows the color palette that will be
used for the Color Shade. 

We are going to use the default settings for this so you can simply select OK to return to the
Contours dialog. However you can take some time to review the options available here to
become familiar with them for your own project purposes.

And finally we are going to restrict the contours and color shade to within the Boundary that
we loaded. So select the Restrain within Domain checkbox and the select the Choose
Domain button. In the dialog that appears select Boundary.
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Now select the Create button to create the contours and color shade.
(You may receive a confirmation message indicating items will null values will not be included
- simply select Yes).
You will then receive an Information dialog indicating that the contours were successfully
created.

Select OK and then the contours and color shade will appear on the map.

If you select the Color Shade icon in the Layer Manager you can adjust the settings - perhaps
try changing the transparency. You can also drag and drop the points layer
(max_btex_concentration) on top of the My Color Shade layer - this will make the points
appear on top of the color shade as items are displayed in the order they appear in the layer
manager.
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Don't forget to save your work by selecting Project / Save before you close your map. We
have gone through only a small number of features of the Map Manager. For more details on
the Map Manager please refer to Map Manager.

2.7 Cross-Sections
Groundwater and environmental site investigations typically entail detailed analysis of
lithologic data acquired from boreholes. Interpreting and visualizing the borehole data is a
crucial step in understanding the subsurface regime. HGA comes complete with a fully-
integrated cross-section tool that is designed with all the features you need to create geologic
and/or hydrogeologic cross-section interpretations.

The Cross-Section Editor is designed with easy-to-use tools for interpreting geological and
hydrogeological data, as well as interpreting data for groundwater flow models. Generating
model layers for use as modeling layer elevations in groundwater modeling packages such as
Visual MODFLOW Flex has never been easier!

The Cross Section Editor can be accessed from the Map Manager - so first you will need to
open the Site map project within the Demo Project by double clicking on Site Map under Map
Projects in the Project Tree. Once the Map Manager loads select the Cross-Section tab on
the right hand side to access the Cross Section Editor. The Demo Project has several Cross
Sections interpreted for you already - we are going to start by opening BB by selecting the +
beside BB in the Layer Control (on the left hand side).
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You can see that this cross section has been interpreted on three layers:

Model - line interpretations of where the model layers occur if you are planning on generating
a groundwater model
Geology - polygon interpretations of the soil types from the known points (at the stations)
across the entire cross section
Hydrogeology - polygon interpretations of multiple soil types that would comprise a
hydrogeologic layer

You can show/hide each interpretation type by selecting/removing the first checkbox beside
each interpretation layer. For instance if you remove the first check box beside both Model
and Geology you will see the Hydrogeology interpretations for this cross section.

And if you remove the check box from Hydrogeology and select the checkbox beside Model
you will see the model layer interpretations.
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Turn the Geology interpretation back on by selecting the first check box beside the Geology
layer. Now select the second checkbox - this puts the Geology layer inter edit mode. You will
notice the Polygon and Rectangle drawing tools become available in the toolbar. If you select
a polygon - for instance the Clay polygon you will notice the vertices - light blue squares -
become available and you can adjust them to edit the interpretation.
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You will also notice that when you put the Geology layer into edit mode "ghost wells" appear
- these are the interpretations of an intersecting cross section. So you can see that the
interpretation of cross section DD is slightly different for the Clay layer. This allows you to
adjust and ensure that interpretations are consistent at intersecting cross sections.

To confirm information on the cross section selection the information button  on the
toolbar and your cursor will now have an i symbol on it. Hover over items on the cross section
to get further information.
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To return your cursor to the regular select the pointer button  and then you can spend
some time attempting to edit the various polygons within the cross section. When you are
done remove the second checkbox beside the Geology layer and you will be prompted to
save your changes - select Yes.

For more details on the Cross Section Editor please refer to Cross Section Editor.

Take some time to review some of the other cross sections within the Demo Project to
become familiar with them. In the next section we will visualize the cross section in a 3D
Scene.

2.8 3D Visualizations
The Scene Viewer within HGA allows you to visualize your data in 3D space to get a better
understanding of your entire project. 

To create a new scene simply select the Scene Viewer button from the main toolbar
and an empty scene with load as a new tab.



Hydro GeoAnalyst Help30

© 2017 by Waterloo Hydrogeologic

Begin by loading the Boreholes station group into the scene. Select the Boreholes station
group on the Project Tree and drag it over into the (black) viewer area and drop it. The stations
will appear. Rotate the image around to adjust the view. Also try increasing the Exaggeration
to 2 to better visualize the stations.
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In a similar way you can drag and drop cross sections into a scene. Try loading the following
Cross Sections; AA, BB, CC, and DD.
Your scene should look something like:
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You will notice that there is now a legend for the soil types found within the station data as
well as a legend with the soild types used for the cross section interpretations. You can turn
these off by selecting the Cross Sections branch of the scene tree and then setting the
Legends Visible option to No.
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You can also add multiple items into the scene at once by selecting the green plus  and
use the Add Scene Objects dialog.
At the top of the dialog you can select Project items on the left side - for example select the
BTEX_3DPlume and then select the blue right arrow. You will notice the BTEX_3DPlume item
moves to the Scene items (on the right hand side).

We also want to add the site map from our map project. Select the green plus  in the
bottom half of the dialog and then browse to the Airport_color.bmp image that is found in the
Map sub folder of the Demo Project.

Select the OK button and both of these object will load into the scene.
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The plume is a transient plume - you can watch it progress over time by selecting the Play
button in the toolbar.
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Select the save button  in the toolbar and you will be prompted to save your scene.

Then you are able to close the scene tab and reopen it from the Project Tree later.

These are just some of the features of the Scene Viewer in HGA. For more details on the
Scene Viewer please refer to Scene Viewer.
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3 Fundamental Concepts

Before beginning to work with Hydro GeoAnalyst (HGA) you may want to review the following
pages to get an understanding of the fundamental concepts of the program. This might help
you become more proficient with the software in less time.

The following pages go through the basic concepts of the program as well as main HGA
interface, including the various tabs available to you. As well as how you can enter data both
manually as well as with the EDD workflow which helps you to validate your data before
importing it into the database.

3.1 Start Page Tab

When first launching HGA you will find a Start Page to help you do common tasks such as
creating a new project or opening an existing project – even installing the Demo Project.
There is also a lot of valuable information such as; what’s new in the latest version, links to
online resources including “how to” videos to help you learn about the new features more
quickly, and links to our Technical Support staff to make it easier to ask questions and report
issues.

The New Features tab will describe each of the new features. Some features will also include
links to videos about the new feature.

The Release Notes tab will display our online Readme file. This contains a lot of detailed
information about the new features, a list of features and bugs fixed from previous versions, as
well as Known Issues and Limitations of the current version. 
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On the Support tab you will find lots of other information to help you including how to contact
our support team. If you have a question or concern with the product you can use this link to
initiate an email to the support team and it will include all the System Information which can
be really helpful for our support team to help resolve your concern. If you are having difficulties
explaining the concern try using the Problem Step Recorder – it does just what the name
implies – it creates a recording of the steps you took (all the clicks) with screen captures to
help make it clear what you were trying to do.

Then on the right side of the Support tab there are links to more information including:
· The HGA You Tube channel with all the HGA videos
· The online Frequently Asked Questions
· And also our available Training Options.

3.2 About the Interface
Once a project is loaded, the main window will appear; the HGA demo project is displayed
below.

The HGA Graphical User Interface is composed of several controls:

Menu Bar: Contains menu commands with access to most features that are available in the
HGA package.
Module Toolbar: Contains several context sensitive short-cut buttons for the most frequently
used HGA features.
Project Tree: Hosts a tree view listing some of the most common components of your
project. These include nodes for Station Groups, Queries, Time Series Plots, Well Profile
Templates, Maps, Cross Sections, Scenes, and Reports. It also includes a Station Picker
which allows the user to select the station used to display data in other tabs and modules.
Data Tabs: Provides access to the various parts of the project including the Station List,
Data Query, Data Filter and Station Data.
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Well Profile: Provides a visual representation of the well for the selected station.
Data Grids: Contains the grids for data entry and visualization.
Data Grids Toolbar : Contains icons for the main options you can perform with the data
contained within the data grid.
Status Bar: Displays the program status.

You will find that you now have options to move the tabs around and dock them where you
like. The default configuration is to have one tab group for the Project Tree and one tab group
with the rest of the tabs (station list, station data, etc.). However, you can have more tab
groups – vertical or horizontal. You can find these options by right clicking on a tab. Then you
can just drag and drop the tabs where you prefer them! Here is an example configuration that
you might like to use. Your configuration is remembered the next time you open the program.

Additionally you will find some helpful filter options on the top of the columns in all of the data
grids. The first row on any data grid is your filter row.
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So you can quickly filter using many of the options you would be used to seeing in Excel.

 
Additionally, if you select the drop down list in the filter row you will find a list of all the unique
values in that column.

3.3 Toolbars
There are different tool bars available within the program. The top toolbar with the larger
buttons provides quick access to the various modules in HGA:
· Template Manager
· Quick Checker
· Data Transfer System
· Query Builder
· Material Specification Editor
· List Editor
· Event Planner
· Well Profile
· Map Manager
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· Cross Section Editor
· Scene Viewer
· AquiferTest
· AquaChem

There are also toolbars available on the individual tab groups specific to the actions you may
wish to perform on the data contain within the tab group.

Below is the general tool bar found on most tab groups.

It provides options to scroll through the list of records (forward, backwards, first and last), an
option to add a record and delete a record as well as save any edits made.
There is also an option to print, an option to show/hide columns and a refresh option.

By placing your cursor over any of the icons in the tool bars you will find a tooltip indicating
what the button does.

3.4 Station Table
The Station Table stores all the station location information for all projects residing in the
database. The Station Table may contain an unlimited number of fields. Though, as a
minimum, the Station Table must contain the following fields:

Station ID (ID)
Station Name (Name)
Station Coordinate (X)
Station Coordinate (Y)
Station ground surface elevation (Elevation)
Top of Casing (TOC)

If plotting stations on a map or cross section is desired, then the following fields are required:
Station X co-ordinate
Station Y co-ordinate
Station ground surface elevation (Elevation)

Station coordinates are stored in the Stations Table in latitude-longitude format by default.
However, each project may contain its own projection and coordinate system settings, so
that station locations may be entered and displayed in an alternate format (e.g. UTM, State
Planar, etc.). 

Hydro GeoAnalyst supports storing and displaying spatial data in a local
coordinate system (or site coordinates). Now there is no need to adapt your spatial
data to world coordinates, if you prefer to work in site coordinates.
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Stations can be added, modified, or deleted through the Station List tab. The Station List tab
displays a limited number of fields for viewing and editing; for a more detailed view of each
station, the Station Data tab must be used; the information displayed in the Stations Table
can be found in the Description Data Category within this tab, in the Location table as shown
below.

3.5 Station Groups
Many operations in HGA require the selection of one or more stations. An example of such
an operation is data entry. One or more stations for which you would like to add, view and/or
modify data need to be selected so that the Station Data tab is accessible (activated).

The complete list of stations that comprise a project can be viewed in the Station List tab by
selecting the All Stations item, under the Station Group node in the project tree.  By default, all
projects will contain a station group named All Stations that lists all stations in the database
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belonging to the project. However, for some of the tasks commonly performed in HGA,
retrieving the complete list of stations in the project may not be necessary. Moreover,
retrieving all the stations when only few of them are needed may be a time-consuming
process especially for large databases containing hundreds or thousands of stations.

The solution is to create Station Groups. Grouping stations into their logical groups allows
efficient management and quick retrieval of data stored in the database. For instance, all
stations which contain groundwater chemistry sampling data can be grouped together under a
group named as GW Sample Locations. Whenever these stations need to be updated with a
new groundwater sampling round, selecting the GW Sample Locations group displays only
those stations that belong to this group.

Station groups can be created based on any criteria. Common examples include:
· Locations of the stations (e.g. locations sorted by City, Project Sites, etc.)
· Station type (e.g. Monitoring Locations, Boreholes, etc.), or
· Purpose of Study (e.g. remediation, site monitoring)

There are three kinds of Station Groups in HGA:

 All Stations: This station group is in all projects and all stations that are entered
(imported or manually) into the project will be found in this station group. You can not delete
or rename this station group.

Static: Select one or more stations directly in the Station List tab, right-mouse click, and
select the Add to Station Group option from the pop up menu.

Dynamic: Using the query builder, define a more advanced search criteria, and build a
station group with those stations that satisfy the query criteria.

All Station Groups created for a project are listed in the Project Tree under the Station
Groups branch. Double clicking on any of the sub-branches corresponding to a Station Group
will load the Station List tab, and display the appropriate stations belonging to that group. An
example is shown below.
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If desired, selected stations can be removed from a static station group or the Station Group
can be deleted as a whole. To remove stations from a static station group simply select the
stations (by highlighting the row) and then select the delete button - this will remove the
station from the station group - but will not delete the station from the database. To delete a
station from the database you must first select the All Stations station group - and delete the
stations from here.
To delete an entire station group right click on the station group in the Project tree and select
delete.

3.6 Data Categories
The tables in an HGA database can be organized into a logical grouping by placing them into
any one of the provided data categories. HGA provides several data categories, which might
be considered common data categories found for environmental data. However, you can
create as many categories as you wish within the Template Manager. This way you can
completely customize the way in which the tables are organized within HGA.

The Station Data categories can be accessed by selecting the Station Data tab and select
the Data Category combo box (ensure that one or more stations are selected in the Station
List tab).
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After a Data Category has been selected, the appropriate tables and fields belonging to this
category will be displayed in the Station Data tab.

The following is a list of the data categories provided in the HGA Demo Project, along with
some of the data entities that may be linked to each category:
· Description (e.g. station name, location, coordinates, elevation, site, etc.)
· Geologic Description (e.g. lithology, soil properties, hydrogeologic properties, etc.)
· Well Construction (e.g. drilling protocol, annular filling, monitoring points, casing materials,

well dimensions, etc.)
· Soil Testing (e.g. SPT, pocket penetrometer, vane shear test, dynamic cone)
· Soil Sampling (e.g. Rock Coring, Soil Chemistry results, Soil Vapor, Moisture Content,

Particle Size Distribution, Atterberg, Standard Proctor, Unconfined Compression, Direct
Shear, Odometer (Consolidation)

· Monitoring Events (e.g. weather conditions, bailing, field properties, water quality,
groundwater levels, groundwater chemistry)

· Mining / Exploration (e.g. Alteration, Mineralization, Structure, Samples, Down Hole
Survey, Down Hole Geophysics)

· Geophysics (e.g. Conditions, Gamma, Neutron, 64 in E-log, 16 in E-log, Density)
· Well History (e.g. Pumping Rate, Pump, Screens, Top of Casing, status)

All of the above data categories may be renamed and used differently if desired. For example,
the category named Geology could be renamed to Surface Water and tables such as
Catchments, Surface Water Monitoring Locations, Rivers, etc. could be organized under it.
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Placing tables under any one of these categories does not have any effect on how the tables
are stored in the database.

3.7 Adjustable Windows
When opening an HGA project for the first time the default window displays will appear. There
are two groups, one with the Project Tree and Station Picker (on the left) and another one
with the following four tabs:
· Station List
· Station Data
· Data Query
· Data Filter

You have several options to adjust the view of these groups. You can add additional groups
(right click on any existing tab) either vertical or horizontal. Several of the modules within
HGA will launch as a tab (e.g. Query Builder, Well Profile, List Editor, Material Specification,
Event Planning etc.)

You can rearrange the order of the tabs within a group by simply dragging and dropping a tab.
You can even drag a tab from one tab group to another.

Here is an example of another way to organize your windows:
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Additionally you now have the option of dragging any tab outside of the main HGA view and
onto a second monitor!

3.8 Project Tree & Station Picker Tab
The project tree lists the following items:
· Station Groups
· Queries
· Time Series Plots
· Well Profile Templates
· Map Projects
· Cross-Sections
· Scenes
· Reports
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These items may be part of any project. Each item is organized as a branch in the tree view
with one or more items under each branch. By selecting an item in the project tree you will
either activate the appropriate tab or launch appropriate module to view this item.

You have the following options in the Project Tree:

 This allows you to collapse all branches in the Project Tree.

 This allows you to expand all branches in the Project Tree.

 This allows you to filter for anything in the Project Tree - simply start typing the name of
the item you are looking for.

You also have the following options available:

 This allows you to refresh the Project Tree.

 This allows you to dock the Project Tree on the left.

 This allows you to dock the Project Tree on the right.

You can organize any of the branches of the Project Tree (except for the Reports branch as it
has it requires its own structure) by creating folders to group the items under the branch.
Simply right click the branch and select Add Folder...
Provide a name for the folder and now you can drag and drop items from that branch into the
folder.
Here for example you can see how the Queries branch of the Demo Project is organized with
folders:
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There is also a Station Picker tab within the Project Tree which allows you to select the
station to display in the currently selected tab.

The Station Picker displays stations from the currently selected station group. To change the
station group double click on the station group in the Project Tree.

You can hide/show the Project Tree & Station Picker by selecting the double blue arrows.
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3.9 Station List Tab
The Station List tab provides an overview of the available stations in the selected Station
Group. This tab displays any fields from the Station table (the main table within the HGA
database) for example name, X-coordinate, Y-coordinate, Elevation etc. 
These fields may be modified for a selected station (simply click in the cell you wish to edit);
or a new station may be created here (selecting the green plus icon), and the values for these
fields may be defined. The Station List tab may be used to quickly enter numerous stations,
and define the basic attributes for each station.

The first line on this tab is the filter line and as such is highlighted in purple-blue. The filter line
is similar to what you find in Excel when you apply a filter. You can enter values to filter the
list of what is displayed only to those values that you are interested in.

You can also highlight a record (will turn bright blue) by clicking on the button on the left hand
side of the grid and then right click on the record and select copy. Then you can paste this
into for example an excel spreadsheet and both the header information and the records you
highlighted will be pasted into the excel spreadsheet.

You have the following options in the Station List tab:
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 These navigation options allow you to scroll through the
stations.

  This allows you to add a new record.

 This allows you to delete the currently selected record(s).

 This allows you to save the changes you have made.

 This allows you select which columns you want to show or hide.

 This allows you to refresh the data in the current tab.

 This option allows you to export the data from the current tab.

 This option allows you to print the data from the current tab to an ExcelTM template.

When printing your Station List to an ExcelTM template you will be prompted to select a
template. Provided with HGA is a template called Template - Table.xlsx. You can modify this
template by going to the folder where your templates have been stored (see HGA Settings for
more details) and adjust it to suit your needs. Perhaps you may want to change the logo etc.
Any templates stored in this folder will be available in the drop down list under the Open
Template option.

Once you have selected a template you can select the OK button and the ExcelTM template
will open with your data in it - ready for printing!

3.10 Station Data Tab
For a more detailed view of a single Station's attributes, the Station Data tab should be
selected, and an appropriate Data Category chosen. The Station Data tab provides access to
all data related to a single station. Once a Station is added to the project, detailed information
on the station can be added, edited, or deleted through the Station Data tab.
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The first line on this tab is the filter line and as such is highlighted in purple-blue. The filter line
is similar to what you find in Excel when you apply a filter. You can enter values to filter the
list of what is displayed only to those values that you are interested in.

You can also highlight a record (will turn bright blue) by clicking on the button on the left hand
side of the grid and then right click on the record and select copy. Then you can paste this
into for example an excel spreadsheet and both the header information and the records you
highlighted will be pasted into the excel spreadsheet.

By selecting a Data Category (from the drop down) you will find different tables (each tab is a
table). And each table has different fields (each column is a field).

You have the following options in the Station Data tab:

 These navigation options allow you to scroll through the
stations.

  This allows you to add a new record.

 This allows you to delete the currently selected record(s).

 This allows you to save the changes you have made.
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 This allows you select which columns you want to show or hide.

 This allows you to refresh the data in the current tab.

 This option allows you to export the data from the current tab.

 This option allows you to print the data from the current tab to an ExcelTM template.

When printing your Station Data to an ExcelTM template you will be prompted to select a
template. Provided with HGA is a template called Template - Table.xlsx. You can modify this
template by going to the folder where your templates have been stored (see HGA Settings for
more details) and adjust it to suit your needs. Perhaps you may want to change the logo etc.
Any templates stored in this folder will be available in the drop down list under the Open
Template option.

Once you have selected a template you can select the OK button and the ExcelTM template
will open with your data in it - ready for printing!

3.11 Non Station Data Tab
The Non Station Data tab provides you the ability to view any Non Station table within the
project database. You can find out more information about how to add a Non Station Data
table in your database in the Template Manager section.

You can also enter data manually into a Non Station table within this tab.
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You have the following options in the Non Station Data tab:

  This allows you to add a new record.

 This allows you to delete the currently selected record(s).

 This allows you to save the changes you have made.

 This allows you select which columns you want to show or hide.

 This allows you to refresh the data in the current tab.

 This option allows you to export the data from the current tab.

 This option allows you to print the data from the current tab to an ExcelTM template.

3.12 Data Query Tab
The Data Query Tab will display the results of executing (running) a query. When you select a
query from the Queries branch of the project tree, the Data Query tab will be activated and



Fundamental Concepts 55

© 2017 by Waterloo Hydrogeologic

display the results of the selected query.

The first line on this tab is the filter line and as such is highlighted in purple-blue. The filter line
is similar to what you find in Excel when you apply a filter. You can enter values to filter the
list of what is displayed only to those values that you are interested in.

You can also highlight a record (will turn bright blue) by clicking on the button on the left hand
side of the grid and then right click on the record and select copy. Then you can paste this
into for example an excel spreadsheet and both the header information and the records you
highlighted will be pasted into the excel spreadsheet.

The following options are available on the Data Query Tab:

These navigation options allow you to scroll through the
records.

 This allows you to create a new query (you will be moved to the Query Builder tab and
prompted for a name for your new Query).

 This allows you to edit the current query (you will be moved to the Query Builder tab
with the current query open).

 This allows you to execute query again.
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 This allows you to delete the current query.

 This allows you to use the query to generate a plume for visualization in the Scene
Viewer.

 This allows you to use the query to create a Pivot table in Excel. You can find more
information in the Crosstabs are Now Pivot Tables section.

 This allows you to use the query to Perform Lab QA/QC Assessment.

 This allows you to show or hide the query columns.

 This allows you to export the results of the query.

 This allows you to save the changes you made (by applying a filter) to the existing
query.

 This allows you to save the changes you made (by applying a filter) as a new query
(you will be moved to the Query Builder tab).

 This allows you to print the results of your query to an ExcelTM template.

 This allows you to send the results of your query as a time series Chart in ExcelTM.

When printing your query results to an ExcelTM Template you will be prompted to select a
template. Provided with HGA is a template called Template - Table.xlsx. You can modify this
template by going to the folder where the templates have been stored (see HGA Settings for
more details) and adjust it to suit your needs. Perhaps you may want to change the logo etc.
Any templates stored in this folder will be available in the drop down list under the Open
Template option.

Once you have selected a template you can select the OK button and the ExcelTM template
will open with your data in it - ready for printing!

When using the Chart in ExcelTM option you will be prompted to select a template. We have
provided several template options which were installed with HGA. You can modify templates
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by going to the folder where the templates have been stored (see HGA Settings for more
details) and adjust it to suit your needs. Perhaps you may want to change the logo etc. Any
templates stored in this folder will be available in the drop down list.

It would be a good idea to review the templates before you use them. In this example I want
to create 2 plots on each page with 2 parameters on each plot. So I will write a query to pull
the 4 parameters I want in the plots: TCE, Vinyl Chloride, Benzene and Ethylbenzene.
Here for example is my query:

Now I will review the template that matches what I want to plot - Template - 2 plots by 2
parameters.
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On the Data tab I can see this template is set for Ca, Mg, Cl, SO4. So I will change this to
the 4 parameters that I want to plot. Once I have changed the parameters I can review the
Time Series tab to see what it will look like.

Here I can see that TCE and Vinyl Chloride are going to be placed on the top chart and
Benzene and Ethylbenzene on the bottom chart which is the way I want to chart them. If
however I want to switch them I would just need to reorder them on the Data tab.
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Also I can adjust the footer - change the logo, add my title etc. Once I like the way it looks I
am going to save as a new template - making sure to save it in the same folder as the original
templates so HGA can find them. Now I am going to run my query and use my new template
to chart the data.

So when I select the  button the first thing I need to do is select my new template from
the drop down list.

Then select the Required mappings - the Series grouping would be the chemical name, the
Time is the Sample Date, and the Value is the Result Value. Also I want to have one page for
every station so I select the Group charts by option and select Station Name.
When I select OK I get the Mappings dialog.

The chemical names automatically match because they are exactly the same within my
template as they are stored within the database.
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Also make sure that you map the Date field. Then select OK and you will be prompted for a
name for the excel spreadsheet that will be created.
Once you provide a name it will open in Excel and you can review to see that each station
has its own tab for the time series chart.
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Provided with HGA is a template for the Chart in ExcelTM option called Template-Chart.xlsx.
You can modify this template by going to the folder where the templates have been stored
(see HGA Settings for more details) and adjust it to suit your needs. Perhaps you may want
to change the logo etc. Any templates stored in this folder will be available in the drop down
list under the Template Selection option.

3.13 Data Filter Tab
The Data Filter tab allows you to browse through the database tables to see the results of all
stations in a particular table. You can select to browse the entire project, database, or a
particular Station Group. Then select the table you are interested in. Select the excute button
and you will see all the results.

The first line on this tab is the filter line and as such is highlighted in purple-blue. The filter line
is similar to what you find in Excel when you apply a filter. You can enter values to filter the
list of what is displayed only to those values that you are interested in.

You can also highlight a record (will turn bright blue) by clicking on the button on the left hand
side of the grid and then right click on the record and select copy. Then you can paste this
into for example an excel spreadsheet and both the header information and the records you
highlighted will be pasted into the excel spreadsheet.

l



Hydro GeoAnalyst Help62

© 2017 by Waterloo Hydrogeologic

The following options are available on the Data Filter Tab:

These navigation options allow you to scroll through the
records.

 This allows you to execute the filter (runs a query to return the records).

 This allows you to delete the currently selected records.

 This allows you to show or hide the columns.

 This allows you to export the results of the query.

 This allows you to save the filter as a Query (you will be moved to the Query Builder).

3.14 Data Entry
Manual Data Entry
You can manually entered and/or edited data in the following tabs:
· Station List 
· Station Data
· Non Station Data

You can use the  to add a new record (row) within one of the above tabs. 

Data Transfer System (DTS)
It may be more efficient to import the data using the Data Transfer System (DTS). 
The DTS give you several options for importing your data:
· General
· EDD
· Mobile EDD
· Chemical
· Diver
· LAS

For more details on how to import data using the DTS, please refer to Importing Data.

3.15 EDD Workflow
The EDD (Electronic Data Deliverable) workflow provides an efficient way of getting validated
data into HGA. The workflow includes the following three steps:

1. EDD Template Designer
2. HGA QuickChecker
3. EDD Import

Additionally, we also have an option to make your EDD mobile so you can use it on mobile
devices like tablets and smart phones.
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3.15.1 EDD Template Designer

You can find this option by selecting Modules / EDD Template Designer. In this first step of
the workflow you can create a template (which can be opened in Excel) for others to use to
validate their data. In the EDD Template Designer you select which fields you wish to have in
your template by simply dragging and dropping them onto the Template Format.

The list of available fields on the left are provided as you would be used to seeing them in the
Template Manager or the Query Builder. First branch are the Data Categories, next branch
are the Tables, and the final branches are the fields. As you drag and drop fields into the
Template Format section you will notice that other fields may show up there automatically –
these are also bolded. These are fields that are required to be able to import the data into the
select table.
If you select fields from the Single Sheets tab – the Template will create a new worksheet for
each table where fields were selected from. In the example above fields were selected from
both the Parameter Sample and the Parameter Result tables – and therefore when you open
this template in Excel you will find both a worksheet was created for each table.
If however you select the Grouped Sheets tab – you will notice that the fields are presented in
another way. Here you will find the tables that are related to each other (by database foreign
keys) are grouped on a branch. When you select the child table (lowest branch) you will find
a list of ALL fields of the related tables below.
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When you select fields from the Grouped Sheets tab you will create a template with only one
worksheet.
You have some additional options when creating your EDD Template. You can set a version
number (to keep tracked in case in the future you wish to update a template). A submission
URL can be set as either an email address or as an FTP folder to upload to. A Template
Version URL can be entered so that when using the template in the HGA QuickChecker and
the EDD import routine it can be verified that it is the most up to date version of the template.

Additionally, you can add conditions onto the fields you have chosen that the HGA
QuickChecker will verify. For example – you can make the Sample Date field required (even
though it is not a required field to enter the data into the database). Also there is an option for
more Advanced Conditions - here you can enter any Excel functions for additional conditions.
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3.15.2 HGA Quick Checker

The HGA Quick Checker is a tool to help you organize your data from spreadsheets into a
format ideal for importing into your database and then validate it before importing it into the
database.

This tool launches as its own module from the main toolbar by selecting the  button on
the main HGA toolbar. This module is also available as a stand alone installation for use on
computers that do not have HGA installed. This installation can be downloaded by contacting
technical support (support@waterloohydrogeologic.com). 

mailto:support@waterloohydrogeologic.com)
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You can select the new button  to create a new quick checker file or open an existing

one by selecting the  button and browsing to your saved *.qck file.
When creating a new file you will be prompted to select the EDD template file you wish to
use and then you are given the option to either enter data manually or import data from a
selected excel file.

When choosing to import data from an excel file you will need to map your spreadsheet to the
fields in the EDD similar to the way you map in the General import routine. If your
spreadsheet does not contain one of the fields you have the option to Add empty column so
you can manually enter this data for validation.
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This quickly brings your data into the Quick Checker for validation. You still have the option to
add or edit data after importing the data in.

In the following example you can see there are some problems with the data. The tab where
errors occur are flagged (red) and the errors are displayed on the right hand side Error
section. If you double click on an error it will take you to the row containing the error so you
can correct it. Once all errors are corrected the flag will disappear.
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When you select the validate and submit button if no further errors exist you will be prompted
to save your file as a *.zip_hga file which can be easily imported through the DTS.

3.15.3 EDD Import

To launch the EDD Import routine select Modules / Import / EDD. Then specify the location of
the *.zip_hga file that was generated within the HGA QuickChecker. 
Please be aware that you should not attempt to unzip or modify the file in any way as this
can invalidate the file and cause difficulties importing the data.
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As soon as the file is validated you will see the Validation Results dialog appear. Here you
may need to answer a question before continuing. For example the Validation found that
some of the station names I am trying to import do not exist in the database – therefore I can
choose to append the new station names or reject records for stations that do not exist. I
make my choice by selecting the appropriate option in the Action column. If I wish to see
which stations are not currently in the database I can select the Click Here to View Data
option. For this example I choose to Append the stations (so any station names in my data
that are not in the database will be automatically added).
Then the validation also found I have duplicates in the database – some of the sample IDs
already exist in the database! Again, I can select what I want to do – either overwrite what is
in the database or reject the duplicate sample IDs. For this example I will reject these sample
IDs.
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Now I can continue with the import. Now the Import dialog is updated – and I can see how
many records will be imported.
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Select the Import button to import the records – and the import dialog updates to inform you
that the import was successful. Now you can select another EDD file to import or close the
dialog box.

3.15.4 Mobile EDD

Within the EDD Template Designer you will now find an option to Publish Mobile EDD. So
instead of using your EDD within the HGA QuickChecker (MS Excel plugin) you can now use
your EDD on a mobile device!
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Create your EDD as you did previously. Select the fields from the various tables that you wish
to collect data for while you are out in the field. Fields where you have created a list within the
List Editor can be used to provide a drop down list in your Mobile EDD.

Please be aware of the following limitations for Mobile EDDs:
· you must include the Station Name from the Location table within your Mobile EDD

template.
· the Advanced option under the Conditions in the EDD Template Designer is not supported

in the Mobile EDDs.
· You are limited to a maximum of 12 tables.

When you are happy with your EDD template select the Publish Mobile EDD button and
you will be provided with the following options.



Fundamental Concepts 73

© 2017 by Waterloo Hydrogeologic

The default option is to publish this Mobile EDD to our Waterloo Hydrogeologic Web Server –
therefore all you need to do is confirm the name (Web link folder) that will be used – by
default it takes the Project name and the EDD template name. 
Or if you prefer you can publish to another Web Server. When publishing to your own
webserver you need to provide the URL, the FTP Host as well as the User Name and
Password.
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You also have an option to publish a station group within your Mobile EDD - you will find this
option on the Additional Data tab - select the station group you wish to publish with the EDD.
This means that the stations in that station group will appear listed in the Home Page of the
Mobile EDD. This can be very helpful if the stations already exist within your HGA project and
you are sending someone into the field to collect data for specific stations. If you do not use a
station group it simply means you will be creating new stations while collecting your data in
the field.
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Note: We recommend using Apple or Android devices using Safari or Chrome as your
browser.

Here is the Litho EDD that comes with the Demo project as a Mobile EDD. The home page
provides you the option to add a new station or submit the data that you have collected. If the
EDD was published with a station group you would find the list of stations from the station
group by selecting the plus button beside Stations.

When you select Add New Station you are brought to another page showing all the tables
and fields from your EDD Template.
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In this example I selected the Lithology tab. Here you will find the fields from the EDD
including the soil type. The soil type field has a list associated with it - and you can see this
list is also available within the mobile EDD to ensure only appropriate values are being
entered.

You can add more records by selecting the Add New button.
Here for example I have added 4 rows:

\
Once you have finished collecting your data you need to return to the Home page. You will
find your list of stations - if you select one of the stations you will be returned to the tabs for
that station so that you can edit the data associated with the station. If you select the X
button to the right of the station name will be given the option to delete the station. All
stations by default are marked as "In Progress" - if you wish to submit your data to be
imported into HGA you first need to indicate that you are done collecting the data for the
station by selecting the check box for the station. You will notice that the "In Progress" flag
has changed to "Done".
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Only stations which have been designated as Done will be submitted.
To submit the data select the Submit button.

You need to provide a name for the file that is being submitted – please note that the date will
be automatically added to the name you provide.
You also have the option to Remove Done stations from memory after sending. This will
remove the data from the device after it has been submitted. This way you can submit your
data throughout the day (when you have a wifi connection) and carry on with collecting
additional data.
When you return to the office you can import this data into Hydro GeoAnalyst by selecting
Modules / Import / Mobile Data.
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HGA will remember the Mobile EDD’s that you published for your project – you can select
them from the drop downlist. Then hit the refresh button to see the files that were submitted
from this site.
Select the file you wish to import and select the Import button.
You will see a validation dialog which shows how many new records will be imported. In this
example I created one new station and entered 4 new lithology records.
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Select the Import button to finalize the import process.
I can review the data that was imported within HGA – for example here are the 4 new lithology
records imported:
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3.16 Spatial Geo_Point
Making use of the spatial geo point option within SQL Server 2008 R2 or later we can have a
more direct link to ArcGIS. When creating or upgrading HGA projects to version 2012 (or
later) and using SQL Server 2008 R2 (or later) there will be a new field called geo_point in the
Location (station) table. We have hidden  this field from your view in the Main HGA view as
this is a system field that is automatically calculated based on the X and Y fields. 

Additionally, any Map – Ready queries will now include this field as well. ArcGIS is able to
recognize this field and be able to plot your stations using this field. Any time you make
changes to your X and Y coordinates in HGA (for example adding, deleting, or editing) the
geo_point will be automatically recalculated. Therefore all you need to do is select the refresh
button (F5) in ArcGIS and your points will automatically be adjusted as it is directly reading
the points from the database.

Please be aware that if you are using a Projected Coordinate system for your project the
geo_point is being calculated as WGS 1984 (lat long) as this is the internal way HGA stores
coordinates in the database. If you are using a local coordinate system for your project then
the geo_point will not contain any coordinate system information (only the values of the
coordinates).

Within ArcGIS you can select File/Add Data/Add Query Layer
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Select New to make a new connection

Provide your SQL Server details (please remember you must be using SQL Server 2008 R2)
and the database you wish to connect to.

Then select OK and you will see the New Query Layer dialog box – here you can see all the
tables and fields in your database. You can write your own SQL statement – or you can copy
a SQL statement from one of your HGA saved queries (in HGA in the Query Builder on the
SQL Statement section). For this example I wrote a simple query to take all the information
from the station table.
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When you select the finish button the layer will be added to your map.

If any changes are made to the database stations within HGA (you delete stations or add new
stations or even edit the stations coordinates) all you need to do is hit the refresh button in
ArcGIS (F5 or View/Refresh) and the points will be automatically updated.



Menu Bar 83

© 2017 by Waterloo Hydrogeologic

4 Menu Bar

The HGA menu items have been specifically designed for optimal flexibility and ease of use. The items
in the menu bar are context sensitive; this means that one or more menu items may be greyed out if a
specific feature is not applicable for a particular view. 

The following sections describe the items which appear in the menu bar.

4.1 Project
The Project menu contains options for project level actions as described in the following
sections. 

4.1.1 New

This option launched the New Project wizard which is described further in the next section: 
Creating New Projects

4.1.2 Open

The Open menu item is used to open existing HGA projects by selecting the *.hga file. The
*.hga file contains basic information for the project, including a connection string to the HGA
database. 

The  (Open) button in the Project Tree toolbar performs the same function.

4.1.3 Open from Backup

Use this option to open a back up copy of the HGA project and database. This is useful if
receiving a copy of someone else's project and database and needing to have a copy on your
SQL Server.
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In the Restore from section browse to the SQL server backup file (*.bak). Then select the
corresponding project file (*.hga).

In the Restore to section you need to specify the name of your project (it will use the project
name in the *.hga  file by default). and then specify the Data source type and which SQL
Server you will be restoring the backup to. You can select the Refresh button to look for
additional SQL Servers.

 The SQL Server instance should be on the same machine as HGA as SQL
Server does not allow you to restore databases across a network.

You can specify the name of the database - by default this is also taken from the *.hga file.

Finally you have the option to specify to use Windows Authentication (default) or SQL Server
Authentication.
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The select the OK button. The database will be restored onto the SQL Server and the project
will open.

If you ever need to provide a copy of your database to someone - a back up of the SQL Server
database can be made using the BackUp Database option (available in the Database menu),
explained later in this section. A copy of the project can be made by simply copying the
project folder, and its contents, using Windows explorer.

 NOTE: On Windows 7 operating systems, User Account Control (UAC) must be
disabled before you can successfully open a project from backup. 

4.1.4 Close

Close the project which is currently open.

4.1.5 Re-Open

This menu item provides a list of projects that have been recently opened. The most recent
project will appear at the top. Simply select the desired project, and it will be loaded into
HGA.

4.1.6 Online Sharing

This new option allows you to share your HGA project with others who do not have the
program. You can find this option by selecting Project/Online Sharing. On the first tab you
can provide some general information regarding the project.

Note: Best size for client logo is 150 pixels wide by 100 pixels high.

The next tab allows you to select a query to display station information.
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The Queries tab allows you to select a query to display any additional data that is important
for your project (for example chemical concentration information).

The Maps tab allows you to select layers from any of the maps in your project that you wish
to share. Additionally, any water level information for the points layers you select from the
map will be included in the Online Share. You have an option to specify if you want a specific
date range for the water levels or simply include all water levels. This will be displayed as
water level elevations in the Online Share when you select a station on the Map.
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Following are some screenshots of an example project Online Share:

 

 
If you select one of the stations on the map you will find a pop up with some additional
information. Also, the pop up will provide a link to visualize the water levels (in another
window) associated with that stations.
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4.1.7 Install the Demo Project

You can Install the Demo Project from within the program by selecting Project / Install the
Demo Project (there is also an option to do this from the Start Page.

The Default option will install the Demo Project to a Local Database (SQL 2012). Simple
select Next and then Finish to Install the Demo Project.
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However, if you prefer, you can install the Demo Project to a SQL Server database by
adjusting the Database Type option.
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You simply need to provide the name of the SQL Server you wish to use, the Database Name
for the Demo Project, and then select if you wish to use Windows Authentication or SQL
Server Authentication.

The Demo Project files will be installed to the location designated under Project / HGA
Settings (the Project tab). The default location is under Documents / Hydro GeoAnalyst.

4.1.8 Properties

This menu item will load a window displaying the properties for the current project. 

On the General tab you can find the settings selected during project creation including:
· Projection Type
· Projection
· Coordinate System Unit
· Project Location
· Material Specification
· Database Name
· Database Server
· Project Folder

 NOTE: While you can adjust the Projection and Material Specification here - all
other settings are read only (and cannot be adjusted from this dialog).
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On the Well Profile Settings tab you will find the settings used within the Well Profile module
- here you can specify which tables and fields are to be used to obtain information related to
geology and well construction details.
Each item that requires a setting has its own tab including:
· Lithology
· Hydrogeology
· Drilling
· Casing
· Screen
· Filling
· Water Level

For each item, provide the table and the field that stores the patterns or provides interval data
to be used in all the graphical displays. For example, in the Lithology tab, select a table
which contains the Lithology information for your project; then select a field from this table
which contains the Soil Description information. The information provided in this window will
be used when displaying profile diagrams in Hydro GeoAnalyst. The geological data and the
corresponding patterns will also be displayed in the cross section editor, and in the Scene
Viewer.

Only tables with the following parameters can be displayed in this dialog:
Lithology: Tables must have two fields with type DOUBLE (from_, to_) and one field with
type STRING (soil_type)
Hydrogeology: Tables must have two fields with type DOUBLE (from_, to_) and one field
with type STRING (ex. formation name)
Drilling: Tables must have three fields with type DOUBLE: (from_, to_, diam_), and one field
with type STRING (method)
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Casing: Tables must have three fields with type DOUBLE (from_, to_, diam_) and one field
with type STRING (ex. material)
If it's desired to have multiple well casings, or nested piezometers, you must also define two
additional fields:
Casing ID: field type LONG (used to distinguish different well casings)
Parent ID: field type LONG (required only if a well casing exists within a parent casing; if so,
for the selected well casing, set the ParentID equal to the CasingID of the parent casing)
Screen: Tables must have three fields with type DOUBLE (from_, to_, diam_) and one field
with type STRING (ex. material)
If you have multiple well casings, you must add an additional field:
CasingID: field type LONG (used to distinguish different well casings). This allows to assign
multiple screens to multiple well casings.
Filling: Tables must have two fields with type DOUBLE (from_, to_) and one field with type
STRING (ex. material)
Water Level: Tables must have one fields with type DOUBLE (depth_) and one field with
type STRING (ex. comments). In the Water Level tab, you may also select the reference
datum for measuring depth to water levels: select "Ground Surface Elevation, or Top of
Casing"

NOTE: The depth-point and depth-interval information (from, to fields) are
depths and not elevations. As such, the Well Profile and Cross Section editor require
that data be entered as "depth to" and not an elevation above sea level or a
benchmark.

4.1.9 HGA Settings

The HGA Settings dialog provides various settings for a number of options within the program.

· Project
Here you can specify the default server and default location for project files. These settings
are taken into account when creating new projects or when installing the Demo project.
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Additionally you can specify when you will be reminded to close any outstanding Event
Plans. 

· General
Here you can turn the Template Manager warning message on or off. As well as find an option
to set the Query timeout length and error logging Level.
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Also, when working with large projects you can specify the maximum number of rows to load
in the Data views (Station List, Station Data and Data Filter tabs). The default is 10,000 rows.
This can help prevent long wait times as HGA is trying to load data. If a maximum has been
reached in one of the data views you will notice this indicated at the bottom of the tab. It will
also indicate the total rows that are stored in the database.

There are 4 levels of logging available:
· Error - this logs unexpected (bad) things
· Warning - this logs the errors as well as warning which might point to impending errors
· Information - this logs errors and warnings as well as other helpful things
· Verbose - this logs errors, warnings, information as well as debugging information 

The Warning level is the default level - however if you are encountering errors Technical
Support may suggest to increase the logging level and have you reproduce the issue and then
send the log file to help us understand the problem.
However, be aware that changing the level to Verbose may have a negative impact on
performance - so you might want to lower the level once you have provided Support with your
log file!

· Start Page
Here you can specify if you want the Start Page to be hidden after opening a project as well
as if you want the Start Page to be shown when you start HGA.
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Additionally, you can change the number of projects to show in the list of recently opened
project - or even clear the list completely.

· Help
Here you can specify if you want to use the Online Help (Recommended) or the Local (In
Program) Help. We recommend the Online Help (if you are connected to the internet) as this
set of documentation can be updated more frequently that the Local Help.
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· Template Files
Here you can specify where you want to store the HGA template files. These template files
include the database template files used when creating a New Project as well as the office

template files for printing to ExcelTM and PowerPointTM as well as the WordTM template used
for printing Event Plans. The office template files are organized into appropriately named
folders. Do not adjust the folder names as this is how HGA knows which templates are
available.
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You will also find the option to restore all the templates - incase you want to move them to a
different location or if you have made changes to the original ones and want to revert back.

· External Programs - Here you can specify the location of the AquaChem and AquiferTest
program locations. This allows HGA to launch these programs from the Main Toolbar.
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· Scene Viewer  

Here you will find the option to switch between using your hardware accelerator of Microsofts
driver for the Open GL Driver to be used in the Scene Viewer. The default recommended
option is to use your hardware accelerator, however, if you have an older machine or
encounter difficulties with the way things are visualized within the Scene Viewer you might
consider switching to the MS Driver option.
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The HGA Settings dialog also has a Reset button which will allow you to reset ALL the
settings to default settings.

4.1.10 Default Tab Layout

The Default Tab Layout will restore your HGA main interface to show the Project Tree on the
left and the follow four tabs on the right:

· Station List
· Station Data
· Data Query
· Data Filter
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Any other tabs that were opened will be closed. Any other tab groups that were created will
be removed.

4.1.11 Exit

This menu item will close HGA, and all related windows (if any are open).

4.2 View
The View menu allows you to reopen any closed tabs. The tabs you can view include:

· Start Page
· Station List
· Station Data
· Data Query
· Data Filter
· Well Profile
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 Please be aware, there are other modules that will launch as a tab (for example the Query
Builder, the List Editor and the Material Specification Editor) but you view these by selecting
these modules from the Modules Menu or by selecting the Icon in the Main Toolbar.

4.2.1 Start Page

If you have closed the Start Page tab you can reopen it by selecting it from the View menu.

4.2.2 Station Data

If you have closed the Station Data tab you can reopen it by selecting it from the View menu.

4.2.3 Station List

If you have closed the Station List tab you can reopen it by selecting it from the View menu.

4.2.4 Non Station Data

If you wish to see data in tables that are not related to the Station table you can open this
data tab by selecting it from the View menu.

4.2.5 Data Query

If you have closed the Data Query tab you can reopen it by selecting it from the View menu.

4.2.6 Data Filter

If you have closed the Data Filter tab you can reopen it by selecting it from the View menu.

4.3 Modules
Any module you wish to use within HGA can be found in this menu option. Each Module is
explained in further detail in following sections.

4.3.1 Template Manager

The Template Manager provides the tools to modify the HGA database structure, and define
user-level views.

The Template Manager captures the schema of the database and displays database and view
settings. The following features are available:
· Adding and deleting tables/fields
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· Altering the properties of each table and field defining primary keys, defining relationships
between tables

· Grouping tables under logical data categories
· Defining visibility of tables and/or fields
· Defining user level table and/or field names, units, and data formats (where applicable).
· Save user templates as a new database schema structure
· Rename fields, add fields to data categories, and modify the field formats

For more details, please refer to the Template Manager section.

4.3.2 Import

HGA has several import options for you to import your data into the program. These include:
· General 
· EDD
· Mobile EDD
· Chemical
· MON
· LAS

Note: When formatting your excel source file for importing using the General,
Chemical or EDD import options it is important to organize your station names so
they will be recognized by the import routine. Excel will take the data type format of
the first 8 rows for each column - therefore, if you have station names that are
completely numeric (Data Type Double), the import options may have difficulty
recognizing them as names (Data Type String). To avoid this you will need to ensure
that you manually assign the data type within Excel as text. You do this by right
clicking on the cells and selecting Format Cells... and then selecting the Text option
in the Number tab dialog that appears. You will notice that your numeric station
names are now left justified in the excel column.
If you have completely numeric Sample ID's you will need to do the same for this
column. In fact any field in the HGA database that is set to have a data type "String"
you will need to do this in order to be able to import completely numeric values.

If you are trying to import non detect values with the Chemical import option
then you need to consider rearranging your data sheet so that results with a non
detect (< symbol) is within the first few rows so that excel recognizes the data
expected for that column.

To find more information on all these options review the Importing Data section.

4.3.3 EDD Template Designer

EDD Template Designer



Menu Bar 103

© 2017 by Waterloo Hydrogeologic

You can find this option by selecting Project / Export. In this first step of the workflow you
can create a template (which can be opened in Excel) for others to use to validate their data.
In the EDD Template Designer you select which fields you wish to have in your template by
simply dragging and dropping them onto the Template Format.

The list of available fields on the left are provided as you would be used to seeing them in the
Template Manager or the Query Builder. First branch are the Data Categories, next branch
are the Tables, and the final branches are the fields. As you drag and drop fields into the
Template Format section you will notice that other fields may show up there automatically –
these are also bolded. These are fields that are required to be able to import the data into the
select table.
If you select fields from the Single Sheets tab – the Template will create a new worksheet for
each table where fields were selected from. In the example above fields were selected from
both the Parameter Sample and the Parameter Result tables – and therefore when you open
this template in Excel you will find both a worksheet was created for each table.
If however you select the Grouped Sheets tab – you will notice that the fields are presented in
another way. Here you will find the tables that are related to each other (by database foreign
keys) are grouped on a branch. When you select the child table (lowest branch) you will find
a list of ALL fields of the related tables below.
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When you select fields from the Grouped Sheets tab you will create a template with only one
worksheet.
You have some additional options when creating your EDD Template. You can set a version
number (to keep tracked in case in the future you wish to update a template). A submission
URL can be set as either an email address or as an FTP folder to upload to. A Template
Version URL can be entered so that when using the template in the HGA QuickChecker and
the EDD import routine it can be verified that it is the most up to date version of the template.
Additionally, you can add conditions onto the fields you have chosen that the HGA
QuickChecker will verify. For example – you can make the Sample Date field required (even
though it is not a required field to enter the data into the database).
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4.3.4 Query Builder

This menu item loads the Query Builder, which provides options for tasks related to queries.
In the Query Builder, there are options for creating new queries, or loading previous queries.

The  button in the toolbar performs the same function.
For more details, see the Query Builder section.

4.3.5 Quality Control

This menu item loads the Quality Control component; with these tools, you can manage Lab
Quality Control templates, and perform a quality control assessment.
For more details, please see the Lab Quality Control section.

4.3.6 Material Specifications Editor

The Material Specifications Editor provides options for editing material specifications,
specifically creating/editing soil classifications for your project. This Editor displays a list of
standard soil specifications shipped with HGA, and allows the display of the soil type names
and patterns for each classification.
The Material Specifications Editor may be launched from two locations:

Select the Material Specifications option from the Modules menu, or click on the  
button in the main toolbar.
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The Material Specifications Editor will appear as a tab in the main HGA view, as shown in the
following screenshot. Any view or module which loads as a tab may be pulled out of the main
HGA view and dragged to a secondary monitor if you wish.

The left side of the tab displays the existing specifications (which may be chosen from the
drop down box). 

The right side of the tab provides the option for editing an existing custom material
specification or creating a new one. 
Please Note: You are not able to edit the specifications that come with HGA - you can only
edit a custom made specification.

In the Existing Specification side the following buttons are available:

Use the  buttons to navigate through the individual entries for
a specification.

Use the  button to set the selected specification as the project default.

Use the  button to delete the specification.

Use the  button to edit the selected specification (only available if you have selected a
custom specification) this will move the specification to the right side of the tab for you to
make your edits.
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Use the  button to export the specification.

In the Edit Specification side the following buttons are available:

Use the  button to create a specification (don't forget to provide a name).

Use the  button to add a new entry to the specification.

Use the  button to delete the selected entry from the specification.

Use the  button to save the specification (it will now be available on the Existing
Specification side of the tab).

Use the  button to import images file (bmp or jpg) to be entries in the specification.

Use the  button to import names for your entries in the specification.

Use the  button to export the specification.

Creating a New Specification

When creating your own custom specification you may borrow the names and images from
existing specifications.

Use the  button to copy a single entry from an existing specification to your custom
specification.

Use the  button to copy all the entries from an existing specification to your custom
specification.

To select an image to be associated with an entry simply select the image cell and you can
browse to the location of your image. 

 When importing to create your specification ensure that you have the same
format for your source file as what appears in the  Material Specification Editor. That
means there are 2 columns with the following headers: Name and Image. The
minimum that needs to be populated is the Name.

Please Note: If you want to re-use this custom specification in a new project,
you must save the database template. Then, create a new project with this new
database template, and the specification will be available. For details on saving
database templates, see the Template Manager section Exporting the current
template as a Database template.

4.3.7 List Editor

The List Editor provides the ability to create and customize lists for any field - allowing for
efficient and effective data entry. A list in HGA may be considered as a lookup table - they
become drop down lists within the interface (i.e. on the Station Data tab).
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Select the List Editor option from the Modules menu, or click on the   button in the main
toolbar.

The List Editor will appear as a tab in the main HGA view, as shown in the following
screenshot. Any view or module which loads as a tab may be pulled out of the main HGA
view and dragged to a secondary monitor if you wish.

On the left side of the tab you will find the database structure tree (similar to what you find in
the Template Manager or Query Builder).
Select the field you wish to create a list for by highlighting it in the tree.

On the right side of the tab you can generate your list by using any of the following buttons:

Use the  buttons to navigate through the individual entries for
a list.

Use the  button to add a new entry to the list.

Use the  button to delete the selected entry from the list.

Use the  button to save the list.

Use the  button to import images file (jpg or bmp) to be entries in the list.

Use the  button to import names for your entries in the list.



Menu Bar 109

© 2017 by Waterloo Hydrogeologic

Use the  button to export the list.

 When importing a file to create your list ensure that you have the same format
for your source file as what appears in the List Editor. That means there are 4
columns with the following headers: Item Name, Include, Description, and Image.
The minimum that needs to be populated is the Item name.

Please Note: If you want to re-use this list in a new project, you must save the
database template. Then, create a new project with this new database template, and
the list will be available. For details on saving database templates, see the 
Managing Database Templates section.

4.3.8 Event Planning

The Event Planning module ensures that your field activities are always completed correctly
and on time. Easily create multiple schedules for various stations and then create event plans
that outline the details of your field activities including stations to be sampled, data to be
collected, field checklists and more. Event plans are automatically converted into reports
which can be printed and given to field personnel. Hydro GeoAnalyst keeps track of all your
event plans and automatically reminds you in advance when scheduled field activities are due.

The icon launches the Event Planning module.

For more details see 

4.3.9 Time Series Plotting

The plotting component in Hydro GeoAnalyst allows users to create time series plots of data
stored in the HGA database. A query is required to be the source of data for a time series

plot to be created. The  icon in the main toolbar launches the Time Series Plotting
module. 

For more details see Time Series Plotting. 

4.3.10 3D Interpolation

The Scene Viewer is able to display and animate 3D volumetric plumes of one or more soil or
groundwater contaminants. The plume is generated using the 3D Interpolation tool, then
displayed with the Scene Viewer. The following section describes how to interpolate 3D
points data in order to create 3D plumes; for details on viewing the plume, see the Scene
Viewer section.
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The 3D Interpolation starts with a data set - the data set must be created by building and
executing and saving a query with the Query Builder. The query should contain the data set
your are interested in analyzing, along with the fields required by the 3D Interpolation. 
The following are required fields for the 3D interpolation, and as such, must be fields that are
present in your data query:
· X
· Y
· Z (elevation of sampling point)
· Value (concentration value for one or more contaminants)
· Sample Date (if transient plume display is desired)

The Z value should be a field that represents the depth or elevation at which the data value
(sample) was observed. If you want to display the plume on the same elevation scale as your
cross sections (where data is displayed as above mean sea-level) you may need to convert
your sample depths to sample elevations. This can be done in the query builder, by adding a
calculated display field, as shown below:

The last display field in the screenshot above, combines the sample elevation, and the screen
depth (from) fields; the screen depth is subtracted from the station elevation (or station TOC
elevation if desired), using the Expression below:
station.elevation - soil_sample.end_depth
and entering Z for the Alias. 
Executing this query, will produce the results shown below:
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The last column displays the calculated sample elevations (Z). This value should be mapped
to Z in the 3D Interpolation to generate your plume.

NOTE: It is recommended that the X, Y, and Z fields all be displayed with the same length
units.

Once you have created a data query, you may use the 3D Interpolation module to generate a
plume. To access the 3D Interpolation tools, select Tools / 3D Interpolation from the main
menu, and the following dialog will appear:
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In the 3D Interpolation window, specify the various settings related to the grid size, extents,
and data mappings.

3D Plume Project Name: Define the plume project name. One plume project can contain
multiple plumes (e.g. for one or more contaminants).

Add Data Source
Define the various properties relating to the data source:
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Data Source: select a field from the data query that contains the data to be interpolated (e.g.
concentration, or result value)
Name: define a name for the parameter
Date Field: select the field that contains the sampling date (if available)
Date Granularity: This option controls how to accumulate the data items of various date
stamps. For example, assume you have data for the following sample dates (could be from
the same, or other stations):
· 5 stations sampled on 03/05/99
· 6 stations sampled on 03/14/99 
· 4 stations sampled on 03/19/99
· 5 stations sampled on 03/27/99
· 6 stations sampled on 04/04/99
· 5 stations sampled on 04/15/99
· 4 stations sampled on 04/25/99

If you select Day for date granularity, you will obtain 7 data sets to interpolate.

If you select Month for date granularity, you will obtain 2 data sets to interpolate:
20 stations sampled in March, and
15 stations sampled in April
In this case, the first observation from a station will be selected.

If you select Year for date granularity, you will obtain only one data set, that will essentially
be a static plume. In this case, the first 1 data set.

When you have defined the settings, press the  (Add) button to add the mapped fields; the
values should then be displayed in the table at the bottom of the window.

To delete an existing 3D Plume, simply click on the  (Delete) button.

Grid Region
Define the various properties relating to the grid size:
· X Value: select a field from your query to be used for the X axis
· # of nodes: define the number of grid nodes in the X direction
· X min, X max: define the minimum and maximum X values for the interpolated grid; by

default, these will be read from the data source, however you may modify these values if
necessary

· Similar parameters exist in the Y and Z directions.

Interpolation Method:
Available interpolation methods include:
· Krigging (default), and
· Inverse distance
[Advanced Settings]: Press this button to see advanced settings for the selected interpolation
method. For more details, see "Appendix B: Advanced Interpolation Settings".
Interpolate log values: This option will interpolate the log values of the data points and then
invert the log value distribution. This option is useful when interpolating data with a high
degree of variance.

When you are finished, click on the [OK] button.
HGA will create a 3D plume file, in the "Plumes" sub-directory for your project, with the file
name provided, and the extension .nc. For example, TVOC.nc, in the directory:
D:\Program Files\HGAnalyst\Projects\Demo_Project\Plumes
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To display the plume, please proceed to the instructions in Scene Viewer.

In addition to the *.nc file, HGA will save a *.txt file that stores the results from the query (x,
y, z, value) that is used by the interpolator in generating the interpolation using the same file
name, and in the same "Plume" sub-directory.

NOTE: Currently there is no method of opening plume projects in the Interpolation tool, to
make modifications. Therefore, it is suggested that you save the data query so the 3D
Interpolation can be quickly re-created.

4.3.11 Well Profile

The Well Profile module can be used to display detailed information pertaining to a single
station or well including:

· Well construction details (casing, screens, annular fill)
· Geophysical data plots
· Lithology information for each formation
· Description of the geologic formation
· The depth and or elevation of each layer
· many others...

The  icon in the main toolbar launches the Well Profile module.
 
For more details see Well Profile.

4.3.12 Map Manager

This menu item loads the Map Manager. The Map Manager can be used for creating and viewing site

maps, creating thematic and contour maps, and defining cross section lines. The  icon in the main
toolbar launches the Map Manager module.

For more details see  Map Manager.

4.3.13 Cross Section Editor

This menu item loads the Cross Section Editor. This module can be used for defining and displaying

geological, hydrogeological, and model layer cross sections. The  button in the main toolbar
performs the same function.

For more details see   Cross Section Editor.
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4.3.14 Scene Viewer

The Hydro GeoAnalyst Scene Viewer is an advanced three-dimensional visualization and
animation component for displaying and presenting cross sections created with the mapping
component included with Hydro GeoAnalyst. Specifically, this can be used to display multiple
cross sections in the form of fence diagrams using a variety of three-dimensional graphical
formats. In addition, basemaps may be displayed for relating the fence diagrams to surface
features. The graphical tools and presentation formats available are specifically designed for
viewing geology and hydrogeology data.

The  icon launches the Scene Viewer.

For more details see the Scene Viewer section.

4.3.15 AquiferTest

In order to use the AquiferTest analysis feature, you must first have AquiferTest 2011.1 or
later installed on the local machine, and specify where the program is installed in the  HGA
Settings on the External Programs tab.

Use this feature to analyze pumping test data in AquiferTest. For this feature, you must have
one or more data queries that contains the required fields for a pumping test analysis,
namely:
· Well Name
· X Co-ordinate (for both Pumping Wells and Observation Wells)
· Y Co-ordinate (for both Pumping Wells and Observation Wells)
· Pumping Start
· Pumping End
· Pumping Rate
· Observed time
· Observed depth to water level

Additional fields may also be mapped and the data sent to AquiferTest; these include:
· Well Elevation
· Screen Diameter
· Borehole Diameter

For your convenience, these fields are included in the Environmental templates, in the Well
History tables.
The following section describes these settings:

In the first tab, define the project units you would like to use for AquiferTest, and populate the
Pumping Test information.
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In the Pumping Wells tab, select the data query that contains the required fields for this
module, for your pumping test analysis. Then, in the grid below, map the appropriate field to
each required field. If the unit for the field is defined in the database template, then the unit
will be automatically populated. Otherwise, this will be left blank. If needed, you can manually
enter a conversion factor, to convert the data from the HGA source, to the AquiferTest project
target units.
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NOTE: For station X,Y co-ordinates, the AquiferTest project units must be the same as the
unit system used for the HGA project (for example, if your HGA project is using UTM, set the
AquiferTest units as meters; for some State Plane, set the AquiferTest units as feet).
Currently, there is no conversion for these units.

In the Pumping Rates tab, the workflow is the same as earlier mentioned. In this tab, you
must map the well name, pumping rate, and the start and end interval.
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In the Observation Wells tab, the workflow is the same as earlier mentioned. In this tab, you
must map the well name, X,Y coordinate, and the observation date/time and observed depth
to water level.
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Once all the required fields are defined, click the Analyze button to send the data to
AquiferTest. For more details on how to use AquiferTest, please refer to the AquiferTest help.

4.3.16 AquaChem

 
In order to use the AquaChem (Water Quality Analysis) feature, you must first have
AquaChem installed on the local machine. When you  select Modules / AquaChem (or select
the icon from the toolbar) HGA will search for the installation, however, if it can not be found
you will be prompted to browse to the location of your AquaChem executable
(aquachem.exe).

Then it will check the current project database to see if the Geochemistry Extension has
been added - if this has not been added you will be prompted to add this extension.

http://www.waterloohydrogeologic.com/help/aquifertest/
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It is always a good idea to make a backup of our database before adding this extension.
The Geochemistry Extension will add several tables and fields required to allow AquaChem to
run on the HGA SQL database.

If you use the standard template it will use AquaChem's Demo_Basic.tpl file to perform the
geochemistry extension. If you have a different naming convention for your chemical
parameters you should use your own (custom) AquaChem template to perform the
geochemistry extension.

Once the Geochemistry Extension has been added to the project database AquaChem will
launch.
The next time you open the HGA project and select Modules / AquaChem it will simply
launch AquaChem.

When using AquaChem with HGA, keep in mind that AquaChem is intended only for its
presentation and calculation features. Data entry and maintenance operations should be
performed centrally through the HGA interface and not the AquaChem interface. 
The operations that must be performed in HGA include:

· Importing data
· Creating new samples 
· Creating new stations 

Please keep in mind that there are specific table and field requirements in the HGA project
database in order to allow the Geochemistry Extension to be properly added to your project
database. The following tables and fields are required:

Station
ID
Name
X
Y
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Elevation
TOC
Depth

Parameter Sample
sample_id
lab_id
sample_date
comment
watertype

Parameter Result
sample_id
chemical_name
result_value
result_unit
reporting_detection_limit
sampling_precision
analysis_method
qualifier
outlier
comment
analysis_date

These tables and fields are all included in the current Environmental (metric or imperial)
versions of the Database Templates provided with the installation of HGA. You are free to
change the View Settings for these tables and fields (for instance to change them to a local
term or another language) however,  the database settings must remain. 

Limitations:

X and Y coordinates
When using an HGA project with projected coordinates, the X and Y coordinates in the
database are stored as latitude and longitude (WGS 1984) in decimal degrees. When linking
with AquaChem this information will be shown in the Coord_Long and Coord_Lat fields within
AquaChem. While working in AquaChem these can be converted back to UTM and shown in
the X and Y fields by using the UTM Conversion tool (found under Tools/Calculators menu).
The X and Y fields will then NOT be dynamically linked to the HGA X and Y fields. Therefore
when needing to make changes to the coordinates you must make the change in HGA and
then re-run the UTM conversion in AquaChem.
When using an HGA project with local coordinates, the X and Y coordinates are stored as is
in the database. Therefore when linking with AquaChem this information will be shown in the X
and Y fields of AquaChem (and no further conversion is required).

4.3.17 Parameter List Editor

The Parameter List Editor allows you to create groupings of parameters to make it easier to
list which parameters will be analyzed by the lab within the Event Planning module.

For more details see Event Planning.
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4.4 Database
Enter topic text here.

4.4.1 Manage Databases

Use this option to remove unwanted databases from the local instances of SQL Express. This
option is available when HGA is first loaded, and no projects have been opened. 
The following dialog shows the options that are available.

In this dialog, select the Server and the Database that you would like to delete. Once the
database is selected, a list of projects using the selected database will be listed at the
bottom; the project list is read-only, and displayed in order to assist you to decide if the
selected database can be safely deleted.

Click on the   button, to compress the file size of the database, to save disk space. After
the database has been compressed, you may continue to work with it.

Click on the   button to delete the selected database.
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Click on the  button to delete a project from the database (as a database may include one
or more projects).

Please take note of the Delete Method - by default Data Only is selected. Only the data from
a project or database will be deleted. If you also wish to delete the associated Project files
you must first select the Project Folder and Data option before deleting the project or
database.

NOTE: Use caution when deleting databases, since the data cannot be recovered once
deleted, and there is no "undo" option unless you have taken a backup.

4.4.2 BackUp Database

Use this option to create a backup copy of the SQL Server database used by the current
project. A backup of the database is helpful, in order to preserve data, or to detach and send
the database to colleagues or Technical Support.
Select this menu item and provide the directory path for the file. It will be saved with the name
of the database and the .BAK extension.

You also have the option to make a copy of the all the project files as well.

Please note that if the folder already exists all data from the folder will be deleted in order to
create and save the backup.

NOTE: Backup  Database works only if you are running HGA on the system that
also hosts the SQL server. SQL Server does not permit saving the back up copy of
the database to a mapped network drive; it can be saved only to a local drive.

4.5 Help
Displays either the online or in-program HGA Help depending on the settings specified under 
HGA Settings.
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4.5.2 About

Displays the HGA Info dialog. This contains the HGA version number, serial number and
information on how to contact Waterloo Hydrogeologic.

4.5.3 Release Notes

This option opens your default internet browser to display the online ReadMe file explaining
the changes and additions to the program for the last several releases.

4.5.4 View Log File

By selecting Help / View Log file the HGA log file will open up (usually in Notepad). This log
file can be helpful for troubleshooting issues.

4.5.5 Email Log File

By selecting Help / Email Log File a new email will be created within OutlookTM with the Log
File attached and addressed to our Technical Support department
(support@waterloohydrogeologic.com).  The log file can be helpful when trouble shooting
issues.

4.5.6 Problem Steps Recorder

By selecting Help / Problem Steps Recorder you will initiate a Windows program you can use
to record the steps you are taking within HGA that is causing difficulties. This can be helpful
to send to Technical Support to better describe exactly the steps you are taking when you
encounter a problem.

The program is very simple to use - simple select Start Record and then reproduce your
steps within HGA. Once you have finished select Stop Record and you will be prompted to
save the recording as a .zip file so you can send it to Technical Support.

Please be aware this option is only available on Windows 7 or later operating
systems.

4.5.7 License...

This menu option provides the ability to request a license as well as install a license.
If you are working with a Team License you will also find the option to check out and check in
a license.

mailto:support@waterloohydrogeologic.com)
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5 Creating New Projects

 This section presents information on how to create new projects, and modify the properties of
existing projects. A new project is usually created with a completely new database
however,HGA is designed to also allow for managing multiple projects on a single database. 

The most common workflow is to create a new database for each new project and that
workflow is documented here.

Starting the New Project Wizard

The New Project Wizard can be launched in two ways:
· Select Project / New from the Main Menu; OR

· Click on the  button on the Start Page.

The New Project Wizard will then appear. The Project Wizard contains various steps, each
step appearing in a new window, with the various settings for a new project. It is designed in a
sequential fashion; after defining the necessary inputs in each window, press the Next button
to proceed. The Next button will only become activated after the necessary fields have been
defined. 

5.1 Select Data Source
The first step in the New Project Wizard provides the data source settings options.
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HGA allows you to choose between Microsoft SQL Server or using the Local Database
option.

If this project is intended only for you (others will not need to be given access) then the Local
Database option can be used. It does not require any additional Microsoft SQL Server
installation - as this is already done (silently) during the HGA installation.

If however, this project will need to be accessed by multiple users you should use the
Microsoft SQL Server option.We currently support Microsoft SQL Server 2012 or 2014
(Express or Full editions). 

Local Database
If you have selected to use the Local Database you only need to specify the Instance name of
your local database. When it is installed with HGA it is named Waterloo - however if you have
another instance installed you can use that as well. And then provide a name for the
database.

If Local Database does not appear in the dropdown consider closing and then
restarting HGA to initiate the Local Database. In some cases you may have to restart
your machine.

Microsoft SQL Server
If you have selected Microsoft SQL Server you will need to select the SQL Server that will
hold your project database and then provide a name for the database.

You have two options for authentication:
1. Windows Authentication (default)
2. SQL Server Authentication

Windows Authentication uses your log in to authenticate you on the SQL Server while SQL
Server Authentication requires you to enter an appropriate User Name and Password to be
authenticated on the SQL Server.

Please Note: Appropriate permissions need to be provided to use either of the
authentication options. Please contact your IT support to ensure you have
appropriate permissions to create new databases or create new projects on existing
databases.

If you cannot see your local instance of SQL Express when creating a new
project, or opening an existing project, please refer to Connection Problems for
some troubleshooting suggestions.

Select the Next button to proceed to the next step in the New Project wizard.
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5.2 Select Template
This step  in the New Project wizard allows you to select which database template to use for
your project. Provided with HGA is a metric and imperial version of our Environmental
template.
When you select a template from the drop down list you can review the database structure in
the preview below.

If you have exported a database template from another project would like to use it to create a
new project select the browse button and browse to the location of your template (*.hgat).

Select the Next button to proceed to the next step in the New Project wizard.

5.3 Provide Project Details
This step  in the New Project wizard allows you to specify a project name and location for
your project folder.
Additionally you can select a Material Specification and then the Projection Type and
Projection to be used for your X and Y coordinates.
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The Unit for your projection will be selected automatically, based on the selected projection
type (e.g. UTM will use m, State Planer will use feet, etc.). 
If the Local Projection Type option is selected, you can select the desired unit from the drop
down box.

 If Local Projection Type is selected, the project coordinate system cannot be
changed once the project is created. Furthermore, all imported spatial data must
already be expressed in local coordinates as HGA does support conversions from
projected/geographic coordinates systems to local systems.

Depending on the projection type that you select, you may also be required to select an
appropriate Geotransformation for your project. If required, the following dialog will display:
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Simply select the area that best represents the spatial extent of your geographic data from
the list, and then click the [Ok] button. Note: You will not be able to create the project until
you have selected an area.
For more details on defining geotransformation settings, please refer to Appendix F:
Configuring Geotransformation Settings

Once you have specified the projects settings select the Next button to proceed to the final
step of the New Project wizard.
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At this final step you can decide if you want to go back and adjust any selections or settings
you made or complete the New Project wizard by selecting the Finish button.

A new project will be created, with the necessary tables, fields, and settings. Please be
patient during this process. The new project should then appear in the main HGA interface.
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6 Template Manager

The Template Manager is one of the most powerful tools provided with Hydro GeoAnalyst. It
allows you to edit the structure of your database. 

The Template Manager provides the tools to:
· Add or Delete tables and/or fields
· Alter the properties of tables and fields
· Define relationships between tables
· Group tables under logical data categories
· Save database templates for future projects
· Set visibility of tables and/or fields
· Setting user level table and/or field names, display units (where applicable), and data

formats (where applicable)

Understanding the Template Manager

Hydro GeoAnalyst comes with our standard environmental database structure (in metric and
imperial templates) that are currently in use around the world. When creating a new database
for your project, you have the option of selecting any of the provided database templates or
simply selecting No Template and have only the table and fields required by HGA added to
the project. This allows you to completely customize your project.

All database structure templates that come with Hydro GeoAnalyst also come with their
respective report and well profile templates. As such, if one of the existing database
templates is selected during the project creation, these templates will be copied to your
project by default. You can later edit them or even remove them from your project if desired.

The Template Manager allows you to modify the view of the database. For example, you may
only need to view tables that are related to geological investigation data. The Template
Manager allows you to hide all unwanted tables and/or fields from view and display only a
smaller set of relevant tables and/or fields.

The Template Manager allows you to export the currently active database structure as a new
database structure, for use in creating new similar projects.

You can launch the Template Manager from the main toolbar by selecting the   icon or by
selecting the Modules / Template Manager menu option.

6.1 Interface

On the left hand side you will find the tables and fields organized into categories. By selecting
any item in the tree on the left hand side you will find all the properties of the item displayed
to the right.
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In the image above you can see the Lithology Table properties displayed. All the fields in this
table are found by opening the Lithology table branch. Primary Key fields are indicated with a 

 icon while all other fields use the  icon.

 Please be aware that certain tables and fields are required by HGA - therefore
you may not be able to change the Database Name of these (they will be grayed
out). However, you can change the Display Name so that these tables and fields
appear as you would like to see them in the main HGA interface.

You can adjust which tables and fields you see within the main HGA interface by simply
adjusting the visibility option (ie. turn tables and fields on or off).

 Not visible in the main HGA interface

 Visible in the main HGA interface

To add more items to your database structure (you can add as many as you like) you need to
use the following options in the tool bar:

 to add a new category

 to add a new table

 to add a new field
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To adjust the order of items in your database structure you need to use the following options
in the tool bar:

moves the item (category, table or field) you currently have selected up

moves the item (category, table or field) you currently have selected down

6.2 How to add Tables and Fields
When you are ready to adjust the structure of your database and want to add a new table use

the  icon.

You will find a dialog appears when you can specify the Table Name as well as the Category
the table should go into.

Then you can add as many fields as need for your table by using the  icon.

Be sure to provide a name for each of your fields as well as indicate which field you would like
to assign as the primary key for the table.

 Please note that if you do not assign a primary key field to a table HGA will add
a field named tablename_ID and set it to the primary key, as well as making it an
auto-increment field.

 Please note that the auto-increment option is only available at the time of table
creation (or field creation). You cannot assign this option to a field after the field has
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been created. Therefore it is important for you to consider your table properties
carefully before beginning to make new tables.

Take note to select the appropriate Data Type for each of your fields and specify whether or
not Nulls are allowed in that field.

If you wish to set a field to be an auto-increment field its data type MUST be integer.
If you set a field to be double (think of this as a measured number) then you should also set a
Unit Category and a Unit.

By default the table will be automatically linked to the Station table. However, you now have
the option to remove this link (uncheck the Automatic link to station table option at lower left).
We refer to these tables as Non Station Data tables.

 Please note that to enter data to a Non Station table manually there is now a
new tab: Non Station Data Tab that allows for this. You can also import data to a Non
Station table using the General Import options within the Data Transfer System
described in the Importing Data General section.

When you select the OK button the table will be created and you will find it in the database
tree within the Template Manager. If you decide you need additional fields in the table simply

select the  icon and the Add Field dialog will appear.

Simply provide a name for the field and select the appropriate Data Type from the drop down
list. Select the OK button and the new field will be added to your table.

6.3 How to set a Field to use a List
Would you like to establish a set of valid values allowed to be entered for a field? You can do
this by setting a field to use a List and then create the list within the List Editor.
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When you select a field in the Template Manager you will find the option to set a List Style as
well as a List Type.

You will find three options in the List Style drop down:
None - this means there will be no list available for this field
Optional - this means there will be a list available for this field, however you can still enter
things other than the list items
Required - this means you can only enter items from the list for this field (nothing else will be
allowed

You will notice that you have two options in the List Type drop down:
Generic - this means you will need to create your list in the List Editor (you will notice the
icon appears so you can launch this module and make your list right from here)
Soil - this means you will need to create your list as a Material Specification (and make sure
to set your material specification as the Project specification.

6.4 How to Adjust Table Relationships
Many tables within the standard environmental database template of HGA have relationships -
one table can be referred to can the Parent table and it is related to a Child table by a Foreign
key. 
A common example of this can be found in the Monitoring Even category. The Parameter
Sample table is the Parent to the Parameter Result table. The way this relationship is
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established is by a foreign key. Sample ID is the Primary Key in the Parameter Sample table
and it is the Foreign Key in the Parameter Result table.
This means that the Sample ID must be unique within the Parameter Sample table (to
indicate the unique sample that was taken at a particular station) - however, the sample
Sample ID will be found multiple times within the Parameter Results table as there will be
many results associated with the single unique sample (you will have one record for every
parameter that you had the lab analyze the sample for).

If you are adding new tables to your database you might also want to establish relationships
between your new tables.
Here is an example of how you can establish a relationship between 2 tables:

Lets say you have created 2 new tables in your database - one called Parent and one called
Child.
The Parent table has a date field as the primary key as well as a field to enter the name of an
event for your project. And the Child table has an auto-increment ID field as the primary key,
as well as a date field (which we will use to establish the relationship back to the Parent
Table) as well as a field to record an observation.

Here is how these 2 tables would look in the Template Manager:

You will notice that the Station field has been added to the Parent table because I made this
table have the automatic link to the Station table. However, the Child table does not have the
link to the Station table (because we are going to link it to the Parent table).

Now when I select the Child table I will find the settings for this table which includes an option
to set the relationships for the table.
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Select the  to add a new relationship to this child table and the Define Foreign Key dialog
will appear.
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From the drop down list select the parent table (in this example it is called Parent). Then
select the date field as the ParentKey and the date field as the ChildKey.

 Please note it is common practice to use the same name for the field in both
the Parent table and the Child table. Additionally the fields must have the same data
type.

When you select the OK button and review the Child table you will see that the relationship
has been established.

6.5 Managing  Database Templates

If you have made many changes to the database structure as well as perhaps set up List
Editor lists on fields in your database and think you might want to re-use the structure for

another project you should export your project settings as a template by selecting the 
icon in the Template Manager.

This will save a *.hgat file where all your templates are saved. The default location is  D:
\Documents\Hydro GeoAnalyst\Templates\Project however you may have changed this. You
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can find out where your HGA template are saved by selecting Project/HGA settings from the
main HGA interface.

This way when you go to create a new project you will now have the option to select your own
database template (instead of just the standard ones provided with HGA).
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7 Importing Data

The Data Transfer System (DTS) is a flexible tool used for importing data into an HGA project.
When starting a new project, it will be necessary to enter data from other sources into the
HGA database. While you can enter data manually on the Station List Tab and the Station
Data Tab  or Non Station Data Tab it is more efficient to import your data.

You launch the DTS by selecting Modules / Import or by selecting the  Import icon from
the toolbar. The DTS will launch and give you several options for importing depending on what
kind of data you wish to import.

The General option is the updated version of the original DTS. This should be used when you
are importing your stations - as it will perform the correct coordinate transformations.
Additionally if you need to convert units during your import you can do that within the General
option.

Then there is the EDD option - this lets you import the files that have been validated within our
Quick Checker program - an Excel plug in. As well as the Mobile EDD option which lets you
import data that has been submitted through a Mobile EDD form.

The Chemical option is available if you are importing chemical results (usually received from a
lab) and you need to separate out the < sign from your result value.

Then we also have a specialized import for Diver data (from our dataloggers) as well as one for
Log data in LAS files.
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You need to select the option you want and then select the Next button to launch the
appropriate module to import your data.

7.1 General
The General option begins with you selecting the file you wish to import. It supports the
following file formats: .txt, .xls, .xlsx, .mdb, or .accdb.
If you need to you can also build a connection string to another MS SQL Server and import
data directly from another database.

Once you have selected a file you will see a preview of the data. Select the Next button to
proceed to the Mapping step.
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On the Mapping step you need to select the table you wish to import into. In the example
above I selected the Location table (i.e. the station table) as I am going to import new
stations into my project.
Once I have selected the table I want to import into I can see the fields for that table on the
right hand side. Any required fields are highlighted green. The minimum required is the
Station Name. You will also notice that if the column headers in my source file (an Excel
spreadsheet in this case) is the exact same as the field in the database - they will map
automatically. It seems my column for elevation did not map - this is because in my excel
spreadsheet I just called it Elev - so I must map this myself by picking it from the drop down.

Additionally I need to indicate the unit for both the Elevation and TOC fields. As mentioned
previously this is to allow for unit conversion during the import process. You can see the
database I am  trying to import into has the Elevation and TOC set as meters (unit is found in
brackets in the Destination column). So if my source file is in feet I need to indicate that here.
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Select the Next button to move on to the next step - indicating the Projection. This step will
only appear if you are importing into the Location (Station) table as you need to indicate what
projection your X and Y coordinates are in.
In this case they are in the same projection as my project - so this is selected by default.

You also have the option to indicate if you wish to put these stations into a specific Station
Group. By default all stations will go into the All Stations station group - but you can also
place them into additional groupings to help you organize your stations (this can be very
useful later when you are querying the database).

When you select the Next button you will see a preview of the data to be imported.
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You will notice that the Elevation and TOC have been converted into meters. Select the Next
button to perform the import.

You can watch the progress of your import. When it is completed it will summarize how many
records were in your source file and how many were imported so you can compare. If data
contained any errors or caused any warnings a dialog would appear that summaries the
problems with your data.
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Select the Finish button to close the wizard. Your new stations should now be available within
the Station List tab.

7.2 EDD
The EDD option prompts you to specify the location of the *.zip_hga file that was generated
within the HGA QuickChecker. 
Please be aware that you should not attempt to unzip or modify the file in any way as this
can invalidate the file and cause difficulties importing the data.

As soon as the file is validated you will see the Validation Results dialog appear. Here you
may need to answer a question before continuing. For example the Validation found that
some of the station names I am trying to import do not exist in the database – therefore I can
choose to append the new station names or reject records for stations that do not exist. I
make my choice by selecting the appropriate option in the Action column. If I wish to see
which stations are not currently in the database I can select the Click Here to View Data
option. For this example I choose to Append the stations (so any station names in my data
that are not in the database will be automatically added).
Then the validation also found I have duplicates in the database – some of the sample IDs
already exist in the database! Again, I can select what I want to do – either overwrite what is
in the database or reject the duplicate sample IDs. For this example I will reject these sample
IDs.
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Now I can continue with the import. Now the Import dialog is updated – and I can see how
many records will be imported.
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Select the Import button to import the records – and the import dialog updates to inform you
that the import was successful. Now you can select another EDD file to import or close the
dialog box.

7.3 Mobile EDD
The Mobile EDD option allows you to import data that was submitted by a Mobile EDD.
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HGA will remember the Mobile EDD’s that you published for your project – you can select
them from the drop downlist. Then hit the refresh button to see the files that were submitted
from this site.
Select the file you wish to import and select the Import button.
You will see a validation dialog which shows how many new records will be imported. In this
example I created one new station and entered 4 new lithology records.
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Select the Import button to finalize the import process.
I can review the data that was imported within HGA – for example here are the 4 new lithology
records imported:
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7.4 Chemical
Use this option for importing your chemical data (samples and results) when stored in an .xls
or xlsx file. Please be aware you need to have a primary key on your Result table that
consists of the Sample ID and Chemical Name fields in order to import your chemical data
with this import routine. Please see Template Manager section for further information on
setting a primary key.

Step 1 Choose a Data Source
Select the source file you wish to import and you will see a preview of your data. You also
have options for setting which row to begin importing at and if the first row contains header
information.
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You also have the option to select if your result field contains Non Detect qualifiers (e.g.
<0.5), when you select the result field you will find that 2 new columns of data appear in your
data preview. one that contains just the qualifier and one that contains the value. These
columns can then be used for the mapping in Step 2.
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Step 2 Data Mapping
This step requires you to select the category and result table you wish to import the data
into. Fields highlighted in green are required. You also have the option to show the fields from
the sample table - this allows you to import information other than the Sample ID into the
sample table (for example the sample date).
As mentioned in Step 1 - here you can map the newly created result value_value and result
value_qualifier fields. All data within your result field that appears as a string (i.e. text) will
have been separated into the result_value_qualifier field. While all data that appears as double
(i.e. a number) will have been separated into he result value_value field.
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After selecting the next button you may receive a message indicating that some station
names were not found within the database. You will have the option to append the stations to
you station table or reject those stations (and the data associated with those stations).
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And then you will receive a message indicating any sample ID's that are not in your database
which will be added.

Step 3 Data Validation
In the last step you will see a preview of the data to be imported into the sample table as well
as into the results table. By selecting Finish the data will be imported.Any errors or warning
will also be displayed.
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After the records are successfully imported you will receive a message indicating how many
records were imported.

7.5 Diver
This option allows for importing data from a MON file, a format generated from datalogger
monitoring software such as Diver-Pocket, LoggerDataManager, or Diver-Office. MON files
consist of three sections: Logger Settings, Data Series and Data.
The Logger Settings section contains the current settings of the logger including the location,
sample method, sample interval, serial number and available channels.

The Data Series section contains information on when field measurements were taken.
The Data section contains all the measurements for each channel, ordered by date and time.
To import MON file data into your database, follow the steps below:
STEP 1: Select MON Data Files
STEP 2: Map Data Fields
STEP 3: Import Data into the Database

Please note that the MON data import procedure can accommodate multiple
MON files simultaneously. However, for demonstration purposes, only one MON file
will be used in the following guide.

Also, before you import data from MON files, the water level values need to be compensated
with respect to the top of the well casing. This can be done through Van Essen datalogger
software (Diver-Office, Data Logger Manager) by performing barometric compensation on the
MON data, using the "Top of Casing" method.

Diver data applications, e.g., Diver-Office, allow you reference the water level data in various
ways, i.e., with respect to the top of casing, with respect to a vertical datum, or with respect
to the Diver itself. The first step is to specify how the water level data is referenced in the
MON file.
Note: If you wish to show water level data on cross sections and borehole log plots, the water
level data must be reference to the top of casing (or ground surface) and the data must be
imported into the Water Level table.

Next, specify the MON data source:

Click the Open Folder button 
Locate and select a MON file(s), and click [Open].
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The selected MON file(s) will now appear under the Select data source frame (shown below).

Below the Select data source frame is the MON file Information table. This table contains the
datalogger information of the selected MON file.

To remove a MON file from the list, select the file and click the Delete button  .
Select the Next button to proceed to Step 2: Data Mapping.
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The next step in the MON data import operation is to map the MON file fields (source) with
the appropriate database fields (destination). To map a source field with a destination field,
F Select a source field from the MON file in the Select Section Field frame
F Select the matching HGA destination field from the Select Table Field frame
F Click the Map button.
Rules for Mapping
The Station Name field of the Location table must be mapped.
All destination tables and fields must already exist in the HGA database.
All channel tables (e.g. Level, Temperature, Conductivity, Oxygen) in the database must
include a Screen ID.
All mapped tables in the database must have primary key(s) mapped.
Data type of mapped fields must be compatible.
The mapped fields will now display in the table at the bottom of the Data Mapping
Configuration dialog. Repeat this process for additional fields.

To remove mapping,
F Select the appropriate row in the preview grid

F Click the Delete button  .
Select the Save mapping to database checkbox to retain the mapping for future MON file
import operations.
Select the Next button to proceed to Step 3: Importing Data into the Database.
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From the Select Channel frame, select a parameter (i.e. Level, Temperature, Conductivity,
Flowman). NOTE: A selection is not necessary if all the channels are inactive (greyed-out).
HGA will read the station name in each MON file, and attempt to find an appropriate station
match in the current HGA project database. If one is found, you may proceed. Otherwise, the
field will display a color and you must specify the appropriate destination station name.
The color displayed in the information table represents the number of station names that can
be matched with the location information in the MON file.
White: indicates that a single station name has been found.
Red: indicates that a matching station name could not be found.
Yellow: indicates that two or more matching station names exist in the database.

If a row is either red or yellow, click the  button and manually specify a destination station
name from the database.
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From the Get Station&Screen dialog, select a destination station and a screen id. Click the
List Matched button to open the List Matched dialog. This dialog will display all the possible
station and screen_id combinations that match the MON data. After selecting, click [Ok].
Click the [Import] button to finalize the data import. Selecting the OK button will close the
import dialog.
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7.6 LAS
This option allows for importing data from an LAS (Log ASCII Standard) file, a standard format
introduced by the Canadian Well Logging Society in 1989. 
The LAS file contains two types of sections:
Well Information Section: data related to the station (location, driller, etc.)
Parameter/Curve Information Sections: descriptive and/or measured data for one or more
down hole parameters.

When importing the LAS file in HGA, the following options are available:
Import the Well Sections and Parameter/Curve sections; use this option if you want to import
a new station, and one or more measured parameters for this station. A new station will be
added to the database, using station details (name, co-ordinates, etc.) in the LAS file. If the
station already exists in HGA, you will be prompted to overwrite the details, using those in
the LAS source. In addition, data from one or more parameters (Parameter Sections) may be
imported to one or more tables in your database.

Import only Parameter sections; use this option if this station already exists in your project.
HGA will read the station name in the LAS file, and attempt to find an appropriate match in
the current project.

When you select this option, the following dialog will appear:

The first step requires selecting the data transfer package and data source.
A Data Transfer Package (DTP) is designed to store all settings of desired import operations
that may be repeated from time to time. For example, importing several LAS files containing
the same measured parameters. The DTP contains information about the data source, the
selected destination table(s), matching between source and destination tables and fields,
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source units, and a number of other settings. You may create an import package, or select
from existing packages.

All Data Transfer Packages (if any) are listed for selection at the beginning of all data transfer
operations. If an existing package is selected, the import routine loads all information stored
in the package. The information can then be reviewed and updated as desired before as you
move through the data transfer operation.

After selecting the package, select the Data Source; please note the following limitations:
· HGA currently supports LAS v.2.0.
· Third dimensional data array handling is currently not supported
· Multiple log runs is currently not supported

When you are finished, select the Next button in the lower right corner to proceed to the next
step. The next step is Data Mapping.

The next step in the data transfer operation is to match a source table with a destination
table.

You may map the entire LAS file (including the Well Section), or just down hole parameters; if
you do not include the well section, you must have the appropriate station already created in
your project. HGA will read the station name in the LAS file, and attempt to find an
appropriate match in the current project. If one is found, you may proceed. Otherwise, you
must include the well section, or terminate the import routine and return to HGA and create
the appropriate station (using the same station name as found in the LAS source).
If duplicate station names are found in the database, there will be a prompt to select the
appropriate station.
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The Data Mapping window is divided into two frames:
The Source well section, found on left side of the window; and
The Destination tables and fields, on the right side of the window
The Source frame (which contains the data to be imported) can be expanded on the left side
of the window. If the field names in the source are identical to those in the destination, then
the fields will be matched automatically. For all others, you must map the fields using the
procedure below.
The Destination frame contains the database schema: all tables and fields under their
appropriate data categories. From this frame, select a Category, then a Table from this
category, and a list of fields will be displayed in the grid on the right side of the window.

Mapping
Mapping fields from the LAS file to the database is described below:
· Select one field from the source file in the left frame
· Select the appropriate matching field from destination in the right (by expanding the

appropriate data category and table)
· Click on the Map button
Mapped fields will then be added to the Preview grid at the bottom of the window. Repeat
these steps for additional fields.
To remove the mapping for a selected field,
· Select the appropriate row in the Preview grid
· Click on the Delete Mapping button

Units
Due to the flexible nature of the LAS file, there may exist one or more parameters with units
that are not supported in HGA; as such, unit conversion will not be possible during the import.
Where the unit categories and units exist, HGA will attempt to do unit conversion, and import
the data. If the destination field does not support the selected source units, there will be no
conversion, and the data will not be imported. For this reason, it may be necessary to modify
the field settings for your database schema, before proceeding with the import. For more
details, see Chapter 13: Modifying Fields and View Settings.
When you are finished, click the [Next>] button in the lower right corner to proceed to the
next step.

If the data to be imported contains the Well Section, then some additional information may be
required in order to allow proper data transfer. The Station Related Settings window (as shown
below) will only be displayed if data is imported to the Stations table.

Projection Settings
Define the coordinate system, the projection system, and the units for the stations in the
source file. Following successful import, the new stations will be converted to the projection
system and units defined in the HGA project. A detailed description of the coordinate and
projection systems available in HGA is provided in Chapter 3.

NOTE: It is important to know and select the correct projection system during the import, to
prevent erroneous station co-ordinates.
The LAS file allows to specify a place holder for NULL values (common examples are -
999.0000). Wherever this value is detected in the source, HGA will insert NULL in the
destination, according to the field setting specified in the Template Manager.
When you are finished, select the Next button in the lower right corner to proceed to the next
step.
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The last step in the import involves previewing the data to be imported, and taking appropriate
actions with regards to erroneous data. The Data Validation window (as shown below)
displays all data ready to be imported. Errors or warnings, if any, will be listed along with the
data. Records with errors will not be imported. You may return to previous steps to make any
corrections to the mapping.
The data is checked against the following conditions:
· Proper Station Locations
· Data type compatibility

NOTE: All coordinates in the database are stored in latitude-longitude format (WGS 1984) for
internal use, regardless of the projection system in the source file and project. The Preview in
this window displays the converted station co-ordinates. However the station co-ordinates
may be displayed in HGA in any projection system desired.
At the top of the window, each tab represents a different database table containing one or
more mapped fields.
Accepting or Rejecting Records
Any of the records in the preview window may be accepted or rejected.

To accept the selected records, click on the  (Accept) button.

To reject the selected records, click on the  (Reject) button.

Once you have removed or verified the errors,
F [Import] button to import the data to the project.
After successfully importing the data, a confirmation window will appear, similar to the one
shown below.
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8 Query Builder

This section provides a detailed description of the Query Builder. Within an HGA project, it
may be necessary to perform different types of queries for data filtering, reporting, and
management. A few examples of data queries are provided below:

· Select wells drilled later than 1995 and earlier than 2000
· Select wells with discharge over 500 gpm
· Select boreholes deeper than 150 feet
· Select boreholes where the overburden thickness exceeds 20 feet
· Locate groundwater concentration exceedances for BTEX

In the Query Builder tab, the query display fields and conditions can be quickly defined. Once
the queries have been created, they may be easily accessed from the Project Tree, where
each new query will appear as a new branch. 

8.1 Query Types
There are two types of Queries within HGA. A Standard Select Query which pulls data from
the data for further analysis, and a Dynamic Station Group Query which uses a condition to
group stations.

Standard Select Query

Data Queries can provide a more detailed look at your data, and can be used for quantifying
and qualifying any field in the database.
In addition, many of the visualization and data analysis modules require data sources as data
inputs. 

Using the Query Builder, you can generate Select Queries that provide the data for:

· Map Layers
· Cross section interpretation results
· Quality Control Analysis 
· Well Profiles
· Time Series Plots 
· 3D Interpolation 
· Reporting
· and more!

To create a Select Query, select the Standard Select Query radio button in the New Query
dialog box. Then, define the necessary fields and conditions, and execute the query. Once
the query has been saved, the query will appear as a new branch in the project tree, under
the Queries branch.

Dynamic Station Group Query

Dynamic Station Group Queries can be created and executed for the purpose of organizing
the stations into groups.
To create a Station Group Query, select the Dynamic Station Group Query. Then define the
necessary conditions, and execute the query. Once the query has been saved, the query will
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appear as a new branch in the Project Tree, under the Station Groups branch. When selected
from the Station Groups branch the query will be executed and the stations that meet the
conditions set in the query will be displayed.

NOTE: Station Group Queries do not have options for modifying the display fields, or
advanced grouping options.

8.2 About the Interface
The Query Builder may be loaded from HGA several ways for example by selecting Modules /

Query Builder or by selecting the  icon from the Main Toolbar.
Additionally if you right click on the Queries branch of the Project Tree (or any branch under
it) you can select New Query... to launch the Query build.
Finally, if you right click on a query in the Project Tree and select Edit Query... the Query
Builder will open displaying the selected query. 

The Query Builder tab is shown below and displays the options available for a Select Query.

The Query Builder tab contains the following sections:
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· Available Fields: Select fields for the query from the tables in the database shown in the
tree.

· Display Fields: The fields in this section will be displayed when the query is executed.
· Conditions: The fields in this section are used to set conditions for the query.
· Toolbar: Contains buttons to most of the functions in the Query Builder.
· Source Conditions: Provides options for adjusting the source for the query.
· Group Conditions: Specifies grouping options when using an aggregate function.
· SQL Statement: Allows user to generate their own custom SQL Statement (other sections

will become inactive).

NOTE: The Display Fields and the Group Conditions sections are not available when creating
a Dynamic Station Group query.

Toolbar Items
The toolbar provides access to most functions of the Query Builder. Toolbar buttons are
context sensitive, if there a button is "greyed-out" this indicates that that functionality is not
currently available (based on what has been selected).

 New button allows you to create a new query.

 Open button allows you to open an existing query.

 Delete button allows you to delete the currently open query.

 Save Query button saves changes to the query.

 Save As button saves the query under a new name.

 Execute SQL Statement button executes (or runs) the query.

8.3 Standard Select Query - Example
Follow the steps below to create a Standard Select Query.

If the Query Builder tab is not yet opened, select the Query Builder icon  from the main
toolbar.

In the Query Builder tab toolbar, select the New button , and the following dialog will
appear:
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Provide a Query Name: TOC Exceeds 320m for this example)
The default Query Type is the Standard Select Query - which is the query type for this
example.
We also have the option to specify the location of the Query. The Select Queries will be
stored in the Queries branch of the Project tree - however, you can create folders to organize
your queries. You can select the folder where you wish to save your query.
For this example we we will leave the default which will save the query to the main Queries
branch (i.e. not in a folder).

Select OK to create the query.

By default the only field selected to be displayed in the query is the Station Name. We are
going to add other fields to the display fields.
Let's select the Map, Plot and Plume Ready option as well as the Well Profile option - this
will automatically add several fields to the Display Fields section and will make the query
available in other modules within HGA.

Expand the tree in the Available Fields section to find the TOC field (under the Description
category and the Location table.
Double click on the TOC field - notice it has been added to the Display Fields section.

Now we will add a condition to the Query.
Click once on the TOC field (it will become highlighted blue), and drag this field into the blank
Conditions field (under the Expression column). The TOC field will be added to the Query

Conditions. (Alternately, you may use the  (Add) button (on the bottom half of the
conditions section) to add conditions, then define them manually).
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We need to set an operator and value for our Condition. You will notice there are several
options in the Operator drop down list (>, >=, <, <=, =, <>, IS, IS NOT, and LIKE) providing
you several options to query your data from the database.

For this example select the > option from the drop down list in the Operator column.
Enter the number 320 in the Value field.

In the Conditions section, select the Source Conditions. The options are Project, Station
Group, and Database. If Station Group is selected, then another combo box will become
activated where you can select the appropriate Station Group to be the source for this query.
If Project is selected, then all stations in the project will be queried. If Database is selected,
then the query will be applied to the entire database. For this example we will use the default
- Project.

The Query Builder should look similar to the image below:
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Select the Execute Query button  and you will be moved to the Data Query tab to see the
results of your query.
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The new data query will now appear as a new branch under the Queries node in the Project
Tree - if you do not see it right away right click on the Queries branch and select Refresh.

This query can be executed/run at any time by selecting it from the Project Tree. The results
will show on the Data Query tab.
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If you need to make further changes to the query right click on the query in the Project Tree
and select Edit Query... and the query will be opened in the Query Builder tab.

For further information on what can be done with the query once it has been executed and the
results are being displayed - please see the section on the Data Query Tab section.

8.4 Dynamic Station Group Query - Example
A Dynamic Station Group query is used to group stations that meet specific conditions. The
stations groups that are created this way are called "Dynamic" because the stations in the
group may change as data is added/edited in the database. Alternatively, the Stations
Groups that are user defined are referred to as "Static" because they do not change unless
the user makes the changes manually.

Follow the steps below to create a Dynamic Station Group query.

If the Query Builder tab is not yet opened, select the Query Builder icon  from the main
toolbar.

In the Query Builder tab toolbar, select the New button , and the following dialog will
appear:

Provide a Query Name: Station with TOC exceeding 320 (for this example).
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The default Query Type is the Standard Select Query - we need to change this by selecting
the Dynamic Station Group option.

Select OK to create the query.

You will notice that the Display Fields and the Group Conditions sections have become
disabled - these are not available for Dynamic Station Group Queries.

Click once on the TOC field (it will become highlighted blue), and drag this field into the blank
Conditions field (under the Expression column). The TOC field will be added to the Query

Conditions. (Alternately, you may use the  button (on the bottom half of the conditions
section) to add conditions, then define them manually).

We need to set an operator and value for our Condition. You will notice there are several
options in the Operator drop down list (>, >=, <, <=, =, <>, IS, IS NOT, and LIKE) providing
you several options to query your data from the database.

For this example select the > option from the drop down list in the Operator column.
Enter the number 320 in the Value field.

In the Conditions section, select the Source Conditions. The options are Project, Station
Group, and Database. If Station Group is selected, then another combo box will become
activated where you can select the appropriate Station Group to be the source for this query.
If Project is selected, then all stations in the project will be queried. If Database is selected,
then the query will be applied to the entire database. For this example we will use the default
- Project.

The Query Builder should look similar to the image below:
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If you need you can add multiple conditions - these need be linked by specifying an additional
Operator; choose from AND, OR. For this example we will only use one condition.

Select the Execute Query button  and you will be moved to the Data Query tab to see the
results of your query. The results of a Dynamic Station Group query will have only 2 columns
- the RowID and the Station ID. 
More useful is the fact that the new query will now appear as a new branch under the Station
Group branch in the Project Tree. 

The Dynamic Station Group queries can be distinguished from a user-defined station group
(static) by the color of the icon used to display in the Project Tree. Blue icons are Static
Station Groups while green icons are Dynamic Station groups.
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8.5 Using SQL Commands - Example
If you are familiar with MS SQL (Structured Query Language) syntax commands, you can
retrieve, manage and manipulate your data through the SQL Statement section of the Query
Builder. 

As soon as you begin typing within the SQL Statement section you will be prompted to
confirm that you wish only use the SQL Statement to create/edit the query.

When you select yes you will notice the Display Fields, Conditions and Group Conditions
section will all become disabled. Moving forward you can only edit the query by directly
editing the SQL Statement.
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Two commands that are commonly used include the Select command and the Delete
command. Both of these commands are described below. These queries are based on the
HGA Demo Project.

Select Command

The Select Command retrieves data from tables in a database and is usually followed by a
"where" clause. For example, if you want to create a query to show all chemistry results
where the chemical name is benzene, you would enter the following into the SQL Statement
section:

SELECT * FROM parameter_result WHERE chemical_name = `Benzene'

As soon as you have entered a few characters you will see that the Query Builder
autocomplete tool becomes available to help you write your SQL Statement.
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Based on the first few letters of each word you enter the program will try and help you by
suggesting SQL Commands (for example SELECT) or the names of tables or fields in your
database.

Once you have completed entering the statement (ensure it is exactly as written above
including the single brackets around the word Benzene) you can execute the the statement

by selecting button.

You will be moved to the Data Query tab to see the results of your query.
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Since we used the * in the Select statement ALL fields in the parameter results table will be
displayed - but only the records containing Benzene will be displayed.

Delete Command

The Delete Command can be used to remove records from the database. 

For example, if you want to delete all records from the Parameter Result table with the
chemical name benzene that we just found using the above Select statement, enter the
following SQL statement into the SQL Statement section:

DELETE FROM parameter_result WHERE chemical_name = `Benzene'

Then  select the Execute Query  button to run the delete query.
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You will be moved to the Data Query tab - but no records will be displayed (as your query has
deleted the records).

NOTE: Once you click the Execute Query button, all the data that is specified in the SQL
statement will be permanently deleted from the database. Because there is no undo function,
it is recommended that you use the select command before a delete command, to ensure
that you have the selected the correct records.

8.6 Aggregate Functions
Select queries within HGA may include an aggregate function. The following functions are
available:

· AVG: Returns the average value of a numeric expression evaluated over a set.
· COUNT: Returns the number of items in a collection.
· MAX: Returns the maximum value of a numeric expression evaluated over a set.
· MIN: Returns the minimum value of a numeric expression evaluated over a set.
· STDEV: Returns the sample standard deviation of a numeric expression evaluated over a

set.
· STDDEVP: Returns the population standard deviation of a numeric expression evaluated

over a set.
· SUM: Returns the sum of a numeric expression evaluated over a set.
· VAR: Returns the sample variance of a numeric expression evaluated over a set, using the

unbiased population formula.
· VARP: Returns the population variance of a numeric expression evaluated over a set, using

the biased population formula.

You can specify the function within the Query Builder by selecting the appropriate function in
the Display Fields section, in the Function column for the appropriate field.

When executing a query containing an aggregate function the query builder will automatically
group all other fields in the Display Fields. . This is required in order to be able to
determine/calculate the function for the selected field.

In the example above, the query will be grouped by the station name - so only one record per
station name will be displayed - the record with the maximum depth to water level for each
station.
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9 Event Planning

The Event Planning module ensures that your field activities are always completed correctly
and on time. Easily create multiple schedules for various stations and then create event plans
that outline the details of your field activities including stations to be sampled, data to be
collected, field checklists and more. Event plans are automatically converted into reports
which can be printed and given to field personnel. Hydro GeoAnalyst keeps track of all your
event plans and automatically reminds you in advance when scheduled field activities are due.

9.1 About the Interface

The Event Planning module can be launched by selecting the  icon from the main toolbar
or by selecting Modules / Event Planning from the menu bar.

The module launches as a tab and displays as a calendar to allow you to see any upcoming
schedules.
If you select a schedule in the calendar you will see the stations that are due to be sampled
that are associated with the schedule on the right hand side.

 allows you to schedule your stations for regular sampling

 allows you to create an Event Plan

 allows you to close any existing Event Plans

 allows you to manage your Event Plans
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 allows you to go to today (current date) in the calendar (helpful if you have scrolled
ahead or behind in the calendar).

9.2 Schedule Stations

You can schedule your stations for regular sampling by selecting the  icon and the Event
Schedules dialog will appear.

Here you can see all current schedules for your project. You can create a new schedule, edit
an existing schedule or delete a schedule.

To create a new schedule select the New... button and the New Schedule dialog will appear.
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You must provide a name for the schedule in the Subject field and then you have the option of
providing a description for the schedule.
Indicate the start and end date for the schedule.
Select the Stations you wish to schedule from the list of stations on the left hand side. You
can reduce the list of all stations by selecting an appropriate Station Group.

Once you have selected the stations (will be highlighted blue). Select the  button to move
the stations to the Selected Stations area (right hand side).

To move all stations from a Station Group to the Selected Stations area use the 
button. 

You also have the option to set the Recurrance for your your schedule (similar to the options

found in MS Outlook TM)and the following dialog will appear.
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Once you save an close your New Schedule you will find it in the list of Event Schedules. You
find also find it in your calendar.

9.3 Event Plan Wizard

You can create your Event Plans by selecting the  and the Event Plan wizard will
appear.
The first step of the Event Plan wizard allows you to provide some basic information about the
plan including the Name and the Start and End dates.
Additional option information can also be provided including the Field Technician, the Primary
Lab where the samples will be sent, the Plan Approver and Comments regarding the plan.
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The next step of the Event Plan wizard indicates which stations will be sampled in the plan. If
you had a schedule selected in the calendar when you selected the Event Plan wizard the
stations that are due will already be populated.

You can add more stations to the plan if you wish - select the Stations you wish to add from
the list of stations on the left hand side. You can reduce the list of all stations by selecting an
appropriate Station Group.

Once you have selected the stations (will be highlighted blue). Select the  button to move
the stations to the Selected Stations area (right hand side).
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To move all stations from a Station Group to the Selected Stations area use the 
button. 

The next step of the Event Plan wizard allows you to indicate if you want QAQC analysis
samples to be taken.

Select the  button to add a QAQC sample to be taken. Then you need to specify at which
station the sample should be taken, and what kind of QAQC sample should be taken (options
include duplicate, trip blank and equipment blank). You also have the option to provide a
comment.

If you need to delete a QAQC sample highlight the sample and then select the  button.

The next step of the Event Plan wizard allows you to indicate which parameters will be
analyzed.
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By default the parameters selected will be applied to all Stations - however if you wish you
can select different parameters for each individual station.

Once you have selected the parameters (will be highlighted blue). Select the  button to
move the parameters to the Selected Parameters area (right hand side).
To move all the parameters from a Station Group to the Selected Parameters area use the 

 button. 

To make it easier to select parameters - since the list can be very long (the list is taken from
the List Editor list for the Chemical Name field in the Parameter Results table) you can create
Parameter groupings. Several groupings have been provided by default, but if you wish, you

can create your own by selecting the  button. This will launch the Parameter List Editor.
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This module is similar to the Material Specification Editor. Provide a New Group name on the
right hand side and select the parameters you wish from the left hand side to be included in
the new grouping. Once you have selected the parameters (will be highlighted blue). Select

the  button to move the parameters to the Selected Parameters area (right hand side).
To move all the parameters from a Station Group to the Selected Parameters area use the 

 button. 

Once you save the new grouping it will be available within the Event Planning wizard.

The next step of the Event Planning wizard allows you to indicate if any Additional Data
needs to be collected while in the field.
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By default the additional data to be collected will be applied to all Stations - however if you
wish you can select different data to be collected for each individual station.
The data fields to be collected can be selected from the datamodel tree on the left hand side.

Once you have selected the field (will be highlighted blue) select the  button to move the
data field to the right hand side.

The next step of the Event Planning wizard allows you to prepare a checklist to help ensure
all required items for performing the field activities are remembered.

You can enter one item per line.
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The final step of the Event Planning wizard allows you to  print the Event Plan report. The

Event Plans are generated and populate an MS WordTM template. 

The first page of the Event Plan report is a summary including the list of stations to be
sampled along with the coordinates as well as the checklist. 
Each page thereafter contains the information for what needs to be collected at each station.
Including the parameters that will be analyzed, any QAQC samples that should be taken, and
any additional information that should be collected in the field while at that particular station.
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These plans can be saved and printed out for field personel. The templates used to generate
the plan reports can be modified if for example you wish to change the logo. The template can
be found in the Templates folder - the location can be found in the HGA Settings.
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9.4 Event Plan Closure
The Event Planning module will remind you to close an Event Plan 7 days after the plan was
scheduled to be completed. This can be adjusted in the HGA Settings.
The Event Plan Closure wizard allows you to close an Event Plan. In the first step you need

to select the Event Plan you wish to close by selecting the  browse button. Once the plan
is selected you will see the basic information of the Event Plan displayed.

The Next step allows you to indicate what was collected during the field activities.

If all the required collections (Station samples, QAQC samples, and Additional Data) were
made you can simply select the Select All option to indicate that everything was collected. If
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however some items were not collected during the field activities they should remain
unchecked and a comment indicating why must be provided.

The next step confirms your collections.

You have the option to reschedule any Stations that may have been missed during the field
activities as well as entering comments regarding the plan.
You must select the Acknowledge button in order to select the Finish button the Event Plan
(which will then be considered closed).

9.5 Manage Event Plans
When you select the Manage Event Plans icon the list of all Event Plans will be displayed
indicating the Name, Start and End dates as well as whether the plan has been closed.
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Here you have the option to re-print the plan if necessary as well as the option to re-open a
plan if it was mistakenly closed. You also have the option to delete Event Plans in this dialog.
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10 Crosstabs are Now Pivot Tables

With the release of Hydro GeoAnalyst we have removed the old way of creating a Crosstab
query and instead are offering a simpler option to push your query into an Excel template that
has been set up to use the Pivot table option. This gives you all the power of Excel and Pivot
tables to allow you to re-arrange your data to suit your specific needs.

The option is available from the Data Query tab and can be accessed by selecting the 
button.
You will be prompted to select a template. We have included a landscape as well as a
portrait template. As with other options within Excel you may want to review and adjust the
template to make it more your own - perhaps include your logo and change the title etc.

When you select OK you will be prompted for a name for your excel spreadsheet and then it
will open.

 Please be aware - depending on your security settings you may find that the
data connection have been disabled - simply select Enable Content to allow for
connection between the SQL Server and the Excel template.

After that the Excel spreadsheet will open and you can select inside the Pivot Table option.
This will make all the fields from the query available in the Pivot Table Field List.
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Then it is a matter of deciding what fields you want as columns and what fields you want as
rows - as well as the value field (which need to be a number field). Here I have organized my
Pivot table with the Station Names and dates as the rows and the Chemical names as the
columns. The concentration values are used in the values field.
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You now have all the power of Excel's options for customizing your Pivot tables. 
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11 Lab Quality Control

When collecting, analyzing, and interpreting environmental data, Quality Control (QC) can
come in many forms and fashions. Hydro GeoAnalyst supports a Lab Quality Control
component, that allows users to verify the accuracy of the analysis results reported by a
laboratory.
As part of a data collection process, duplicate samples, blank (control) samples, and spiked
samples are added to sample sets; these samples are sent to a laboratory, along with the
original field samples, to be analyzed in a controlled environment, using constant techniques,
instruments, and personnel. The objective is to identify any sources of contamination that
may originate from the lab analysis, and provide some assurance to the client, that the data
is valid, and representative of your site conditions.

HGA has integrated a Lab Quality Analysis component that allows users to:
· Define one or more lab quality assessment templates
· Analyze Duplicate, Spiked and Blank samples
· Compare Relative Percent Difference and Coefficient of Variation for Duplicate samples (for

more details, see Check Duplicates Settings ).
· Analyze Percent Recovery for Spiked samples (for more details, see Check Spiked

Settings ).
· Compare Blank samples to method detection limits (for more details, see Check Blanks

Settings ).
· Analyze Dilution Factor, Detection Limit, and Holding Time
· Compare the dilution factor in your results with the maximum allowed dilution factor that

you set in your template (for more details, see Check Dilution Factor Settings ).
· Compare the detection limit in your results with the standard detection limit (for more

details, see Check Detection Limit Settings ).
· Compare the holding time in your results with the standard holding time (for more details, 

see Check Holding Time Settings ).
· Execute a Quality analysis on a selected dataset
· Display and retrieve assessment results; records not meeting assessment criteria will be

highlighted
· Save assessment results to a MS Excel spreadsheet

11.1 Preparing Your Data for QC Analysis
Your QC Blank, duplicate, and spiked samples should be entered in the same table and
fields as your original samples.
If a Duplicate sample was collected at an existing station, then create a new sample ID, and
assign the appropriate Quality Code (D). You must also define a common batch ID for
duplicates to indicate that they belong together. If you want to compare the duplicate to its
original sample, you must add the appropriate Original Sample Quality Code (O), to each
original sample.
If a Blank sample was collected, it can be added as a new station and sample, or as a new
sample, to an existing station. Create a new sample ID, and assign the appropriate Quality
Code (B).

For Spiked samples, you must add two types of samples codes and results:
The first will be a sample that contains the known spiked concentration, for each parameter.
Create a new sample ID, and assign the appropriate Quality Code, ST (for Theoretical Spiked
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concentration). Create a new sample for every spiked sample and enter the amount of
constituent that has been added for every spiked parameter.
Next, add the analyzed spiked sample as a new sample. Create a new sample ID, and
assign the appropriate Quality Code, SM (for Measured Spiked concentration). Create a new
sample for every spiked sample and enter the measure amount of constituent that was
recovered, for every spiked parameter.
Both the measured sample and the sample holding the theoretical concentrations should be
assigned a common batch # (Batch ID), which relates the samples to each other.

Defining Quality Codes for Data
When importing/adding sample data, quality codes need to be added to indicate the type of
sample, in order to be used in a Lab Quality Analysis. The following are the codes required by
HGA:

Sample Type Quality Code

Duplicate Original O

Duplicate Measured D

Spiked Theoretical ST

Spiked Measured SM

Blank measured B

Using the Template Manager, you can create a field that will store the quality codes. This
field may be added to any table, but typically it is found in the Parameter Sample table, with
the Sample ID.
These quality codes are saved in the file: ...\Program
Files\HGAnalyst\Whi.QualityAC.dll.config
If necessary, the codes may be changed to reflect the codes used in your data. Simply use a
text editor to open the .config file, and modify the quality codes under the section:
<QualityCodes>.

Data Requirements
Quality Control starts with a data set; before you can apply a quality control template, you
must generate a data set, by building and executing a data query with the Query Builder. The
data query should contain the data set your are interested in analyzing, along with the fields
required by the Quality Control component.

The following are required fields for the Lab Quality validation, and as such, must be fields
that are present in your data query:
· Station ID: located in the Station table
· Sample ID: this is typically found in the Monitoring Event > Parameter Sample table, or the

Soil Sampling > Soil Sample table.
· Batch Identifiers: Samples that are prepared and/or analyzed together with the same

process and personnel, using the same lot(s) of reagents, within a specified time period,
should be assigned the same Batch ID. Both the measured sample and the sample holding
the theoretical concentrations should be assigned a common batch number, which relates
the samples to each other.

· Detection Limit: Method detection limit, typically found in the Chemistry_Results or
Soil_Chemistry table.

· Parameter Name: contains the parameter being analyzed; typically found in the
Chemistry_Results or Soil_Chemistry table with the results

· Parameter Identification Information: contains meta data about the parameter; typically
found in the same table as the parameter name
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· Parameter Values: The measured or observed value for the selected chemical or parameter.
Typically found in the Chemistry_Results or Soil_Chemistry table

· Quality Code Identifiers: Used to identify the sample type. Typically found with the Sample
ID, in the Monitoring Event > Chem Sample table, or the Soil Sampling > Soil Sample
table.

The following fields are not required, but are helpful for easily identifying samples in the
results page:
· Station Name: located in the Station table
· Sample Name: this is typically found in the Monitoring Event > Chem Sample table, or the

Soil Sampling > Soil Sample table.
· Sample Date
· Units
· Unit conversion factors

11.2 Define A New Lab Quality Template
To create a new lab quality analysis template, click Tools > Quality Control from the Main
Menu, then select the Manage Lab QC Templates option. The Lab Quality window will open,
as shown in the following figure:

To create a new template, click the [Add] button, and enter a name for the template. The
newly created template will then appear in the Lab Quality Templates list. To configure your
template, click on the [+] to expand the template tree. As shown in the following example
screenshot, the three Check types (Duplicate, Spikes, and Blanks) will be listed. To activate
a Check type, click in the checkbox beside it.
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The Template Description field is filled in by default with a verbal description of the Settings
used for the template. You can modify the Template Description with any text you would like
to use by simply typing over the existing text.
Each Check type has its own Settings, which can be adjusted by clicking on the Check type
to highlight it. The Settings will then appear to the right. Settings for each Check type are
described in the following sections.

11.2.1 Check Duplicates Settings

A field duplicate is a QC sample which is used to determine the precision associated with all
or part of the sample collection and measurement process. Field duplicates are two
independent samples which are collected, as nearly as possible, from the same point in
space and time. The two field duplicate samples are collected from the same source, using
the same type of sampling equipment. Ideally, analyte concentrations in the duplicate sample
should be identical, or very close, to the original sample to which it is being compared. The
following settings are available:
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Relative percent difference less than: This criteria is used to compare how close the
result from a duplicate sample (D) is to the true, original field sample (O). It is expressed as
either a positive difference (the sample result is higher than the true value) or negative
difference (the sample result is lower than the true value). When used with duplicate samples,
the Relative Percent Difference measures precision - the lower the value, the more precise the
results must be to be considered acceptable. It can also measure accuracy, when one of
your results is the true value (such as the quality control lab results for a split sample), or the
actual concentration of a known or unknown sample.
Coefficient of Variation (CV) less than: The standard deviation as a percentage of the
average. The CV is a unitless quantity indicating the variability around the mean, in relation to
the size of the mean. When used with duplicate samples, the CV measures precision - the
lower the value, the more precise the results.
Highlighting: If a record is identified as not meeting the Template criteria specified above, it
will be highlighted according to the settings entered in this frame. By default, the record's
Background Color will be changed to yellow. However, the user has the option to modify the
Font, the Background Color, and the Border Color of the record by clicking on the appropriate
button(s).

11.2.2 Check Spiked Settings

A matrix spike is an aliquot of sample that is spiked with a known concentration of target
analyte(s) prior to sample preparation. Ideally, there should be 100% recovery of the spiked
concentration (or very close to this). The following settings are available.
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Minimal Percent Recovery:You can find this option by selecting Project / Export. In this
first step of the workflow you can create a template (which can be opened in Excel) for others
to use to validate their data. In the EDD Template Designer you select which fields you wish
to have in your template by simply dragging and dropping them onto the Template Format.

Highlighting: these are also bolded. These are fields that are required to be able to import
the data into the select table.

NOTE: The analysis assumes that the sample that is being spiked is a blank, and does not
contain any detectable concentrations of any of the contaminants. You may not use a field
original sample for a spiked sample analysis.
Highlighting: The options are the same as described in the previous section.

11.2.3 Check Blanks Settings

A blank is a quality control sample used to detect and identify contaminants introduced to
samples during the measurement process. A laboratory blank is an analyte-free matrix that is
carried through all or part of the analytical process for identifying contamination introduced
during analysis. Types of laboratory blanks include method blanks (carried through the entire
preparation and analysis sequence), calibration blanks (matrix-matched reagent water used
for calibration), and storage blanks (placed in sample storage areas). In the field, an analyte-
free matrix is carried through a portion of the field process to identify contamination
introduced during field or transportation operations. Types of blanks associated with the field
are trip blanks (these accompany samples through the transportation process), equipment
rinsates (collected after decontamination), and field blanks (collected on-site during the
sampling event).
Ideally, analysis of the blank samples should return no detectable concentrations of any of
the analytes; i.e. concentrations are below the method detection limit (MDL).



Lab Quality Control 205

© 2017 by Waterloo Hydrogeologic

The detection limit for contaminants can be specified in HGA, and must be added to your
data query.
Highlighting: The options are the same as described in previous section.

11.2.4 Check Dilution Factor Settings

A dilution factor is calculated by dividing the final volume by the aliquot volume.
Aliquot volume is the measure of sub volume of original sample.
Final volume is the total volume.
This QA/QC check will look for exceedances in the dilution factors in your result records. You
simply need to set the Maximum allowed dilution factor. Any reported Dilution Factors above
what you have specified as the maximum will fail this check.

11.2.5 Check Detection Limit Settings

This QA/QC check will compare the Standard Detection Limit in the QA/QC reference table
with your detection limits reported within your results. If your reported detection limits are
greater than the Standard Detection Limit in the reference table they will fail this check.
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You can enter your QAQC references (Standards) by selecting Project/Properties/QAQC
References

Here you can manually enter or import the reference values used for running the associated
checks.You will notice that the Method Name and Chemical Name have drop down lists you
can pick from - this is based on your selections from the Settings:

11.2.6 Check Holding Time Settings

Holding time is the length of time a sample can be stored after collection and prior to analysis
without significantly affecting the analytical results. This QA/QC check will compare the
Standard holding time with the holding times of your results. The holding time of your results
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will be calculated by comparing the difference between the Sample Date and the Analysis
date. Any results that have a holding time greater than what is specified in the QAQC
Reference table will fail this check.

You can enter your QAQC references (Standards) by selecting Project/Properties/QAQC
References

Here you can manually enter or import the reference values used for running the associated
checks.You will notice that the Method Name and Chemical Name have drop down lists you
can pick from - this is based on your selections from the Settings:
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Once you have defined the settings for your Template, you can create another template by
clicking the [Add] button, delete an existing template by clicking the [Remove] button, or
accept/reject your changes and return to the HGA main program window.
You are now ready to apply the lab quality template to your data.

11.3 Perform Lab Quality Assessment
NOTE: An example of a Lab Quality Data query is available in the Demo project; select the
QC_Lab_Analysis query in the Queries node, and feel free to follow along with the
instructions below.
To apply a Lab Quality Template, follow the instructions below:
· Select and highlight the appropriate Data Query from the Queries node in the HGA

Browser.
· From the main menu, click Tools > Quality Control and select the Perform Lab QC

Assessment option; the following dialog will appear:

From the Select and configure a template window select from the list of Lab Quality
Templates.
Once a template has been selected, the Template Description field will be completed with the
description entered when the template was created. The next step is to map the fields in your
data query, to the fields required by the QC component.

Mapping Fields
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In the Mapping frame, the Field must be matched to the Query Alias for all required fields;
required fields are marked with a "*", and are also listed in previous section. In most cases,
HGA will be able to automatically detect and map the fields, however if you have created
custom fields, or renamed existing fields in your database structure, you may need to browse
through the list and select the appropriate Query Alias in your project (using the pull-down
menus) that corresponds with a Field.
NOTE: A field in your query must be mapped to each of the required fields, as listed above.

Generate QC Results

The results for an example analysis including all six checks is displayed in the screenshot
below:

 Indicates that all records have passed this check.

 Indicates that one or more record(s) has failed this check.
If any records failed the check you will also find the record is highlighted as per your settings
from your template.
You will also find an option to write flags to the database indicating the results of the
Validation. You must select which field in the database to write the Results Flag (should be in
the results table). The name of each check that was failed will be appended to the field you
select.
You must also select which field in the database to write the Sample Flag (should be in the
sample table). The name of the Template that was run on the sample will be appended to the
field you select.
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Export Quality Control Analysis Results
To export the results of your Lab Quality Analysis to a MS Excel spreadsheet, click the
[Export Results] button, select the check results you wish to export and provide a name for
your spreadsheet.

If more than one check result is selected you will find multiple worksheets within your
spreadsheet (one for each check) see below for an example.
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12 Time Series Plotting

The plotting component in Hydro GeoAnalyst allows users to create time series plots of data
stored in the HGA database. The plotting provides the following features:
· Create Time Series X-Y plots using data from data queries.
· Display X-Y plots as a line or bar chart.
· Add legends and data marker labels to plots
· Add best fit, trend, formula, or statistical lines to the plot
· Interact with plots, and display multiple plot windows in the viewer window simultaneously
· Display non-detect, uncertainty, or detection limits on the plot, as lines or symbols
· Define data series ranges, and modify display properties for different data ranges (e.g.

define a data range where the data exceeds the water quality standard values, and assign
unique symbol, line, and display properties for this data)

· Select fields for plot grouping or data series grouping
· Modify display properties, including axis, labels, symbols, legends, and intervals
· Print plots to a single or multiple pages
· Save plot settings as templates for re-use
· Export plots to graphics format
· Copy plots to Windows clipboard

12.1 About the Interface
Once you have created and selected a data query, you may create a plot with the data set.
The plot component may be launched from HGA in several ways:

To create a new Plot Page Design, right-click on the Plots node (on the Project Tree) and
select New from the pop-up menu
Existing plots can be opened from the Plots node in the Project Tree by either double-clicking
on the desired plot in the available list, or by right-clicking and selecting the Open pop-up
menu option.
NOTE: A data query containing the required fields (see below) must be selected in order to
launch the plots mode from the HGA main interface.

A typical plot window is shown in the following figure.
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The plot window contains the following items:

Plot Page Design Tree: A list of all available plot page designs, plots, and series such as
Lines and Standards
Designer Toolbar: Toolbar buttons used for modifying the plot design
Plot Settings and Data Source: Contains the settings for the selected entity, and data
mappings
Viewer Window: Contains a real time view of the plot page design

Description of Designer Toolbar Items

The plot designer toolbar provides the controls for designing the plot page. The following
buttons are available.

 Save button saves the current plot design

 Save As button saves the current plot design as a new name

 Add button provides two options: Add Plot will prompt you to select a template to be
used; Add Default Plot will create a new plot using the default plot template

 Delete button deletes the selected plot or line series

 Refresh button refreshes the design with new settings or data

 Zoom in button allows you to zoom into the selected plot page; to zoom in on selected
plot data within an individual plot
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 Zoom out button returns to the original zoom view

 Fit to Page button fits all plots to the current viewer window size
At the bottom of the window, you will find the following buttons:

The function of these buttons, from left to right, is:
Previous Page: scroll to the previous page in the plot design
Next Page: scroll to the next page in the plot design
Zoom
To zoom in on plot data in an individual plot, use the mouse cursor to draw box around the
desired data; a sample is shown in the screen shot below:

To zoom out to the original extents, right-mouse click on the plot area, and select Zoom Out
from the menu.

Viewer Window Settings
Under the Settings tab, you can define the settings for the plot page design:
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Name controls the name of the selected plot series; this is read-only, and cannot be
modified.
The plotting component supports display and manipulation of multiple plot windows in the
viewer window.
Number of columns controls how many columns will be displayed in the viewing window for
displaying plots.
Number of rows controls how many rows will be displayed in the viewing window for displaying
plots.
For example, 2 columns X 2 rows means that 4 plots may be displayed simultaneously in the
viewer window.
Spacing width controls the amount of space between each plot, in the horizontal direction.
Spacing height controls the amount of space between each plot, in the vertical direction.

12.2 Adding Plots
The data source for the plots must originate from a Data Query; before you create a plot, you
must build and execute a data query using the Query Builder. The data query should contain
the data set you are interested in analyzing, along with the fields for a time series plot.

TIP! If you are plotting a large water level dataset which was logged using a small time
interval, e.g., 1 sample per hour over many days, use the average aggregate function in the
query builder to query the daily average water level. By doing this, you will lower the number
of data points in your query and thus lower the drawing time when displaying the time series
plot.

The following are required fields for the Time Series plots, and as such, must be present in
your data query:
· Sample Date or Time
· Value for the parameter of interest (e.g. water level, chemical concentrations, temperature,

pH, conductivity, etc.)

The following fields are not required, but are available for plot and series grouping, and to take
advantage of additional plot options:
· Station ID
· Station Name
· Chemical (Parameter) name
· Measured parameter units
· Non detect (ND) factor
· Method detection limit (MDL)
· Uncertainly factor
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12.2.1 Add Plot

To add a new plot to the design, click the  (Add) button in the toolbar, or right-click on the
Plot Page Design node in the tree view, and select the Add plot menu option. The following
Add plot dialog will appear:

In the Name field enter the name of the plot.
The Type combo box contains the supported plot type; currently only Time-Series scatter
plots are supported.
In the Template combo box, select the desired plot template that should be applied to the
new plot. The plot template contains numerous pre-defined settings for axis, data series,
style settings, etc. If you want to re-use the same template again in the future, select the Set
as the default template check box. For details on creating plot templates, see Managing Plot
Templates section.
Click [OK] when you are finished, to display the new plot in the viewer window. The next step
is to map the fields.

12.2.2 Field Mappings

Under the Data Source tab, you can define the field mappings for the plot, as shown in the
screenshot below:
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Query: select the data source for the plot from the combo box; currently the data must come
from data queries.
Plot Grouping: specify a field to be used for grouping plots
Series Grouping: specify a field to be used for grouping series; at least one field must be
selected for grouping the plot series.
Time Axis: specify a field to be used for the Time (X) axis. This should be the date field from
your query.
Value Axis: specify a field to be used for the Value (Y) axis. This will be observed result value
for the parameter(s) of interest.
Units: loads the following dialog, allowing you to make unit conversions:
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Select the unit category, then the units from this category. If the units' categories are not
compatible (for instance Time and Length) then the buttons are disabled.
You may also select a field to be used for the unit conversion, or create constant conversion
factor; in this case, enter the factor, and an appropriate field.
The units conversion component implements full SI units including temperature, electric
current and luminous intensity.

Label: select a field to be used for the symbol label
The next two fields are used to control non-detect results. When the query returns null
records for the result value, the method detection limit (if available and if selected) can be
displayed on the plot. Optionally, the method detection limit multiplied by the non-detect
factor (ND_Factor) can be used instead of the method detection limit. For example if an
ND_Factor of 0.5 is provided, and a column containing method detection limit values is
provided, then the plot will display the method Detection Limit (DL) value multiplied by 0.5 (the
ND_Factor). If ND_Factor is left empty, then the DL will be displayed.
ND_Factor: specify a field that contains the factor for non-detects.
Detection Limit: select a field that contains the detection limit value
Uncertainty: select a field that contains a value for the uncertainty for the plotted series. This
will plot uncertainty bars directly on the plot
Standard: This option allows you to display water quality standards as a plot series on the
plot. This is useful for quickly identifying which values exceed the standard. When you load
the options for standards, the following dialog will appear:

Click on the [Add] button to add a standard value and select a field that contains the standard
value
Click on the [Delete] button to remove existing list items from the list.
When you are finished, click on the [Close] button.
The new standards will appear as a plot series, under the Plots node in the tree. You can
then modify the line, symbol and label properties, as shown below:
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Line
Visible: show/hide the line
Width: set the line width
Color: specify the line color
Style: specify the line style (Solid, Dashed, etc.)

Marker
Visible: show/hide the markers
Font: Set the font for labels for the line markers
Color: specify the color
Size: Set the size of the markers along the line
Multiplier: select a field that contains a multiplier value; use this to apply a multiplier factor to
all result values on the plot
Bar Color Schema: This option allows you to define advanced bar color settings for bar chart
plots. When this option is loaded, the Bar Chart Color Settings dialog will display (shown
below).

NOTE: This dialog will only be available after you have specified Bar as the Series Type in the
Settings tab.



Hydro GeoAnalyst Help220

© 2017 by Waterloo Hydrogeologic

In this dialog you may define the color scheme by selecting the Graduated Color radio button
or the Classification radio button. These options are most useful when displaying the charts
on a map, in order to see both the trends in the data over time at a single sample location,
and the spatial distribution/trends of all sample locations.
Graduated Color: This option allows for coloring bars from the same sample date, the same
color on all bar charts. For example, if your plot data contains sample data from three
seasonal sampling rounds (spring, summer, fall), you will see 3 instances in the grid at the
bottom. A different color can be assigned to each sample date.
Upon clicking [OK], each bar in the bar chart will be colored with the specified color, and all
bar charts in the series will share the same color (where the sample date exists).

Classification: This option allows for coloring the entire bar chart a certain color, based on
where it lies within a specified criteria. For this, you must provide a query that contains a field
that will be used for the criteria identification. When you select this option, you must map to
this field, and you will then see the min and max available for this field (as shown below). You
can then define the number of classifications (default is 3), and the data range will be
separated into equal number of parts. At this point, you can specify the color and the label.
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Upon clicking [OK], the entire bar chart will be colored with the appropriate color, based on
where it lies in this criteria

12.3 Plot Settings
Once a plot is selected and visible, there are several settings that can be modified. These
settings are sorted into several groups explained below.

General Series Settings

Some of the most-frequently used, general plot settings are available when you right-mouse
click on a plot window (that contains a data series), and select Edit General Settings. The
following dialog will appear for line chart:
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The following settings are available:
Line Width: specify the line width
Line Style: select the line style
Labels Visible: show/hide the data marker labels
Markers Visible: show/hide the data markers
Color: specify the color for the line

As you define the series options, the Preview frame at the bottom of the dialog provides a live-
update preview of how the data series will appear using the selected settings.
If you have selected Bar as the series type, the following dialog will appear:

In this dialog, you can modify the following settings:
Font: Specify the label font style, size and effects
Visible: Show/Hide labels
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Font Color: Specify the color of the label text
Bar Color: Specify the color of the bars

12.3.1 Style and Display Settings

Settings such as Axis, Line, and Legend can be modified in the Settings tab as shown below:

The following settings are available:

Common

Name: Enter the Plot name, and optionally specify a Background color
Size: Specify the Height and Width for the plot
Location (Origin): Specify the X, Y origin for the plot. The origin (0,0) is located in the upper
left corner of the plot window.
Data Filter: Set a data filter for the plot data; this is useful when the plot contains a large
number of data points, and you want to filter out repetitive or unnecessary data, or values
where this is no significant change.
Active: Use this option to enable/disable the filter
Value: Set the filter value. Any consecutive plotted data points with a value less than this
specified filter value will be hidden from the plots, when the filter is active.
Title: Enter a Title for the plot.

Legend

The following Legend settings are available:
Visible: Show/hide the legend
Alignment: Set the Legend position; choose from the following options:
Top
Bottom
Left
Right
Style: Controls what data elements or series appear in the Legend; choose from the following
options:
Automatic
Series Names
Series Values
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Last Values
Palette
Vertical space: Controls the amount of vertical space between each data element in the
legend; higher values will result in more space between each item in the legend.
Inverted Legend: Use this property to reverse the order of items in the legend. For example,
items in the order A, B, C, will be inverted to the order C, B, A, when this property is
selected.
Check boxes visible: Use this property to display a check-box beside each item in the
legend; when active, you can then use the Legend check boxes to show/hide which data
series are visible on the plot.
Font series color visible: Controls the font color for the text in the legend.

Vertical (Y) Axis

Pen width: Controls the thickness of the axis line
Visible: Shows/hides the axis on the plot
Log scale: Plots the axis values using a logarithmic scale
Max value: Controls the maximum value for the axis. By default, this value will be calculated
from the selected data set
Min value: Controls the minimum value for the axis. By default, this value will be calculated
from the selected data set
Auto max value: Restores the default automatic maximum value, which is calculated from the
selected data set.
Auto min value: Restores the default automatic minimum value, which is calculated from the
selected data set
Grid
Visible: Shows/hides gridlines on the plot
Style: Controls the grid line style; select from Solid, Dash, Dot, DashDot, or DashDotDot
Title
Text: Sets the title for the axis
Visible: Shows/hides the axis title
Angle: Controls the angle for the axis title; for the Y axis, it may be useful to have the angle
set at 90 degrees.
Font: Controls the font for the axis title
Tick Label
Format: Controls the decimal format for the labeled tics; enter #.00 to display 2 decimal
places, to display no decimal places, simply enter 0
Angle: Controls the angle for the tick labels; for date labels, it may be useful to select an
angle of 45 or 90 degrees for improved display
Font: Controls the font for the tick labels

Horizontal (X) Axis

The Settings for the X Axis are identical to the Y axis, with the following exceptions:
Log Scale is not available
Min and Max values: when you define the min and max format, you must select these values
from a calendar
You can specify a Date/Time format from the following options:
m/d/yyyy
MMM/yyyy
MM/yyyy
yyyy
MMM
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hh:mm:ss tt (tt = AM/PM)
hh:mm:ss
You can set the Tick Interval by selecting one of the following options:
Min
Hour
Day
Month
Year

Series Type

Line: displays the plot as a line chart.
Bar: displays the plot as a bar chart.
NOTE: You can also change the Series Type by right-clicking on any data point on and plot,
and selecting Change Series Type.

12.3.2 Data Series Settings

Data Series (Range) settings can be accessed by right-mouse clicking on any data point on
the plot, and selecting Edit Range Settings from the pop-up menu. The following Series
Settings dialog will appear:

On the left side of this dialog, there is a list of available data series for the selected plot. You
may also Add Data Range series, and specify Data Series options for this Series. This is
useful if you want to identify data on the plot that exceeds a guideline or standard value, and
assign unique symbol or label properties to this data set only.

Click on the  (Add) button to add a new range

Click on the  (Delete) button to delete the selected range
When you add a new Range, enter the Breaking Value; this is the upper limit for the range.
For the example shown in the screenshot above, there will be two ranges:
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Within guidelines: Values 0 - 100 (inclusive) will have unique symbol and label properties
Exceedences: Values greater than 100 to 120 (inclusive) will have a different set of symbol
and label properties, so they can easily be distinguished on the plot
The Labels provides options for the data series labels:
Text: Select the Font, Color and Alignment options for the text.
Custom: There are several options available for defining custom label.
Use different label source allows you to select a field from the list, for the labels from a list.
Include pre-fix provides the option to attach a text string in front of each label
Include post-fix provides the option to attach a text string at the end of each label

NOTE: If the Label options are inactive, you must set the Labels to Visible; load the General
Series Settings, and enable the Labels Visible option.

As you define the label options, the Preview frame at the bottom of the dialog provides a live-
update preview of how the data series labels will appear using the selected settings.
When you are finished with the Label options, you can click on the Symbol tab to modify the
symbol options as shown in the screenshot below:

The following settings are available:
Symbol marker: select the symbol marker type from the combo box
Marker Size
Height: specify the symbol height
Width: specify the symbol width
Proportional: use this option to create proportionally sized symbols, dependent upon the
result value
Min value: specify the min value for the smallest symbol size; then specify the marker size
(Height and Width) that should correspond to this value
Max value: specify the max value for the largest symbol size; then specify the marker size
(Height and Width) that should correspond to this value
As you define the label options, the Preview frame at the bottom of the dialog provides a live-
update preview of how the data series symbols will appear using the selected settings.
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12.4 Adding Lines to a Plot
Best fit lines, or lines calculated with user-defined formulas, can be displayed on any plot; to
do so, right-mouse clicking on any data point on the plot, and selecting Add Line from the
pop-up menu. The following Add Line dialog will appear:

Enter a line Name at the top of the dialog; this name will appear on the plot.

The following Line Types are available:
· Formula
· Best Fit
Best Fit is the default line type; when selected, the following settings are available:
Best Fit type: select from Std Deviation, Moving Average, or Exponential Moving Average
Source Series: select the data source series to which the line should be applied
Period: enter a period value
When the Formula line type is selected, the following settings will be available:

Formula type: select from Constant, Exponential, Logarithmic, or Inverse
Source Series: select the data source series to which the line should be applied
Constant Value: When a Constant Formula Type is selected, enter a constant value for the
location of the line. This will result in a straight line drawn on the plot.
Click [OK] when you are finished, to draw the new line on the plot. The line series will appear
in the tree under the selected plot. The line settings can be modified as described below.

Line Settings
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When a line is selected for a plot, the Settings tab will display the appropriate Line Settings
as shown below:

Name: set the line name

Line
Visible: show/hide the line
Width: set the line width
Color: specify the line color
Style: specify the line style (Solid, Dashed, etc.)

Marker
Show / hide markers on the line using the Visible option
Font: Set the font for labels for the line markers
Color: specify the color
Size: Set the size of the markers along the line

12.5 Saving, Exporting, and Printing
There are several options available for saving, exporting, and printing your plot page design.
Saving

Once you are satisfied with the current plot page design, click on the  (Save) button on
the toolbar. The new plot will appear under the Plots node in the HGA tree.

Exporting
To export the current plot page design, right-mouse click on the plot page design node in the
tree, and select Export Plot Page to Image from the pop-up menu. The image can be saved to
the following graphics file formats:
.BMP, .JPG, .TIF, .EMF, .GIF, .PNG
Enter a filename, and choose the file format, and click Save.

Copy Plot to Clipboard
This option is available for individual plots in the design. To copy the selected plot, to the
windows clipboard, right-mouse click on the plot name in the tree, or right-mouse click on the
plot in the viewer, and select Copy to Windows Clipboard from the pop-up menu. You can
then insert the plot into a graphics or word processing application for further modifications.
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Printing
A plot report may be generated from within the Plot Designer, and either printed or saved to
an external file.
With the Plot Designer window open, click on the Print button at the bottom of the Plot
Designer window, and select from one of the print options, as shown in the following screen
shots.

NOTE: If you select Send all plots to report, a report will be generated for each station in the
current selection; please be aware that this may take some time. If you want to print a plot for
just the selected station, use the Send current plot to report option.
You will be prompted to Select a Template for generating your report, as shown in the
following screenshot. You can either select from the existing templates, or leave the selection
blank and create a new report template for yourself.

Click the [OK] button to load the plot(s) in the Report viewer.

The Report may be printed directly by clicking on the  (Print) button, saved to a report

archive file by clicking on the  (Save) button, or exported to one of several file formats,

including .RTF, .PDF, .HTML, .XLS, and .TIF, by clicking the  (Export) button.
If you would like to modify an existing report template, or if you did not select an existing
template and are creating your own report, you can modify the report design to suit your
needs. 

12.6 Managing Plot Templates
Saving Plot as Template

Once you have designed the current plot to your style and data needs, you can save the
design as a template for re-use in future plots. To do so:
F Right-mouse click on Plots, and select Save as a plot template from the menu
Enter a name for the plot template and
F [OK]
The template will be available next time you create a new plot, in the Add Plot dialog under
the Templates combo box.

Deleting Plot Templates

Plot templates can be deleted from the main HGA window.
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Right-mouse click on Plots in the HGA Project Tree and select Plot Templates. The following
dialog will appear:

Select the template you want to remove, then click on the  (Delete) button at the top of
the window.
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13 Well Profile

The Well Profile module can be used to display detailed information pertaining to a single
station or well including:

· Well construction details (casing, screens, annular fill)
· Geophysical data plots
· Lithology information for each formation
· Description of the geologic formation
· The depth and or elevation of each layer
· many others...

In a typical profile reports, there may be one or more instances of the items listed above. The
number of columns, and their order of display, is flexible and can be set at the time of
designing the template and edited at any point thereafter. Templates can be created for one
or more stations at once based on a desired design. You can create as many different
templates as you need to suit your project needs.

The Well Profile module can also be used as a data entry assistant in HGA, by displaying for
example well construction details as data is entered in tables on the Station Data tab.

13.1 Well Profile Interface

The Well Profile can be launched by selecting the  icon from the main toolbar or by
selecting Modules/Well Profile or by simply double clicking on an existing Well Profile
template found in the Project tree. It will be loaded with the last template that was used.
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You can change the template you are viewing by selecting from the list of templates available
in the drop down. The current station displayed is presented in the toolbar - you can change
stations by selecting another one from the Station Picker in the Project Tree.

The following options are available on the Well Profile toolbar:
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 Refresh data - refreshes the display with latest data from database

 Zoom In - this will give you an option to enter top and bottom values of the interval you
wish to view

 Zoom Out - this will zoom out the display to full extents

 Create a new template - will prompt you for the name of your new template and then
open the editor options

 Edit - will open the editor options

 Delete selected template - will delete the currently select template

 Save Image As - allows you to save your well profile as a .bmp or .emf file format

 Create new PowerPoint template - allows user to create a new PowerPointTM template
using a query to have fields from query appear on the template

 Print to PowerPoint - allows user to push well profiles for one or more stations to a

PowerPointTM template

 Export to cross section - allows you to save images that can then be used to display
on a Cross Section

The editor portion of the toolbar becomes available when you select the Create a new
template or Edit button. You will notice it opens a new set of options on the left side of the
toolbar.

 Save - saves any edits done to the current template

 Save As - allows you to save the current template with a new name

 Rename template - allows you to rename the current template

 Add column - adds a new column

 Delete column - deletes the selected column

 Move column up - moves the selected column up in the design
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 Move column down - moves the selected column down in the design

 Reset to column defaults - restores the settings for the selected column back to default
values

 Add annotation - adds an annotation anywhere on the Well Profile template

 Delete annotation - deletes selected annotation

 Close editor - this will close the editor portion of the Well Profile

The editor portion of the Well Profile provides you the ability to add several different column
types to the template as well as adjusting the settings for the columns.
The overall settings for the design of the template (like header height, outline colour and
thickness as well as column defaults) can be found by selecting the Design node.

Here you can find the option to display your template as True Vertical Depth by selecting Yes
for this option. All data will be calculated as true vertical depth based on the inclination angle
entered into the Drilling Protocol table.
You also have the option to use 0 (zero) as your top value or the minimal measured value.

13.2 Scale Column
The scale column displays a vertical scale on the Well Profile template.
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The following settings are available:

Here you will find the option to Show Elevation values instead of depth values on the scale
column - this will automatically be calculated by using the elevation value in the Station table
and subtracting the depth values.
You also have the option to change the Display Unit - this allows you to display multiple
scale columns within a template showing different units.

13.3 Lithology Column
The Lithology column displays the intervals of data from the Lithology table. Displaying both
the images from the project Material Specification as well as the name of the soil type
entered in the Lithology table.
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The following settings are available:

By default the Data settings are mapped to the Lithology table and the Entities are mapped to
from, to, and soil type for both the text and the image however you can adjust these.

13.4 Interval Column
The Interval column is meant to display data that has been stored as from and to
measurements. You can display descriptive text, values or images associated with the
interval.
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The following Settings are available:

You can choose to display data from a table or from a query in the Data settings. 
Then you can select the from, to, text and image fields from the drop down options in the
Entities settings.
The settings also allow for user to show text or image or both, also options are available to
select the style of images and the percentage of the column the images should fill.

13.5 Depth Column
The depth column is meant to display data related to a specific depth. You can display text
or values associated with the depth.
A typical use might be to display water levels displaying the date of the water level.
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The following settings are available:

The Data options allows you to select either a table or a query and the Entities options allows
you to select the associated fields.
The settings options allows you to display no image, show image or show symbol.
The show symbol allows you to display the water level symbol and the Symbol options allows
you to adjust the look of the symbol.

13.6 Well Construction
The Well Construction column is the most comprehensive data column in the Well Profile. It
displays data from various sources in your database including:
· Drilling details
· Lithology
· Annular filling
· Casing 
· Screen
· Water Level
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The following settings are available:

The Settings options allow you to customize the well construction column to show or hide
various components.
The Data options allows you to further adjust the column.
· Casing options include colour, or use of an image, and stick up and reducer options
· Cluster Wells options include layout (stacked or side by side), order to allow for displaying

your cluster (or nested) wells
· Lithology option includes which side (left, right or both) to display the lithology images
· Scale options include similar options to a scale column like major and minor tick marks,

unit, using elevation etc.
· Screen options include colour, or use of an image and labels
· Water Level options include which ones to display (All, Earliest, Latest, Minimum,

Maximum, or Average) as well as label options and location of symbol

13.7 Plot Column
The Plot column is designed to display various types of depth dependent graphs. It supports
both the Interval as well as the Depth based data types. The following are some example data
that may be displayed using this column type:
· Geophysical investigation results
· Analytical results (chemical concentration)
· Analytical results for soil physics (moisture content, bulk density, etc.)
· Soil testing results (pocket Penetrometer, SPT)
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The following settings are available:

The data section provides you with the option to add one or more series to the plot by
selecting the ... button beside the Edit Series.
You can add either depth or interval series to the plot.
The following options are available for a depth series:
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While the following options are available for an interval series:
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13.8 Display on Cross Section
The Well Profile tab provides the option to export images to be used on the Cross Section
Editor. This option will let you choose which Cross Section you wish to generate images for.
There is also an option to generate images for all Cross Sections.

 Images for each station within the selected cross section will be generated based on the
currently selected template. A common template to use is the resistivity_plot_only as it is a
simple plot column. The images that are generated have a transparent background so that
you can visualize them over the cross section interpretations.
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14 Map Manager

The Map Manager is built on ESRITM Map Objects technology and is packed with an
abundance of mapping features that seamlessly connect your project maps with the Hydro
GeoAnalyst database. However, the Map Manager goes far beyond simple mapping, it also
acts as a fundamental source for producing cross sections, accessing borehole logs and well
construction details, and developing contour maps (elevations, concentrations, water table,
etc.). The Map Manager is an integral part of Hydro GeoAnalyst and is ideally suited for
analyzing and presenting the spatial orientation of your groundwater or borehole project data.

Some of the key features of the Map Manager include:
· Import vector maps into a map project
· Import BaseMap Layers to the Map Project (DXF, Raster and Shapefile formats), including

high resolution MrSid image files.
· Georeference and import raster image maps
· Display Station Groups or Data Queries from the Hydro GeoAnalyst project as a Map Layer

in the Map Project
· Edit map layers (labels, order, style, visibility)
· Draw and edit a point, line, polygon, or text on a map with Annotation tools
· Create contour, color shade and zebra maps of a desired data set
· Create Thematic Maps: Bar and Pie Charts of selected fields
· Select stations using a rectangle, polygon, circle, line, or a single point
· Create new station groups with stations selected in the map project
· Send a Map view to the Report Editor
· Export Map view as Raster images
· Create a legend for the Map Project
· Turn layers on/off and set their properties using Layer Manager
· Define locations for cross section lines
· View statistics for selected data or station group layers (Min, Max, Sum, Standard

Deviation, Mean)
· Label and symbol renderer allows for creating color ramps, gradients, shading, etc., based

on specified station data
· Line measurement tool allows for measuring the distance between two points on the map

project

14.1 About the Interface
Map projects are created and modified within the Map Manager application linked to Hydro
GeoAnalyst. The Map Manager can view and modify one map project at a time. In addition,
the map projects should be modified by only one user at a time.
A map project may have an unlimited number of map layers.
The Map Manager may be loaded from Hydro GeoAnalyst in several ways:

· Select Tools / Map Manager from the Main Menu of Hydro GeoAnalyst

· In the Hydro GeoAnalyst toolbar, click on the  (Map) button
· From the Hydro GeoAnalyst Project Tree, double click a map from the Map Projects

branch

Once the Map Manager window is loaded, the display should be similar to the one shown
below.
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The Map Manager window contains the following elements:

Menu Bar: Contains program menu commands
Toolbar: Contains short cut buttons to some of the most commonly used features in the
Map Manager
Layer Manager: Manages activating a layer, visualizing, and/or editing layers.
Map Window: Contains the visible layers for the map project.
Layer Information: Displays the system for the selected layer.
Coordinates: Displays the X,Y coordinates for the current mouse cursor location, and the
Map Projection system.
Scale: Displays the scale for the map window.
Active Window: Select between the Map Manager window and the Cross Section Editor
window.

The Layer Manager allows you to manage the layers in the map project. The icons at the top
of the Layer Manager provide some insight into the functionality.
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These features include:

 Group Control: Expand and collapse
group layers.

 Visible: Set the visibility status of the
selected layer.

 Editable: Make the selected layer
editable (or not) by checking (or unchecking)
the check box. Currently, only those
shapefiles created in the Map Manager are
editable.

 Label: Displays the Layer name.

 Symbol: Edit the symbol identifying the
layer on the map.

The Layer Manager will contain numerous
types of layers, each represented by a
different symbol type. In the example shown
here, the layer types, from top to bottom, are
as follows:

PointLayer: Point shapefile, represented by
a point symbol. These include station groups
and data query layers imported into the map
project.
LineLayer: A line symbol indicates a cross
section line, contour line layer, or annotation line
PolygonLayer: Polygon shapefile, represented by a polygon symbol
TextLayer: Text annotation layer, represented by a T symbol
Contour Layer: Contour line layer
Station Layers: A group layer containing several component layers
Boreholes and Monitoring Wells: Station group layers
vc_exceeds_1 mg per: A data query
CrossSectionLine2: Cross section line layer
Color Shade: A color shade layer
Airport_color.bmp: Georeferenced raster image
WQ Stations: A station group layer with graduated rendering
DEM_UTM17: A surface (DEM) layer

14.1.1 Grouping Layers

Group Layers help organize map layers that share similar characteristics, in a map project.
For example, if your map contains a railroad layer and a highway layer, you may choose to
group these layers into a single group layer called Transportation Network.
Group Layers behave similarly to other layers within the Layer Manager panel. If you turn off
the visibility for a group layer, the component layers will also turn off. You can also move a
group layer up or down the layer list, change its draw order and ungroup layers as needed.

Creating a Group Layer
To create a Layer Group, follow the steps below:
Right-click anywhere within the Layer Manager panel.
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From the pop-up menu, select Create Layer Group.

Enter a name for the layer group.
Click [Ok]
The new layer group will now appear in the Layer Manager panel.

Adding Layers to a Group
To add a layer to a layer group, simply drag and drop the desired layer onto the layer group.

Removing Layers from a Group
To remove a layer from a layer group, simply drag and drop the desired layer out of the layer
group.

Removing Layer Groups
To remove a layer group, follow the steps below:
Right-click on the desired layer group.
From the pop-up menu, select Delete.
The component layers will ungroup and return to the root of the layer list.

All layer types, including layer groups, can be moved up and down within the Layer Manager
panel, by simply dragging and dropping the layer into a new position.

14.1.2 Description of Toolbar Items

The toolbar in the Map Manager provides access to most of the same features available in the
Main Menu. Most toolbar buttons are context sensitive, and react according to the active
layer, window, or dialog. If there are no options for the selected layer, the respective toolbar
button(s) will become inactive, indicated by a "greyed-out" appearance.

 New button creates a new map project.

 Open button opens an existing map project.

 Save button saves the current map project.

 Print button sends the current map view to the report editor.

 Selection Pointer button allows objects in the active layer to be selected.

 Draw Polygon button allows a polygon to be drawn in the active layer. This feature
is active only when a polygon shapefile layer is selected and set to be editable.

 Draw Rectangle button allows a rectangle to be drawn in the selected layer. This feature
is active only when a polygon shapefile layer is visible and set to be editable.
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 Draw Circle button allows a circle to be drawn in the selected layer. This feature is active
only when a polygon shapefile layer is selected and set to be editable.

 Draw Line button allows a line to be drawn in the selected layer. This feature is active
only when a line shapefile layer is selected and set to be editable.

 Draw a Point button allows a point to be inserted in the selected layer. This feature is
active only when a point shapefile layer is selected and set to be editable.

 Insert Text button allows for text to be inserted on the selected layer. This feature is
active only when a text file layer is selected and set to be editable.

 Information button allows the information for the selected station, or any other object
such as contour lines, to be viewed.

 Measure button allows the distance between two points on the map to be measured.

 Delete Selected Object button allows the selected object (polygon, rectangle, circle,
line, point, or text) to be deleted from the active layer. This feature is active only when an
object is selected.

 Add Vertex button allows a vertex to be added to the selected object (polygon,
rectangle, circle, or line). This feature is active only when an applicable object type is
selected.

 Delete Vertex button allows a vertex to be deleted from the selected object (polygon,
rectangle, circle, or line). This feature is active only when an applicable object type is
selected.

 Zoom In button allows zooming in on the map window. Draw a rectangle in any direction
around the area you wish to zoom in to.

 Zoom Out button allows zooming out from the map window.

 Pan button allows panning the current map view left, right, up, or down.

 Full Extent button restores the map view to the full extent of the map's coordinates.

 Previous Extent button allows restoring the map view to the previous zoom extent.

 Next Extent button advances the map view to the next zoom extent.

 Select Single button allows individual objects such as stations to be selected. This
feature is active only when a layer containing Hydro GeoAnalyst stations is visible, and
selected from the Layer Manager.

 Select In Rectangle button allows selecting all stations within a rectangle that is drawn
by the user. This feature is active only when a layer containing Hydro GeoAnalyst stations is
visible, and selected from the Layer Manager.

 Select In Polygon button allows selecting all stations within a polygon that is drawn by
the user. This feature is active only when a layer containing Hydro GeoAnalyst stations is
visible, and selected from the Layer Manager.
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 Select In Ellipse button allows for selecting all stations within an ellipse that is drawn by
the user. This feature is active only when a layer containing Hydro GeoAnalyst stations is
visible, and selected from the Layer Manager.

 Select Along Line button allows for selecting all stations within a buffer distance of a line
that is drawn by the user. This feature is active only when a layer containing Hydro
GeoAnalyst stations is visible, and selected from the Layer Manager.

 Select All button selects all stations in the current map layer. This feature is active only
when a layer containing Hydro GeoAnalyst stations is visible, and selected from the Layer
Manager.

 Select None button de-selects all stations in the current map layer. This feature is active
only when a layer containing Hydro GeoAnalyst stations is visible, and selected from the
Layer Manager, and at least one station has been selected.

 Cross Section Line button allows the location and buffer distance for cross section lines
to be defined. This feature is active only when a layer containing Hydro GeoAnalyst stations
is visible, and selected from the Layer Manager.

 Show/Create Cross Section button allows a cross section corresponding to a selected
cross section line on the map to be created or viewed. This feature is active only after a cross
section line has been selected or drawn in the map window.

14.2 Description of Menu Items
New

The New item provides options for creating a new map project file. Map projects are saved
with the extension *.VMP in the project sub-directory "Map". The new map project will use
the same projection system and extents as defined in the current Hydro GeoAnalyst project.
NOTE: Each Map Project has required fields which must be present in your database
structure, as defined in the Profile Settings. For more details, see Chapter 4:Template
Manager - Profile Settings.

Open

Provides options for opening an existing Map Project; only files with the (*.VMP) extension
can be opened using the Map Manager.

Save

Provides an option to save the current map project file. All current Map Layers that are
displayed will be saved to the current Map Project file.

Save As

Provides the option to save a copy of the current Map Project with a different name.

Close
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This will close the current Map Project. If there are unsaved edits, there will be a prompt to
save changes before closing.

Reopen

A list of recently accessed map projects will be displayed beside the Reopen item. This is an
alternate method of opening map project files, instead of using the Open command.

Export Project

Creates a copy of all layers in the current map project, for use in other applications.

In this dialog, select the layers you with to export, and define names for the layers; the same
can be done for Surfaces (if any are available). Finally, specify the Destination Folder for the
copy of the map files.
On exporting a map project, selected shapefiles will be exported in the current projection
system if selected by the user. Raster images will use the projection system at the time the
image was georeferenced.

Export Map

Provides options for exporting the current map view to a Raster Image file. Supported file
types include: Bitmaps (*.BMP), JPEGs (*.jpg), and Enhanced Meta Files (*.EMF). Enter a
filename, and choose the file format, and click Save. An Export dialog will appear with
settings for the image file, as shown in the following figure:
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There are several options for modifying the image:
Scale Factor: Choose a scale factor from the combo box. This factor will determine the
resolution of the exported image. The greater the factor the better the resolution will be.
Quality: Using the scroll bar, define the image quality. This option is available only if the
JPEG export format is selected. The greater the percentage the higher the quality will be. The
image size is also directly proportional to this value.
Scale Symbology: Determines if the scale factor will be applied to symbols and lines.
Export Depth: Choose the color quality for the exported image.
Palette: Determines the color palette to be applied to the exported image.
The Palette and Color Depth options are available only for bitmaps (*.BMP) and enhanced
Meta File (*.EMF).

Properties

The Map Project Properties dialog contains general settings for the map project. This dialog
is shown below:

In this dialog, there are options for editing the Projection System, units, and description.

In the Name field, a new name may be defined for the map project.
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In the Projection Type frame, there will be a list of Projection Systems supported by Map
Manager and stored in the Database. For each Projection Type, a Projection must be defined,
along with a corresponding Unit. The default unit for each projection will be displayed. If your
HGA project uses a local coordinate system, all map projects must also use the local
coordinate system. In this case, this setting cannot be modified and will be disabled.
In the Description text box, you may define a brief description of the project.

IMPORTANT: Currently, cross sections cannot be displayed in the Scene Viewer if they have
been created in a map project that uses a geographic coordinate system (latitude, longitude).
If you wish to display your cross section(s) in the Scene Viewer, please be sure to create
your map project using a projected coordinate system, e.g., UTM.

NOTE: Projects in the Map Manager can use co-ordinate systems that differ from those used
for displaying stations in the main HGA window.
NOTE: Changing the projection of a map will affect any existing georeferenced raster image
layers in the map project. If the projection of a map is changed, all georeferenced raster
images must be georeferenced again in the new coordinate system.

Print

Loads the map view into the Report Editor, where the report may be printed and/or saved for
later retrieval. For more information please see The Report Editor.

Exit

Exit the Map Manager and return to Hydro GeoAnalyst.

14.2.2 Layer

A Map Layer is a set of points, lines, polygons or a raster image that have geographic
coordinates attached to it. A Map Layer may be imported into any Map Project.

14.2.2.1 New

Provides options for creating a new map layer. A new layer may be created as one of the
following file types:

· ESRI Polygon shapefile (*.shp)
· ESRI Line shapefile (*.shp)
· ESRI Point shapefile (*.shp)
· ESRI Text shapefile (*.shp)

These are Annotation Layers, meaning that they can be used to draw various shapes or
labels (text) on your map project.
The new map layer will use the projection system of the current map project. After entering a
filename for the layer, the new map layer will be created, then placed in the Layer Manager
and added to the current Map Window.
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HINT: For easy maintenance, it is suggested that the shapefiles be kept in the same folder
as the current map project. By default, Map projects are created in the Map sub-folder of the
current Project folder.

14.2.2.2 Open

Shapefile

Provides options for opening a map layer. The Map Manager is able to open any shapefile
that has a projection system already assigned to it. These shapefiles include all types of
ESRI shapefiles (polygons, lines, points, and text). Once a map layer is opened, it will appear
in the Layer Manager, and is added to the current Map Window.
If the selected shapefile contains numeric attribute data, the Set Field Precision data will
appear on your screen. 

Surface

Provides options for importing 3D surface layers. The following surface files are supported:
· Surfer grid (.grd) version 6 and 7
· DEM (.DEM)
· ESRI ASCII (.asc)
· Text (.txt)

Upon selecting this option, an Open dialog will display (shown below).

Locate and select a surface file, and select [Open]. The following dialog will display where
you can specify a Name, Projection Type, Projection system and Description. The surface
projection system must be the same as the projection system defined for the Map Project.
For example, if your Map Project is set to the NAD83 projection system, you must select
NAD83 for the surface layer.
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Once the surface layer settings have been defined, click [Ok]. The Color Settings dialog
(shown below) will appear.

The Color Settings dialog allows you to define different colored zones/ranges according to
their specific interval of elevation values.
The [Classify] button allows you to decide how many intervals you wish to have, and HGA
automatically divides the available range of values into that number of equal intervals.

The [Ramp] option loads the following dialog.
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You can choose a monochromatic ramp that provides a range of the same color, but with
varying degrees of darkness, a dichromatic ramp that provides a spectrum between two
different colors, or a custom ramp by choosing colors for the Start Color and End Color boxes
(to load the color dialogue, click on the colored box).
Click [OK] to return to the renderer screen.

Alternatively, you may set the color for each value; simply click on the Color box under the
Color column, and the Windows Color palette will display. Select the desired color, and click
[OK] to continue. Repeat this for other values, as desired.
Adjust the Transparency option to make it possible to see layers under the color
shading/zones. The higher the value, the more transparent the layer will be. The value must
be within the range 0-100.

To display the value intervals in discrete color zones, rather than continuous shading, select
the Zebra checkbox.
Once the color settings have been defined, click the [Ok] button.

A surface file with a large grid size may take several minutes to load depending on the
performance capabilities of your computer. For example, a DEM surface file that is
approximately 9mb, may take up to 10 minutes to load.

If the grid size for the selected surface file exceeds 300,000 nodes, the message shown
above will display, and you can choose to accept the original grid size or modify its
dimensions to lower the resolution and decrease the loading time.

To accept the original grid size, click [Ok]. Otherwise, click the [Modify] button to specify a
new grid size. The following dialog will be shown:
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The NCols and NRows fields represent the number of columns and number of rows for the
surface file, respectively. These fields will contain recommended values for the new grid size.
However, you can manually define a new grid size by entering the desired values for these
fields.
Click [Ok] once the new grid size has been defined.

The surface layer will then be generated and added to the Layer Manager panel.

14.2.2.3 Load HGA Data

This menu item provides options for loading Hydro GeoAnalyst data as a new map layer. The
data source may be a list of stations from a Hydro GeoAnalyst Station Group or those
resulting from a Data Query. Upon clicking on this menu item, the following dialog will appear:

In this dialog, select the data source type and choose (from the appropriate combo box), the
desired Station Group or Data Query. The data will be used to create a new Map Layer, and
the layer will be displayed in the Layer Manager as well as in the map window. This option is
available only if a map project is open. The resulting shapefiles will be saved as follows:

· for Station groups, the shapefiles (and supporting files), will be saved to the sub-directory
Map\Selection

· for Data Queries, the shapefiles (and supporting files), will be saved to the sub-directory
Map\Data

Setting Field Precision

If the selected station group or query contains numeric data fields, you will be prompted with
the following dialog:
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The Set Field Precision dialog box lists all the numeric fields in the selected station group or
query. For each numeric field, you can specify the number of decimal places to include when
generating the layer's shapefile. Enter the desired number of decimal places under the
Decimals column for each numeric field, and then click the [OK] button.

Please note that all contouring of numeric values is performed using the precision specified in
this dialog. Moreover, the label renderer will display all numeric values on the map using the
specified precision. If you wish to change the precision after the layer has been created, you
must reload the HGA data into the map project.

14.2.2.4 Import

This menu item provides options for importing basemap layers to the current Map Project.
Basemap images may be Raster Images (*.bmp, *.jpg, *.tif, *.sid, and others) or AutoCAD
files (*.dxf). Each format is explained below.

Raster Image

A critical element of any Map Project is registering the image map with the correct real world
coordinates. This procedure is called Georeferencing. Since raster images do not contain
information on the site's projection system or length units, these details must be manually
added using Georeferencing. Georeferencing assigns points with known coordinates to the
image; the image is then scaled and the map extents are calculated.

NOTE: The Map Manager does not provide an error trap for invalid georeferencing points.

Georeferencing Raster Images

If a Raster image is selected from the Layer / Import menu, a message will appear stating
that the image must be georeferenced. Click [Yes] to continue, and you will be prompted to
save the georeferenced image as a new file:
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Enter a name for the new image. The file will be converted and saved as a bitmap (*.BMP).
This new name will be used as the map layer name in the Map Manager.
Click [Save] to continue, and the Georeference window will appear as shown in the following
figure.
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In order to map the pixels of the image to a coordinate system, the image must have at least
two georeference points with known coordinates. These georeference points can be defined
using the procedure described below.

Note: The real world georeference points must have coordinates that are in the same
projection system as the Map Project. Map Manager will not make adjustments or
conversions for georeference coordinates that are in a different projection system.

To set a georeference point,
Click on the first map location where the X and Y world coordinates are known. A
Georeference point dialog will appear prompting for the X1 and Y1 world coordinates of the
selected location:

Enter the X1 and Y1 coordinates for this point.
Click [OK]
Click on the second map location where the world coordinates are known.
Enter the X2 and Y2 coordinates for this point.
Click [OK]
A box will appear around the map region, similar to the window shown below.
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The Georeference utility will convert the Raster Image to project coordinates; in the top right
corner of the window, the two Georeference Points will be displayed. These values cannot be
modified unless one of the georeference points is deleted and a new georeference point is
assigned.

A box will appear in the map window, defining the image corners. The image region can be
modified as explained below.
To delete a georeference point,

Click the  (Delete Point) button in the toolbar
Select one of the georeference points to delete it.

NOTE: When a georeference point is deleted, a new georeference point must be added, since
two georeference points are required to create a coordinate system.

Once the Georeference points have been defined, the map region may be modified. In the
Select Map Region window, the map region is represented by an outline of a box with circular
nodes at each corner and with arrows pointing along the X and Y axes. The map region box
can be shifted or expanded to any alignment on the site map using the toolbar options
described below. These options may also be accessed from the Options menu on the Main
Menu bar.
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 Resize Region Click-and-drag a corner of the map region box to stretch or shrink the
size of the map region. The new map coordinates will be updated to display the new map
region.

 Rotate Region Rotate the map region

 Align Rectangle Align the map region with the x-axis.

 Maximize Enlarge the map region to the full extents of the basemap.

HINT: If it is desirable to use the entire image for the map, use the Maximize option to
expand the map region to the full extents.

Adding Control Points

You can validate the accuracy of the georeferenced raster using Control Points. Control
points are simply locations on the raster image of which real-world coordinates are known.
Real-world coordinates can be derived from geographic sources such as topographical maps
or GPS units. By comparing the georeferenced raster coordinates with their corresponding
real-world coordinates, you can determine if the raster has been georeferenced accurately.
To add a control point,

Click the  button from the toolbar.
Click a location on the raster image where the real-world coordinates are known. A dialog
similar to the one shown below will display.

Coordinates shown in the above dialog (X2, Y2) represent the interpolated coordinates derived
from the two or three specified georeference points, for that particular location on the image.
You can validate the accuracy of these coordinates by comparing them to the real-world
coordinates of that location. Note: To improve precision, you may want to Zoom In directly on
the location, before adding the control point.

Click [Ok] to accept the Control point. You can add additional control points by simply
clicking on a different location on the raster image.

All control points are stored in a table (shown below) which can be accessed by clicking
Edit / Control Points from the menu bar.
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Here you can review all of the control points. To delete a control point, simply click the
appropriate row in the table and click the [Delete Row] button. Click [Ok] to close the table.

If there is a significant difference between the georeferenced coordinates and real-world
coordinates, check the precision of the georeference points, and reassign if necessary.

Once the georeferencing is completed, click [OK] in the Georeference window. A confirmation
dialog will appear as shown below:

Click [OK] to continue. The Raster Image will then appear as a new Map Layer in the Map
Project.

CAD

The Map Manager also allows you to import AutoCAD files (*.dxf) into a map project. CAD
layers may be built in a Projection that is different from that used for the current map project;
therefore, when a CAD file is selected, the projection system and units may need to be
converted to the current projection system and units. In addition, CAD files may contain
graphic features on different layers; as such, there are options to select the layer to import.
These options are explained below.
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HINT: If you are having difficulties importing your CAD drawing please try exploding all blocks
and re-saving as a dxf file before attempting to import into HGA.

Selecting Layers

When a CAD format is selected using the Layer / Import menu, navigate to the appropriate file
and open it. The following dialogue will load:

The top portion of the dialogue lists the projection system properties of the current map
project. Below this frame is a [Transform] button. This option is required only if you are not
sure that the CAD file has the same projection system as the current map project. In this
case, click [Transform] to georeference the CAD image. Once you are done, click [OK] to
return to the Import DXF dialogue.
In this dialogue, select which layers you wish to import into the map and click [OK].
Transforming Coordinates
The CAD file must contain the same units and projection system as the current map project
in order for it to be displayed properly. If there are differences, then the CAD file can be
Transformed to the map project's projection and coordinate system.
From the Import DXF dialog, click on the [Transform] button. This will launch the Map
Georeference window as shown below.
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Transformation is performed using two points on the DXF file, with known coordinates. The
Map Manager does not provide an error trap for invalid transformations.

Follow the procedure below to import a DXF file, and use the coordinate Transformation
option:
To set the georeference point, click the Georeference button
Click on the first map location where the world coordinates are known. A Georeference point
dialog will appear prompting for the X1 and Y1 world coordinates of the selected location:

Enter the X1 and Y1 coordinates for this point.
Click [OK]
Click the Georeference button again
Click on the second map location where the world coordinates are known.
Enter the X2 and Y2 coordinates for this point.
Click [OK]

The coordinates will be entered into the corresponding Georeference fields on the right-hand
side of the window.
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Once this is complete, click [OK] to continue, and the CAD file will be loaded as a new layer
into the map project.

14.2.2.5 Save

Saves the selected layer.

14.2.2.6 Delete

Deletes the selected layer. A layer cannot be deleted while it is in Edit mode.

14.2.2.7 Create Intersection

With this option, you can create a new map layer from the intersection of any station (points),
polyline, polygon layer, surface layer or color shade/zebra layer, with another polygon layer.

First, select the map layer that will be intersected, from the Layer Manager Toolbar.
Next, select the Create Intersection option from the Layer menu. The following dialog will
appear:

Select the desired layer from the combo box, and enter a name for the new layer. Click [OK]
when you are finished, and the new layer will be added to the Layer Manager panel.

Note: When clipping color shade and surface layers, the Name of the new layer field will be
greyed-out as it is not required

14.2.2.8 Properties

Provides options for modifying the symbol for the shapes (point, line, polygon) on the current
(active) layer in the Layer Manager. The options dialog is shown below:
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The dialog shown here is for point shapes. There are similar dialogs for line and polygon
shapes.

The available symbol Patterns include circle, square, triangle, cross or any symbol from all
true type fonts that may be available on your system. If the latter is selected, you will have to
select the desired font from the Font combo box and the desired symbol from the Symbol
combo box. Choose a symbol size from the combo box in the upper right corner. Finally, the
symbol Fill color may be chosen from a color palette. If a border around the symbol is
desired, select the check box beside Border and provide a border color.

14.2.2.9 Statistics

Displays statistics for the selected data field of a selected layer. These include: Count,
Maximum, Minimum, Sum, Mean, and Standard Deviation, as shown in the figure below.
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14.2.2.10 Renderer

Provides options for a Map Renderer. The Map Renderer allows assigning labels to objects on
the map layers.

There are two types of renderers: System Renderers and Custom Renderers. 
The System Renderers are renderers provided by MapObjects and include label, value and
graduated renderering. 
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Custom Renderers are renderers developed by Waterloo Hydrogeologic. These renderers may
provide the same functionality as the MapObjects renderer, i.e., label renderer, but with
additional options.

System Renderers

A new System Renderer may be added by clicking on the  (Add) button. The following
dialog will appear with the available Renderers from which you can select.

The Graduated Renderer provides a way of classifying features into categories or classes, by
drawing different symbols for features based on numeric attribute values and their ranges.
The Value Renderer provides a means of representing features of a map layer by drawing a
symbol for each unique data value.
The Label Renderer: can be used to display labels on contour maps, or to place labels on
stations or any other object.
Select the desired type, and click [OK].
For each Renderer type, there is a corresponding settings dialog, which is launched

automatically when you create a new renderer; this can also be loaded by selecting the 
(Edit) button after selecting the renderer you wish to change.

Graduated Renderer

Graduated Renderer allows you to graphically display station data according to their specific
interval of values. You have the option of specifying the color scheme and/or the symbol that
represents the station. To use the Graduated Renderer, select Renderer from the 

Layer menu, click the  (Add) button, and choose Graduated renderer from the available
list.
The following dialogue will allow you to compose a set of symbols for different value intervals:
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Enter the Name for the renderer and choose the Field based on the values from which you
want to classify your data.
[Classify] button allows you to decide how many intervals you wish to have, and HGA
automatically divides the available range of values into that number of equal intervals.

Clicking on the symbol beside each interval will load the standard "Point Style" dialog
allowing you to choose a specific symbol and/or color for each interval. Color may also be
specified as a spectrum using the Ramp function.

You can choose a monochromatic ramp that provides a range of the same color, but with
varying degrees of darkness, a dichromatic ramp that provides a spectrum between two
different colors, or a custom ramp by choosing colors for the Start Color and End Color boxes
(to load the color dialogue, click on the colored box).
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This dialogue also allows you to specify the size of the symbols or, if you wish, the start and
end size for a range.
Click [OK] to return to the renderer screen. At the bottom of the Renderer dialog, there is a
toolbar with additional options. These are described below:

From left to right, the function of these buttons are:
· Add a new row to the renderer table, with a new value and symbol/color
· Delete the selected row from the renderer table
· Order the values by Ascending order
· Order the values by Descending order
· Reverse the order of the colors/symbol; lowest will be flipped to highest, and highest will be

flipped to the lowest.

When you are finished, click [OK] again to confirm the renderer settings.
Make sure the renderer you've created has a check mark in the "Visible" column and click
[OK] to apply the renderer.

Value Renderer

The Value renderer function is very similar to the Graduated renderer. The Value Renderer
dialog is shown below.
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At the top of the dialog, specify a Name for the renderer and select a Field Name for the
renderer.

The Value Renderer dialog allows for detailed symbol and label rendering. Use the Frequency
for display value vertical scroll box to set the label display frequency. You can manually
specify value symbols and their corresponding labels by clicking in the desired symbol and
label field. Alternatively, specify a default symbol and select the Default Symbol checkbox to
apply the same symbol characteristics to each value.

Use the Ramp function to specify the color scheme and size for the symbols and click [OK]
first to return to the Value renderer dialog, click [OK] again to accept the settings. Then also
make sure the "Visible" box is checked, and click [OK] to apply the renderer.

Label Renderer

This renderer allows you to display various labels for the selected layer (stations or contour
map, for example).

Enter the Name for the renderer and choose the Field Name which will be displayed as a
label. Customize the settings as desired. Please note that for numeric fields, labels will be
displayed using the precision defined in the Set Field Precision dialog box, when the HGA
data is being loaded into the map project. 

Note: Flip option applies only to the labels that may appear up-side down, such as line
labels. Checking Flip will ensure that all labels will appear right-side up.

Click [OK] to accept the settings.
Make sure the "Visible" box is checked and click [OK] to apply the renderer.
You can add, delete, and edit different renderers using the toolbar located under the renderer
list.
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The renderer may also apply a background to the data symbols; this background can be
modified using the standard "Point Style" dialog.

Custom Renderers

Custom renderers are renderers that have been developed by Waterloo Hydrogeologic.
Currently, the only custom renderer available is the custom label renderer. The custom label
renderer is similar to the system label renderer (described above), however it provides
additional options, allowing for greater control and flexibility when displaying labels on the
map.

Note: Please note that system renderers and custom renderers are mutually exclusive, i.e.,
you cannot apply both a system renderer and a custom renderer to the same map layer.

To add a new custom renderer, make sure "Custom Renderers" is selected from the comb
box at the top of the Renderers dialog.

A new Custom Renderer may then be added by clicking on the  (Add) button. The Label
renderer will be added to the list of renderers.

To configure the custom label renderer, click the  (Edit) button. The Custom Label
Renderer dialog box will appear on your screen.
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The label renderer settings are described below:

Name: Specify the name of the renderer configuration
Show Secondary Label: This control allows you to show/hide a secondary label.
Field: Allows you to specify which layer attribute to show as the object label.
Prepend: Allows you to prepend text to the chosen layer attribute.
Append: Allows you to append text to the chosen layer attribute.
Font...: Loads the generic font settings, e.g., font style, size, color, etc.
Rotation: Allows you to rotate the label.
Alignment: Allows you to set the default label alignment.
Offset: Allows you to offset the label from the default alignment by specifying X and Y values.

Once you have defined the renderer settings, click the [OK] button.

14.2.2.11 Create Thematic Map

This menu item allows the user to create a thematic map for any of the active Map Layers
containing numeric data. A thematic map shows the spatial distribution of one or more
specific data values in the form of a Pie or Bar chart. Thematic Maps can only be drawn on
layers that contain data (such as stations, contour maps, etc.). They are not applicable to
annotation layers.

A common example of the applications for a thematic map would be displaying the
distributions of multiple chemicals.
To create a Thematic Pie Chart for Hydro GeoAnalyst station data,



Map Manager 279

© 2017 by Waterloo Hydrogeologic

A Hydro GeoAnalyst Data layer from the Layer Manager, to ensure that this layer is active.
(e.g. a Station Group or Data Query layer, such as Boreholes, Monitoring Wells, etc.)

Select the menu option Map / Create Thematic Map / Pie Chart from the Map Manager main
menu.

A Thematic map window will appear as shown below:

Enter a name for the map in the Name field. This name will appear in the thematic map list,
should you choose to edit it later.
From the left panel, select the fields for map. Move fields to the right panel using the [>]
button. To move all fields, press the [>>] button.
[Next] to proceed to the next window.
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In this dialog, specify the field color by clicking on the colored rectangles to the right of each
field, and specify the chart size in the Max size and Min size fields. A preview window in the
lower right corner displays a preview of the true size and color of the thematic map, as it will
appear in the Map Manager.

[OK] to create the map.

The thematic map is an entity of the selected layer; when this layer is hidden, the
corresponding thematic map will also be hidden.
The Bar Chart is created in much the similar way. Choose Bar Chart from the Layer /Create
Thematic Map menu and choose which fields you wish to map. The following dialogue will
allow you to choose colors for the bars representing different fields, as well as the max height
and width of the bars.
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14.2.2.12 Modify Thematic Map

Provides options for modifying the properties of an existing Pie or Bar chart.

Select the map you wish to edit by clicking on the check box beside the name you entered
for that map, and click [Modify]. The same Bar Chart dialogue will appear allowing you to go
through the procedure again and change various aspects of the chart

14.2.2.13 Create Contours

With HGA

Provides options for creating contours with data from a selected field, from the selected points
layer. Upon selecting this menu item, the following dialog will appear:
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The gridded data can be represented as the following Contour Types:
· Contour lines
· Color shaded map
· Zebra 

Select the desired Contour type, and enter a name for the layer. For each type, there are
additional settings that can be accessed by clicking on the [Settings] button. See the
sections below for more details on these settings.

Data to be contoured

Select a Field that contains the data you want to contour.
Define the Min and Max values, or accept the defaults

Interpolation Settings

Under Interpolator Settings, select the interpolation method (choose from Natural Neighbor,
Inverse Distance, or Kriging).
To use the advanced interpolation settings, click the [Advanced Settings] button, and
advanced options will be displayed as shown below (for Natural Neighbor):
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You may modify the interpolation settings, then click [OK] to return to the main window. For
more details, see "Appendix C: Advanced Interpolation Settings" .

Use Only Selected Stations
When selected, the contour component will use only those stations that are selected on the
layer, as the data source for the contouring. The option is only enabled when one or more
stations are selected. If not selected, all stations on the layer will be used.

Restrict Within Domain

This option allows you to clip contours lines to a selected polygon layer.

You may select any polygon shapefile from the combo box. Then click [OK] to continue. The
calculated contours will then be clipped at the edges of the polygon.
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NOTE: If the polygon is greater in extents than the selected station layer, the contouring will
end at the furthest point. Currently, extrapolation to the edge of the polygon is not possible.

When you are satisfied with the settings, click the [Create] button to create the contour map.

Contour Line Settings

Click on the [Settings] button beside Contour Lines, and the following dialog will appear:

Specify Intervals; you may select to define the Contour Interval (e.g. 0.5, 1.0, 5, etc.) or the
Number of Intervals (5, 10, 20, 50, etc.). 
You may also define Custom Contour Lines in the grid in the lower corner. Use the + and X
buttons to add/remove custom contours respectively. 
Note: Custom Contour Lines will be added to the map in addition to the ones defined by
selecting  Contour Interval or Number of Intervals. 

Under Contour Line Settings, specify the line color, thickness, style, and label settings. Label
Renderer will add a label to the lines.

Color Shading / Zebra Map Settings

Click on the [Settings] button beside Color Shading or Zebra, and the following dialog will
appear



Map Manager 285

© 2017 by Waterloo Hydrogeologic

The Color Settings Renderer allows you to define different colored zones/ranges according to
their specific interval of values.
The [Classify] button allows you to decide how many intervals you wish to have, and HGA
automatically divides the available range of values into that number of equal intervals.
The [Ramp] option loads the following dialog.

You can choose a monochromatic ramp that provides a range of the same color, but with
varying degrees of darkness, a dichromatic ramp that provides a spectrum between two
different colors, or a custom ramp by choosing colors for the Start Color and End Color boxes
(to load the color dialogue, click on the colored box).
Click [OK] to return to the renderer screen.

Alternatively, you may set the color for each value; simply click on the Color box under the
Color column, and the Windows Color palette will display. Select the desired color, and click
[OK] to continue. Repeat this for other values, as desired.
Adjust the Transparency option to make it possible to see layers under the color
shading/zones. The higher the value, the more transparent the layer will be. The value must
be within the range 0-100.
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The remaining options are similar to those for Graduated Renderers (Add Value, Delete
Value, Ascend, Descent, Change Color); see Renderer for more details.

When you are finished, click [OK] to return to the Contours screen.

14.2.2.14 Create Gridded Data

This feature allows you to interpolate data for the current layer, and create a grid file (.GRD)
for visualization in the Scene Viewer or other applications. For example, if you have a station
layer selected, you can create a grid file based on station elevations or TOC (top of casing)
elevations.

Select this menu item and the following dialog will appear:

Enter a name for the grid file, and select a field containing the source data. Click the [Create]
button to create the file. The grid file will be created in the HGA project's folder, in the
"Surface" sub-folder:
(for example, "D:\Program Files\HGAnalyst\Projects\Demo_Project\Surface\test.grd")

NOTE: As with contours, you can select an interpolation method, and customize interpolation
settings by clicking on the [Advanced Settings] button.

14.2.2.15 Display Data

This feature allows you to display data in a plot or tabular format on the map, for the current
points map layer. Fields are based on points data loaded from Station Groups or Data
Queries (created using the Query Builder). You may define conditions for fields, and highlight
rows in the tables that violate the conditions. For plots, the templates are selected from
available Chart templates.
To activate this feature, first select a layer that contains points data (i.e. a data query or a
station group) from the Layer Control. When you select the Display Data option from the
Layer menu, the following dialog will appear:
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This dialog allows you to manage the various layouts for the map layer.
In the first column, show/hide the layout by setting the Visible status.
Define the Name in the second column.
In the third, you may optionally enter a Description.

Click on the  (Add) button to add a new layout. In the combo box that appears, select
either Tabular or Plot (shown below).

Click on the  (Delete) button to delete the selected layout.

Use the  button to move the selected layout up.

Use the  button to move the selected layout down.
Next you must define the settings for the layout.

Plots

For a Plot display, click on the [Data Settings] button and the following dialog will appear:
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In the list, choose from available plot templates that were created using the chart component.
For details on how to create plot templates, please see Managing Plot Templates. In order to
display the plot in the map, the following requirements in the template must be met:

· Plot Grouping and Series Grouping must be done by station ID
· The plot template must contain data for the selected stations

The remaining settings for the plot are similar to those described in the sections "Choose
Data" tab below.

Tabular

For a tabular display, click on the [Data Settings] button and the following dialog will appear:
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In the Data Settings dialog, you select which Layer Fields from the layer should appear as
Display Fields in the layout table, as well as define the Display settings.

Select the desired fields from the left panel under Layer Fields, then move fields to the
Display Fields under the right panel using the [>] button. To move all fields, press the [>>]
button. To remove fields from the Display Fields, click on the [<] or [<<] buttons respectively.

Use the  button to move the selected field up. Use the  button to move the selected
field down.
Click on the Condition tab, and you will see options for defining validation rules for one of the
selected fields, along with display settings for the table.
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The Header Row Color controls the color of the first row in the layout table.
The Violation Row Color allows you to assign a color to values in the table that exceed the
violation conditions (explained below). This is useful for quickly identifying exceedences on
the map.

The Grid Line Color controls the color of the gridlines in the table.
Under the Violation Field frame, you may specify a condition for one of the display fields.
Select a Field from the combo box, then a Condition (<, >, =, etc.), and define the Compare
To settings. There are two options available:

· Compare to a Value: simply type the value in the provided text box, OR
· Compare to a Field: select another field from the data query, to compare against.

The possibilities are limitless, but here are some examples:
· concentration > 5000 ug/l (a government guideline, or MCL) as shown in the screenshot

above
· depth to bedrock > 40 feet
· overburden thickness < 50 feet
· concentration of a chemical exceeds the criteria limit, where the criteria limit is available in

another field in the selected data query

In the Choose Data tab, you can specify which stations should display the data table. This is
useful if you have a station group with numerous stations, and are interested in displaying the
data summary table only for a few stations.
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Simply place a check-box beside the stations that should display the data summary table.

If you click on the Get Selection Map button, then the Map Manager will "get" only those
stations that are selected on the map layer on the map project, and use only those for the
Display Data. This button is enabled only if you have at least one station selected in the map
layer.

Once you are finished, click [OK] to return to the layout window. From the Layout Setting
dialog, click on the [Display Settings] button in the Callout Box column, and the following
dialog will appear:
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In the Callout Box Settings dialog, you can modify several display properties for the callout
box. The callout box is the box, oval, or bubble, that contains the data for the selected
station. A preview is shown on the right side of the window, in the image above. The following
display settings are available:

Fill Color: set the fill color for the callout box
Outline Color: set the color for the outline of the callout box
Transparent: set the transparency; select from True or False
Box shape: select the box shape; choose from Rectangle, Round Rectangle, or Oval
Tip style: set the tip style; choose from Triangle or Line
Padding: set the padding thickness, the higher the value, the larger the box shape will be
around the tabular values in the layout
Shadow: display a shadow around the callout box; select from True or False
Shadow Color: select the shadow color; only used if Shadow has been set to True
Offset X: set the X Offset; this parameter controls how far the callout box will be placed
horizontally from selected station.

A positive offset will result in the callout box displayed to the right of the station
A value of 0 will center the call out box over the station
A negative offset will result in the callout box displayed to the left of the station

Offset Y: set the Y Offset; this parameter controls how far the callout box will be placed
vertically from selected station.

A positive offset will result in the callout box displayed below the station
A value of 0 will center the call out box over the station
A negative offset will result in the callout box displayed above the station

When you are finished with the Display Settings, click [OK] to return to the layout window.
Click [OK] once more to create the layout on the map, as seen in the examples below.
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Example of Display Data: Chart

You can see that sample values that exceed the specified conditions (TVOC concentration
result value greater than 5000 ug/l), are shaded red for easy detection.
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Example of Display Data: Plot

When stations are clustered, it may be necessary to modify the display location of the callout
boxes. You have the option to manually move individual callout boxes to a new location to
improve presentation. This is explained below.

Edit Layout Setting

To edit the position of the callout box:
Right-mouse click on the map window, and select Edit Layout from the pop-up menu
Click once on any callout box to select it; the box will become highlighted in a color outline,
indicating it has been selected
Left click on the callout box, and using your mouse, drag the box to the new location
When you have done this, the result could be similar to the example shown below.
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When you are finished with the position edits, you must right-mouse click on the map window
and turn off the Edit Layout option, to disable this feature.

To edit the remaining layout settings, including fields, violation conditions, and display
properties, simply select Layer / Display Data from the main menu, then modify the settings
as explained above.

14.2.3 Edit

The Edit menu contains standard windows functions such as Cut, Copy, and Paste objects,
as well as other options for editing shapefiles.
NOTE: Before editing a layer make sure that the Editable check box is selected. After
editing, deselect the Editable check box on the Layer Manager.

Cut

Cuts the selected object to clipboard; only available if an object (polygon, rectangle, circle,
line, or text) is selected.

Copy

Copies the selected object; only available if an object (polygon, rectangle, circle, line, or text)
is selected.

Paste

Pastes the clipboard item onto the current layer.
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Delete

Deletes the selected object.

Delete All

Deletes all objects from the current map layer.

Add Vertex

Provides an option to add a vertex to the selected object. To add a vertex:
Activate the desired map layer containing an annotation object and make it editable
Select an object on this layer

Click on the  (Add Vertex) button or select the Add Vertex option from the Edit menu/
Place the mouse cursor at the desired location; the mouse cursor will change to a pen
Click once with the left mouse button at this location to add a vertex
This menu item is only available when an object (polygon, circle, line or rectangle) is
selected.

Delete Vertex

Provides an option to delete a vertex from the selected object. To delete a vertex:
Activate the desired map layer containing an annotation object, and make it editable
Select an object on this layer; all its vertices will be highlighted

Click on the  (Delete vertex) button or select the Delete Vertex option from the Edit
menu
Place the mouse cursor on the vertex to be removed; the mouse cursor will change to an "X"
Click once with the left mouse button on this vertex to remove it from the object
This menu item is only available when an object (polygon, circle, line or rectangle) is
selected.

Copy Map to Clipboard

Copies the entire Map Window to the clipboard. The map window can then be pasted as an
image in other applications.

14.2.4 Tools

The Map Manager provides annotation tools which allow for drawing shapes and inserting text
labels on the map. The drawing tools are available in both the Tools menu and in the Map
Manager toolbar.

The options for the annotation tools allow modifying the color and style of the annotation
objects.

The annotation items are only available on map layers with the corresponding object type (i.e.
text, line, point, polygon). These are called annotation layers. For example, to draw polygons
on the map, a new map layer with the type "Polygon" must first be created (using the Layer /
New menu option), or if a polygon layer already exists it has to be set to "edit" mode. To add
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text to a map layer, a new layer with the type "Text" must first be created (using the Layer /
New menu option).

The following annotation options are available:

Polygon

Provides the option to draw a polygon. This option is available only when a polygon shapefile
layer is selected and set for editing.

Shifting and Scaling Digitized Polylines/Polygons

Map Manager allows you to shift and scale digitized polygons and polylines. These options
are NOT accessible through the main menu. However, they can be accessed by double-
clicking on a digitized polyline or polygon, while you are in edit mode. When double-clicked, a
blue box will appear around the vertical and horizontal extents of the digitized shape
indicating that the whole shape is selected (as shown in the image below).

You can scale the polyline/polygon by clicking on one of the vertices located on the blue box,
and moving it to a new position (holding the left mouse button).

You can shift a polyline/polygon (up, down, left or right) by placing your mouse cursor inside
the blue box (mouse cursor symbol will change) and then clicking and dragging the entire
shape to a new position.

Note: These features are only available for polyline and polygon layers, which have been
digitized (created) in Map Manager.



Hydro GeoAnalyst Help298

© 2017 by Waterloo Hydrogeologic

Rectangle

Provides the option to draw a rectangle. This option is only available if a polygon shapefile
layer is selected and set for editing.

Circle

Provides the option to draw a circle. This option is only available if a polygon shapefile layer is
selected and set for editing.

Line

Provides the option to draw a line. This option is only available if a line shapefile layer is
selected and set for editing.

Point

Provides the option to add points to the map layer. This option is only available if a point
shapefile layer is selected and set for editing.

Text

Provides the option to add text labels to a map layer. This option is only available if a text
layer is selected and set for editing.

Information

Provides a dialog containing information about the selected station, or other objects such as
contour lines; an example is shown below.

To load the Information dialog,

Select a layer containing HG Analyst station data.

Select Information from the Tools menu, or click on the  (Information) button in the
toolbar
Click once on any station within the selected layer.
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This window will display Station ID, Name, Elevation, TOC, and any other fields depending on
the layer type. If there are stations that share the same ID, and are hidden behind the
selected station, then the scroll arrow buttons (in the lower-left corner) can be used to view
the information for other stations.

NOTE: The information tool can only be used on shape layers that are visible and active.

Measure

Provides an option to measure distances on the map window. To use this utility:

Select Measure from the Tools menu, or click on the  (Measure) button in toolbar.
Place the mouse cursor at the start point for the line. The mouse cursor will change to a
cross-hair.
Click once with the left mouse button to start the line
Drag the mouse cursor to the end point of the line
To add a vertex to the line, click once with the left mouse button, then continue drawing to the
new location.
As the line is drawn, the distance from the start point to the end point (i.e. the current mouse
cursor location) is displayed in a status bar at the bottom of the Map Manager window. This
is indicated in the sample image below:

There will be two values displayed here; The Seg value is the distance from the current cross
hair to the previous vertex location (i.e. the distance of the line segment). The Line value is
the total line distance from the start point, including all segments.
To finish the line and end the line measurement, double-click the left mouse button.

Define Cross Section Line

Allows you to create a cross section line. Make sure you are in one of the HGA data layers
before drawing a cross section line.
Please see the section Defining a Cross Section Line for more details.

Create Cross Section

Loads the cross section editor, for the selected cross section line. This menu item is
activated only when a cross section line is selected/highlighted. There are two ways to
highlight a cross section line:
· Choose the cross section line on the cross section line layer
· Draw a new cross section line on a station layer.

For more details on creating cross sections, please see Cross Section Editor.
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14.2.5 View

This menu provides options to modify the appearance and size of the Map Window, and the
layers within the map project.

Full Extent

This menu item will zoom the map window to its original full extents.

Zoom In

Provides options for zooming into a section of the map that is defined by drawing a rectangle.
Place the cursor on the map and click once to define one corner of the rectangle, drag to a
second position to define the opposite corner of the rectangle, and release the mouse button.
The selected section will be adjusted to fill the screen.

Zoom Out

Provides options for zooming out on the map. Click this menu item and the map window will
zoom out. The current screen will be zoomed out by a factor of two unless it is already in full-
extent mode.

Zoom to Active Layer

Zooms the map window dimensions to the extent of the selected map layer.

Previous Extent

Zooms the map window to the previous window dimensions.

Next Extent

Zooms the map window to the next window dimensions. Activated only after Previous Extent
has been used.

Custom Extent

Allows you to manually set the zoom extents and the center of the Map Window. When this
menu item is selected, the following dialog will appear.
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Provide, the desired viewable width, map scale, and X, Y coordinates of the map that will be
repositioned at the center of the map window.

As the Zoom (window width) changes, the Map Scale changes and vice versa.
The Zoom window width has equal proportions left and right of center.

TIP: When you save the map project, the view extent is saved together with the map project.
The next time the map project is opened, the view extent will be restored.

Turn on All Layers

Makes all layers visible.

Turn off All Layers

Hides all layers.

14.2.6 Select

This menu provides options for selecting or de-selecting stations on the selected layer in the
Map project. Typically, this involves stations from the Hydro GeoAnalyst project. Once the
station's data points are selected, a red circle will appear on top of the station's symbol.

Stations may be selected on the map by:
· Clicking individually
· Drawing a polygon, box, or circle (all stations inside the object become selected)
· Drawing a line and defining a buffer distance (all stations within the buffer distance become

selected)
· Multiple station selections may be accomplished with the use of the <Ctrl> key. Simply

press and hold down the Ctrl key after making the initial selection, then use one of the
tools to select or de-select additional stations.

Each selection option is described below.

Pointer

Allows to select stations one by one. When a station is selected, a red circle will appear on
top of the station's symbol. When another station is selected, the previously selected station
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is un-selected and the new station's symbol becomes selected, indicated by a red circle on
top of the station's symbol.
Rectangle

Allows to select stations within a drawn box. To draw a rectangle, place the cursor in the map
window, click once with the left mouse button in the area of interest and drag a window
around the area, then release the mouse button. All stations within the box will become
selected, indicated by a red circle on top of the station's symbol.
Polygon

Allows to select stations within a drawn polygon. Place the cursor in the map window at one
point of interest, click once with the left mouse button and digitize a polygon around the area
of interest. To add a vertex to the polygon, continue to click with the left mouse button. To
close the polygon, double click the left mouse button at the final vertex. All stations within the
polygon will become selected, indicated by a red circle on top of the station's symbol.
Circle

Allows to select stations within a drawn circle. To draw a circle, place the cursor in the center
of the area of interest, click with the left mouse button and drag an expanding circle around
the area, then release the mouse button. All stations within the circle will become selected,
indicated by a red circle on top of the station's symbol.
Line

Allows to select stations near a drawn line. To draw a line, place the cursor at one end of the
area of interest, click with the left mouse button, and digitize a line through the area of
interest. To add a vertex to the line, click with the left mouse at the vertex location. To finish
the line, double click the left mouse button at the final vertex location. This will open the buffer
distance window.

Enter a buffer distance from the drawn line, and click [OK]. All stations within the buffer
distance of the line will become selected, as indicated by a red circle on top of the station's
symbol. The Buffer distance extends out, perpendicular to the line location.

All

All stations on the current Map Layer will be selected.

None

All stations that are selected on the current Map Layer will be deselected.
NOTE: Once selected, you cannot deselect individual stations.

Add to Station Group
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Provides an option to add the selected stations to a Hydro GeoAnalyst station group. Using
one of the Selection tools mentioned above, select one or more stations, then choose this
menu item from the Select menu, and the following dialog will appear.

Stations can only be added to an existing station group.

Delete from Station Group

Remove the selected stations from a Hydro GeoAnalyst station group. The stations will be
removed from the station group map layer currently selected and active in the layer manager.

14.2.7 Settings

Cross Section

This dialog allows modifying the display properties of features that intersect with cross
section lines, when viewing a cross section in the Cross Section Editor. Selecting this option
launches a dialog similar to that shown in the following figure. The dialog makes a list of all
line type layers available for selection.
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A cross section line may intersect with one or more cross sections, or any line type features
such as rivers and highways; in this dialog it is possible to specify the features to be
displayed on the cross section plots. The dialog also allows you to set display properties of
these features. The following options are available:

Name: Name of the intersecting layer (read-only)
Field: Select a field to represent the layer (typically Name, ID, Text)
Font: Select a font for the label
Symbol: Define symbol properties for the selected layer
Angle: Define label angle

The Field column contains a list of available fields for the selected layer. This field will be
used as the label in the cross section view.
The Symbol column contains the symbol options for the selected layer. Double click on the
field in this column to load the options shown below.

To show the intersections on the Cross Section,
Click on the Cross Section tab.
From the top Menu Bar click Tools, and then Update Cross Section.

The following image shows the intersections between the cross sections:
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NOTE: In order to see intersecting cross sections in the cross section editor, the
corresponding Map Manager project must be open.

Graticule

Provides settings for the graticule (also referred to as gridlines) on the map. The following
dialog will appear:
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Appearance
In the appearance frame, you can edit the line color, style, font.
Tic
Allows defining the number of minor and major tics.
Paddings
Controls the amount of buffer space between the edge of Map Manager window display, and
the labels on the axis. It may be necessary to increase this value when the X and Y co-
ordinates contain many digits
Intervals
Controls the space between the major graticule lines. You can accept the system calculated
Auto values, or enter Manual values.
Mark Text
Controls the axis labels. For each axis, you can set the visible status, rotate the label, and
control the gap between the label and the axis itself.

Code Page

Use these settings to convert accented characters into a shapefile format that can be
recognized by the Map Manager. The following options are available:
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From the combo-box, select the Code Page that should be used for the shapefiles in your
map project. The Map Manager provides several ISO standards. For a complete list of which
standard you should select (based on your language and regional settings) please see
"Appendix D: Map Manager: ISO Codes".
Click [OK] when you are finished.

NOTE: This option is available for new shapes files only; existing shapefiles cannot be
converted.

14.2.8 Help

Contains the contents of the Map Manager help.

14.3 Defining a Cross Section Line
Use the Map Manager to define the locations of cross section lines, which can then be
interpreted in the Cross Section editor. There are two methods for defining cross section
lines: Digitizing and Use Existing Polyline. Additionally, you can modify the buffer area for
your cross sections. Each method is described below.  

Digitizing a Cross Section Line

In the Map Manager, open an existing map project or create a new map project.

Select a Hydro GeoAnalyst data layer (i.e. station data), and ensure this is visible and active
(selected). If you do not have such a layer, you may create one based on station groups that
are available in your Hydro GeoAnalyst project. To do this use the Layer > Load HGA Data
option to select a station group. The Map Manager creates a layer with stations that are
available in the group.
Zoom-in to the area of interest (optional).

Click the  (Cross Section Line) button at the right end of the toolbar, or select
Tools/Define Cross-Section Line from the Main Menu.
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Place the mouse cursor at the starting point of the line, and click once with the left mouse
button.
Click again at another location to add a vertex to the line. You may add one or more vertices
that define the cross-section line. Note: If you wish to place a vertex beyond the extent of the
current map view, click and hold the right mouse button to pan across the map. Also, you
can use the mouse wheel to zoom in and zoom out, while defining the cross section line. 
At the end point of the line, double-click the left mouse button to finish. This will launch the
dialog shown below:

For each cross section line, specify a Name, Buffer Distance and Description. The Buffer
Distance determines which stations will be included in the cross section; stations which lie
within the buffer distance will all be selected (as indicated by a red circle on top of the
station's symbol) and included in the cross section. The Buffer Distance is projected out
perpendicular to the cross section line.
Click [OK] to accept the Line attributes.

If necessary, selected stations can be deselected by clicking on each of them while holding
down the <Ctrl> key.
If necessary, extra stations may be added to the selection by clicking on one or more
stations while holding down <Ctrl> key.

NOTE: Once a cross-section line has been created, stations can still be added to or removed
from the line by selecting the line, then right-clicking and choosing the Add/Remove Stations
option. Stations can then be added/removed by clicking on the desired stations. In order to
use this feature, the station layers on which the cross section are based (e.g. Boreholes),
must be set to Visible in the 
Layer Control.

The cross section can then be created as follows.
Select Tools > Create Cross Section from the Main Menu, or click on the Cross Section

button  on the toolbar.
Click [Yes] to create the cross section; the name assigned to the cross section line will be
used for the cross section name.

Use Existing Polyline
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You can create a cross section line from an existing polyline layer. To do so, follow the steps
below:
Right-click the desired line segment and select Convert to Cross Section Line from the pop-
up menu.

Specify a Name, Buffer Distance and Description. The Buffer Distance determines which
stations will be included in the cross section; stations which lie within the buffer distance will
all be selected (as indicated by a red circle on top of the station's symbol) and included in the
cross section. The Buffer Distance is projected out perpendicular to the cross section line.

Click [Ok] to accept the line settings. The Select Station Layer dialog will display.
Select the appropriate station layer from the dropdown list box and click [Ok].

The following message will display:

Click [Yes] to open the cross section in the Cross Section editor.
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This will load the cross section editor. For more details on creating cross sections, you may
refer to Cross Section Editor section.

Modify Buffer Distance

To modify the buffer distance of a cross section line:
· Select the cross section layer from the Layer Manager panel.
· Select a cross section line.
· Right-click, and select Update Buffer from the pop-up menu.

From the CrossSection Line dialog, specify a new buffer distance.
Click [Ok].

Map Manager will now regenerate the cross section line using the new buffer distance.

Note: Buffer distances for cross sections generated in past versions of HGA cannot be
modified.
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15 Cross Section Editor

The Cross Section Editor is designed with easy-to-use tools for interpreting geological and
hydrogeological data, as well as interpreting data for groundwater flow models. Generating
model layers for use as modeling layer elevations in groundwater modeling packages such as
Visual MODFLOW Pro has never been easier!

In addition, the Cross Section Editor is seamlessly integrated with the Scene Viewer, a tool
that combines and displays one or more cross sections in a 3D fence diagram view!

The Cross Section Editor allows for three types of data interpretations:
· Geologic (containing lithology structure data)
· Hydrogeologic (containing locations of aquifers, aquitards, etc.)
· Model (containing locations of model layer lines, which may be used in numerical

groundwater modeling)

The Cross Section Editor provides users with the following key features:
· Digitize geologic and hydrogeologic layers using the polygon draw tool
· Select standard cross section fill patterns from the Geology
· Copy zones from geology layers in order to define hydrogeology zones
· Display the locations of intersecting layers and other cross sections (using symbols and

labels)
· Display water table location in cross section view
· Dynamically view the spatial orientation of the boreholes in the Map Preview Window -

simply move the mouse over the 2D borehole to highlight its location on the map
· View the orientation of cross sections as they relate to the Map Preview Window
· Define properties of intersecting features (other layers or cross sections)
· Display screened interval in cross section view
· Modify labels for lines and polygons
· Zoom in/out and pan features
· Launch cross section for viewing in the Scene Viewer
· Export cross section view to image format
· Export model layer points for use in groundwater models, including Visual MODFLOW
· Send cross sections to the Report Editor to be included in a report template
· Copy window to clipboard

15.1 About the Interface
The Cross Section Editor may be launched from Hydro GeoAnalyst:
· In the Project Tree, double click on an existing cross section from the Cross Sections

node;

· Select the Cross Sections icon  on the main toolbar and then select the cross section
you wish to launch from the drop down list

· Select Modules / Cross Section Editor and then select the cross section you wish to
launch from the drop down list

The Cross Section Editor may also be launched from the Map Manager in one of the following
ways:
Activate the cross section lines layer from the layer manager, and select a Cross section line
by clicking on the desired cross section.
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To create a new cross section, select the Create Cross Section menu option from the Tools

menu, or click on the Show/Create Cross-Section button  on the toolbar. This option will
create a new cross section based on the selected cross section line.
To open an existing cross section based on an existing cross section line, click on the

Show/Create Cross-Section button  on the toolbar. This opens the cross section editor
with the corresponding cross section.

Click on the Cross-Section tab, in the upper right corner of the window (see figure below) to
activate an existing cross section from a list of cross sections that are available for your
project.

The Cross Section Editor window is shown in the figure below (with a cross section loaded for
demonstration purposes).

The Cross Section Editor window contains the following items:

Menu Bar: Contains program menu commands
Toolbar: Contains short cut buttons to some of the most commonly used features in the
Cross Section Editor.
Layer Control: Manages cross sections, visibility, and editability of interpretation layers.
Right-click a layer to access additional options such as Move up/Move down, View 3D and
Properties.
Cross-Section Window: Contains the cross section view for the selected cross section line.
Site Map: Displays the selected cross section line, as it appears in the map project. The
selected stations for the cross section are highlighted in this Map preview window.
Coordinates: Displays the X, Z coordinate for the current mouse cursor location.
Active Window: Select between the Map Manager window and the Cross Section window.

Description of Toolbar Items
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The Cross section editor contains a toolbar with short cut buttons to some of the commonly
used features. Most toolbar buttons are context sensitive, and react according to the active
layer, window, or dialog. If there are no options for the selected layer, the respective toolbar
button(s) will become inactive, indicated by a greyed out appearance. For example, the option
to add a vertex is active only when a polygon or a line is selected.

 Save button saves the current cross section project.

 Print button sends the current cross section view to the report editor.

 Selection Pointer feature is used for selecting objects in the active interpretation.

 Draw Polygon feature is used for drawing a polygon or a rectangle in the active
layer.

 Draw Line feature is used for drawing a model layer line in the selected layer.

 Add Text features is used for adding annotation to the selected layer.

 Delete Selected Object feature deletes the selected object (shape) from the currently
activate layer.

 Add Vertex feature is used for adding a vertex to the selected object (polygon or line).
This button is activated only if an object is selected.

 Delete Vertex feature is used for deleting a vertex from the selected object (polygon or
line). This button is activated only if an interpretation having at least one object is activated,
and at least one of the objects is selected.

 Link Vertex feature is used for linking two vertices from two polygons or lines. This
feature is only available if an interpretation having at least two polygons or lines is activated,
and at least one of them is selected.

 Remove Links feature is used for breaking the vertex link between two or more polygons
or lines. This button is activated only if an interpretation having at least one object is
activated, and at least one of the objects is selected. For more information, see "Link Vertex"

 Zoom In option is used to zoom in on an area of the cross section, defined by a
rectangle.

 Zoom Out option is used to zoom out from the current cross section view.

 Pan button allows the user to pan the current view left, right, up, or down.

 Full Extent button restores the cross section view to the full extents of the Cross
Section's coordinates.

 Previous Extent button restores the cross section view to the previous zoom extent.

 Next Extent button switches the cross section view to the next zoom extent.

 Information button displays information for the selected station. Moving the mouse
cursor overtop of a station will display the information.
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 Export to Visual MODFLOW Flex button provides an option to export model layers to
xyz text files for importing into modeling project.

15.2 Description of Menu Items
Save

This menu item will save all current edits for the cross section to the current cross section
project file (.VCP).

Close

Closes the currently open cross section.

Export Model Layers

This option allows you to export the model layer lines for all cross sections, to XYZ text file
format. These files can in turn be used to define layer elevations in groundwater flow models,
such as Visual MODFLOW. When this option is selected, the following dialog will appear:
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In this dialog, select the model layers you wish to import. Each model layer will be exported
as a separate file; for each file, you may define the name under the Export As column.

Next select which cross sections should be considered in the export. Click the [Create]
button to generate the files. The files will be generated in the Model sub-folder, of the Project
folder (for example: D:\Program Files \ HGAnalyst\ Projects\ Demo_Project\ Model\
Topography.txt)

The Cross Section editor will generate the text files based on the vertex location of each
model layer line, in each cross section. For example, for model layer 1 (Topography), if cross
section AA' contains this model line with 5 vertices, and cross section BB' has the same
model line with 10 vertices, then the text file should contain 15 rows (if both cross sections
AA' and BB' are selected).

The X,Y location for each vertex corresponds to the X,Y location on the cross section line; the
Cross Section editor also provides the option to save the well contacts using the station's X,Y
co-ordinates, and retrieve this info from the database. 
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Export Image

Provides options for exporting the current cross section to a Raster Image file. Supported file
types include: bitmaps (*.BMP), Joint Photographic Experts Group (*.jpg), and enhanced
Meta Files (*.EMF). Enter a filename, and choose the desired export format, and click [OK].
An Export dialog will appear with settings for the image file:

There are several options for the modifying the image provided in this dialog:
Scale Factor: Choose a scale factor from the combo box. This factor will determine the
resolution of the exported image. The greater the factor the better the resolution will be. A
scale factor of 1 will keep the original size while a scale factor of 2 will be twice the size both
in height and width.
Resolution: Instead of a scale factor you can choose a specific resolution (in units of dpi). The
vertical scale is the ratio of the height of the Cross Section in actual world units / height of the
Cross Section in screen units. These are used to calculate the output image size. So a
higher a resolution will mean a bigger image, while a smaller vertical scale will mean a larger
image.
Quality: Using the scroll bar, define the image quality. This option is available only if the
JPEGs export format is selected. The greater the percentage the higher the quality will be.
The image size is also directly proportional to this value.
Scale Symbology: Determines if the scale factor will be applied to symbols and lines.
Export Depth: Choose the color quality for the exported image.
Palette: Determines the color palette to be applied to the exported image.
The Palette and Color Depth options are available only for bitmaps (.BMP) and enhanced
Metafiles (.EMF).

Print

Loads the current cross section into the report editor's runtime designer. Please refer to The
Report Editor for more details on managing reports.

Exit

Exit the Cross Section Editor, and return to the main window of Hydro GeoAnalyst. Note that
this menu option also closes the map manager.
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15.2.2 Edit

Delete

Deletes the selected object.

Delete All

Deletes all shapes from the currently active cross section interpretation.

Add Vertex

Provides an option to add a vertex to the selected object. To add a vertex:

Activate the desired cross section interpretation (make it editable);
Select an object that is a polygon or a line (depending on the active interpretation type);

Click on the  button or select the Add Vertex option from the Edit menu.
Place the mouse cursor at the desired location; the mouse cursor will change to a pen;
Click once with the left mouse button at this location to add a vertex;
Repeat the last two steps to add more vertices at other locations on the selected object.

Delete Vertex

Provides an option to delete a vertex from the selected object. To delete a vertex:

Activate the desired cross section interpretation;
Select an object that is a polygon or line;

Click on the  button or select the Delete Vertex option from the Edit menu.
Place the mouse cursor on the vertex to be deleted; the mouse cursor will change to an "X";
Click once with the left mouse button on this vertex to remove it from the object;
Repeat the last two steps to delete more vertices from the selected object.

Link Vertex

The Link Vertex option allows for linking two vertices from two polygons or lines. It is intended
to assist in filling in gaps between adjacent polygons (or lines), thus creating continuous
interpretations. The end result is that polygons (or lines) will be able to share a common
"linked" vertex (or vertices).
To Link Vertices on polygons (or lines),
Select the desired interpretation layer and make it editable;
Select the polygon or line whose vertex will be linked with another vertex;

Click the Link Vertex option from the Edit menu or click the  button from the toolbar.
Click on the desired vertex (source vertex) that will be linked with another one; the color of the
vertex changes to green to indicate it has been selected;
Move the mouse cursor to the desired destination vertex, to which the previously selected
vertex will be linked. The mouse cursor will change to a red square outline, when a vertex is
identified;
Click on this red square, and the vertices will be linked.
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The Linked Vertex will turn orange to indicate that the vertex is linked, and shared by two or
more polygons (or lines).

NOTE: "Link Vertices" option is activated only if there are at least two objects on the layer.
Once two vertices are linked, they behave as a single vertex.

Remove Links

The Remove Links option allows for separating previously linked vertices.
To use this option,

Select the interpretation layer containing at least two polygons or lines whose one or more
vertices are linked;
Make this layer editable;

Click the Remove Links option from the Edit menu or click the  button from the toolbar;
Click on one of the linked vertices in the selected polygon; linked vertices are colored orange;
Upon clicking on a linked vertex, the vertex will change back to blue color to indicate that the
link has been successfully removed;

Click on the pointer button  in the toolbar;
Place the mouse cursor on this vertex which has been separated;
Click once on this vertex, and drag the mouse away from its position, and place the polygon
vertex in the new position (if desired);

Set Features

The Set Features option allows for modifying the display properties of most layers in your
map project and other cross sections that intersect with the current cross section. If this
option is selected from the Edit menu, a dialog similar to that shown below will be displayed.

A cross section line may intersect with one or more features that are displayed in one or
more layers in your map project. For instance, one or more rivers from the "Rivers" layer may
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intersect with a given cross section at one or more points. Other features of importance may
include roads, railway lines, lakes, etc. Features from selected map layers that intersect with
a cross section may be displayed as a symbol and/or label on the cross-section line.

NOTE: The intersecting items display options can be defined only at the time when the cross
section is created; currently, it is not possible to set these features later on, once the cross
section has been created. Also, intersecting items must be selected in Map Manager before
the cross section is created.

In the Set Features dialog, there are several options:
Name: Name of the intersecting layer (read-only)
Visible: Defines if the element is visible or not.
Field: Allows you to select a field to use as a label for the intersecting feature
Symbol: Allows you to select a symbol to represent the intersecting feature
Label: Allows you to set properties of the label representing the intersecting feature

The Field column contains a list of available fields for the selected layer. This field will be
used as the label in the cross section view.

Double-click on the desired cell in the Symbol column to load the dialog where a symbol can
be selected and its properties set.

NOTE: You will only be able to change the Font and Symbol of the point if the Pattern is set
to "True type".

The Label Properties dialog may be loaded by selecting the [...] button; the properties that
are available are shown below.
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The Placement options allow you to set the default label placement relative to the feature.
Use the Offset controls to fine tune the placement by adjusting the X and Y values. The labels
can also be rotated by specifying a desired Angle .

Change Well Width

Provides options for increasing the display width of stations (wells and boreholes) plotted on
the cross section.

You can change well width as it appears on the screen by a factor displayed in the "Current
width" drop-down menu. Using this factor, you can make the wells thinner or thicker on the
cross-sectional display.

Change Vertical Axis

This option allows you to extend the vertical range of the elevation axis. When this option is
selected, the following dialog will display:
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Specify a Top value and a Bottom value. Click [Ok] to accept the new values.

Change Vertical Exaggeration

This option allows you to change the vertical exaggeration of the current cross section. The
vertical exaggeration is simply the ratio of the vertical scale to the horizontal scale.

Specify a new vertical exaggeration and click the [Ok] button. The cross section will then be
regenerated to reflect the new vertical exaggeration.

Copy Window

Provides an option for copying the current cross section window to the Windows clipboard.
The window may then be pasted into a supporting application (such as a document, or image
editor, or slide presentation).

15.2.3 View

This menu provides options to modify the appearance and size of the Cross Section Window.
Full Extent

This menu item will result in zooming out the cross section window to its original full extents.

Zoom In
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Provides options for zooming into a section of the cross section that is defined by a rectangle
drawn around the desired area. Place the cursor on the cross section and click once to define
one corner of the rectangle, drag to a second position to define the opposite corner of the
rectangle, and release the mouse button. The selected section will be adjusted to fill the
screen.

Zoom Out

Provides options for zooming out on the cross section. Click this menu item and the cross
section window will zoom out. The current screen will be zoomed out by a factor of two
unless it is not already in a full-extent mode.

Previous Extent

Zooms the cross section window to the previous window dimensions.

Next Extent

Zooms the cross section window to the next window dimensions.

Export to Visual MODFLOW Flex

Allows you to export one or more cross sections to a 3XS file which can be imported into
Visual MODFLOW Flex. Upon selecting this menu item, the following dialog will appear:
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Select the Cross sections to display from the dialog, by placing a check mark beside each
cross section name. Or, to select all cross sections, place a check mark beside the Select
All check box at the top of the dialog.

When you select  [OK] you will be prompted for a file name and location.

Information

Provides a window containing information on the selected station. After selecting this option,
you may place the mouse cursor on a particular lithologic column within a selected station. A
small text box appears displaying specific information about the layer (layer type, top and
bottom elevations, and thickness). If the station in question has screens, the Information
feature can also highlight their pertinent features.

Create Surface Line

Allows you to take surface layers from the map manager and display them as a line layer on
cross section interpretations. Surface data can be used to show the relationship between
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interpretation layers and numerical model layers, or for showing interpolated subsurface
features, e.g., water table.

In order to show surface data on a cross section, you must first import or create the surface
in the map manager. Once the surface exists in the map manager, select Tools > Create
Surface Lines from the cross section editor toolbar.
The following dialog will appear on your screen

The Display Surface on Cross-Section dialog displays all surfaces currently loaded in the
Map Manager. These surfaces may have been imported, or interpolated from point data (Layer
> Create Contours).

Select the desired surface to show on the cross section. You may also change the name of
the surface, and specify the color, size and pattern of the surface line by clicking on the Line
Style preview.

Click the [OK] button to add the surface line to the cross section. The surface line will appear
in the cross section legend under the "Surface" category where it can be shown/hidden,

15.2.4 Tools

Options

Allows setting line snapping options for lines drawn on the cross section. If this feature is
selected, the dialog shown below will appear.
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Editor Tab
In this tab, there are options for specifying the snapping buffers for the selected cross section
and its elements. The Snapping Buffers are specified in pixels. The buffer values determine
the distance to which lines and vertices will snap (i.e. join) to the nearest line or vertex. If a
low value for the Snapping Buffer is specified, the mouse cursor must be very close to a
vertex or line in order for snapping to occur. If a high value for the Snapping Buffer is specified,
then snapping will occur at a distance further away from the destination vertex (or line).

Snapping allows for exact placement of vertices, and eliminates the need for repetitive use of
zooming in to specific locations. If the snapping is used, the vertices will be connected (but
not linked) at the desired locations.

Well Snapping Buffer
The default Well Snapping Buffer is 10 pixels. When a line is drawn, and the mouse cursor
comes within 10 pixels of another well (borehole), then the borehole will be highlighted; upon
clicking the left mouse button on this station's lithologic interval, the line will be automatically
snapped to the closest vertex.

Boundary Snapping Buffer
The default Boundary Snapping Buffer is 5 pixels. When a line is drawn, and the mouse
cursor comes within 5 pixels of a cross section boundary line (either the left or right), then the
boundary line will become highlighted; upon clicking the left mouse button on this boundary
line, the drawn line will be automatically snapped to this boundary line.

Vertex Snapping Buffer
The default Vertex Snapping Buffer is 5 pixels. When a vertex on a polygon is selected, and
the Link Vertex option is used, and the mouse cursor comes within 5 pixels of a vertex on an
adjacent polygon, then the vertex will become highlighted with a red box outline; upon clicking
the left mouse button on this vertex, the vertex on the selected polygon will be automatically
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snapped to this newly selected vertex. Polygon Vertex Snapping makes it easy to place
polygons adjacent to one another, for continuous cross section views.

Labels Tab
Provides options for modifying the label fonts for the interpretation layers (Geology,
Hydrogeology, and Model). Simply click on the sample box beside the appropriate label, and
a Font options dialog will appear as shown below.

Define the desired font settings, then click [OK] to return to the Options dialog.

Rulers Tab
Controls the appearance settings for the axis of the cross section plot. For each ruler (vertical
and horizontal) you may define:
· Foreground Color
· Background Color
· Marker Width
· Min Tic Pixels
· Tic Numbers
· Font
· Vertical Exaggeration

Define the vertical exaggeration scaling factor for new cross sections. There are two options:
Default value, or User-defined (Specific). If the default option is selected, the map manager
will automatically calculate and assign the most appropriate vertical exaggeration factor.

NOTE: Please see "Change Vertical Exaggeration"  in the Edit menu item discussed
previously for information on how to change the vertical exaggeration once a cross section
has been created.

Screen / Water Levels
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Controls the appearance settings for how screens and water levels are displayed on the cross
section. These options are shown below

In this dialog, there are options for the view settings (color, style, etc) for both the screen and
the water levels. The "Gap between Well and Screen" controls the distance between the
station and where the screen is placed. The larger this Gap value, the further away the screen
will be from its respective station.

Intersecting Tab
During a cross section interpretation, knowledge of other interpretations is essential. In this
dialog, you can define display options for intersecting cross sections.
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Specify the color and line style under the Intersecting Layer Symbol frame. In the View
Intersecting While Editing frame, specify the view options for different interpretation types. By
default, all modules will be active.

The intersecting cross sections will be visible when you set one of the interpretation types to
visible, and editable. In the example screen shot below, you can see that cross sections EE
and BB along with their interval locations, are visible while interpreting cross section ZZ:
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Grid Tab
Set the display properties for grid lines in the 2D cross section view.
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In the Grid Lines frame, set the line style, color and width, and also set visibility settings for
the horizontal and vertical grid lines. The Show on Load option will result in the grid being
displayed each time the cross section is loaded.

Interpretation Tab
Define the data storage options for cross section interpretations.

The cross section editor now saves the cross section interpretations to the project database.
The interpretations are also linked to the stations that were selected for the cross section,
and these stations, along with their interval data, are also saved to the database. The
interpretations, and the wells and corresponding interval data, can be retrieved later, using the
Query Builder. 

Store Soft Data Points
Whenever a layer intersects with a station at only one point, it could be because of one of the
following reasons:
The layer truly touches the well at only one location (e.g. pinch-out), or
There is no contact with the well
In either case, the following options are available:
Consider the actually intersecting point as the top elevation and insert NULL for both the
thickness and bottom elevation
Extend the depth of the station fictitiously (within the bounds of the cross section) to
determine the location of the other point. These extensions are known as Soft Data Points. If
this point can not be found within the bound, the layer will be considered to be a zero
thickness layer (with thickness of NULL).

Save All Contacts
Some stations may be crossed by a layer but may not be involved in the interpretation (e.g.
bad wells or data in those wells did not make sense, etc.) and as such, the following options
are available:
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Consider all intersection points as valid contacts; this is the option Save All Contacts
Only store contacts where there are vertices within the well (e.g. user snapped to intervals or
clicked within a well and created a vertex). To do this, disable the option Save All Contacts

Model Layers

Before drawing model layers, the model layer attributes must first be defined in the dialog
shown below. Model layers can be added, deleted, or edited in this dialog.

In the Model Layers dialog, there are four columns:

· Order: Layer order, from top to bottom (read-only)
· Name: Defines the layer name
· Description: Defines layer description
· Pattern: Defines line properties for the model layer

In this dialog, specify the total number of model layers, and the properties for each layer.
Layers will be ordered from top to bottom; the first layer will always be Top of Layer 1 (i.e.
Ground surface), followed by Bottom of Layer 1, Bottom of Layer 2, and so forth. The top
most layer represents the top surface for the first layer while the bottom most layer
represents the bottom surface of the last layer. (i.e. each model line defines the bottom of the
model layer (excluding the top layer)).

Additional model layers may be inserted at any location, at any time.

Press the  (Add) button to add a new model layer. The new layer will be added ABOVE
the currently selected layer.

Press the  (Delete) button to remove the selected model layer.
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To edit an existing layer, press the  (Edit) button or double-click on the row containing
this layer.

Each model layer does not need to appear in all cross sections.

NOTE: The Model Layers options are not available when the Model Layer interpretation is set
to edit mode in the layer manager.

Update Cross Section

Use this option to update the screen, water level, and intersecting layer information displayed
on the current cross section. The corresponding map project should be open in order to
update information from intersecting cross sections.
Cross Section Info

Displays summary info for the selected cross section.

Display Well Profile

Use this feature to display a well profile directly on the selected cross section; when
displaying elements such as geophysical plots and well screen intervals, the well profile can
be a valuable asset when creating a cross section interpretation. The layout settings is shown
below:
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You can select which station to display a well profile for - remember selecting too many
stations may result in a crowded display.
The well profile is displayed to the right of the station in the cross section.

15.2.5 Help

Launches HGA Help, placing the focus on the Cross Section Editor section.

15.3 Cross Section Interpretations
Creating the Cross Section

As mentioned earlier, cross section locations must be drawn using the Define Cross-Section

Line option, or the CrossSection Line button (  ) in the Map Manager. See  Defining a
Cross Section Line for details on this procedure.

Once the cross section line is defined, the corresponding cross section can be created from
the Map Manager, as follows.
In the Map Manager, select Tools > Create Cross Section from the main menu, or click on

the Show/Create Cross-Section button  on the toolbar.
Click [Yes] to create the cross section; the name assigned to the cross section line will be
used as the cross section name.

If surface layers are present in your Map Project, you will be prompted to select a surface
layer. 
Please see Loading Surface Layers for further information.
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The cross section editor opens the selected cross section and displays the stations and
related information.

The cross section shows projections of the borehole lithology columns on the cross section
plane. By default, the topography (top of model layer 1), will be drawn in for you. The starting
point of the cross section line will appear on the left side of the cross section window; the end
point of the line will appear on the right side of the window.

Locations for layers must be interpreted, and drawn manually using lines or polygons; layer
types may be Geologic, Hydrogeologic, or Model

The process of drawing layers is described in the next section.

NOTE: Each cross section has required fields which must be present in your database
structure, as defined in the Profile Settings.

Drawing Cross Section Interpretations

Interpretation of the cross section is a considerably creative process, however the cross
section editor makes it easy for you. Once the selected stations have been loaded into the
cross section editor, the appropriate layers must be manually drawn, and interpreted. Start
the interpretation by selecting the layer type from the layer manager. Choose from Geologic,
Hydrogeologic, or Model. Each of these is explained below.
Hydrogeologic interpretations can be copied from geologic interpretations. As such, it is a
better practice to first perform geologic interpretations of the cross section.

15.3.1 Loading Surface Layers

Surface layers (e.g DEM, Surfer GRD) in a Map Project can be used to generate a detailed
topography model line for a cross section.

Note: A surface layer can only be defined for a cross section line when the cross section is
being created, in the Map component of Map Manager.

When a surface layer is present in a map project, you will be prompted to select a surface
layer when creating your cross section line. The following dialog will display:

This dialog contains all of the surface layers currently present in your map project. Select a
surface from the dropdown list box and click [Ok] to create the cross section. Be sure to
select a surface layer that covers the full extent of the cross section line. Leave this dialog
blank if you do not wish to use a surface layer.
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15.3.2 Geology Layer Interpretations

This option allows for drawing interpretation layers that assist in defining the geology (sand,
clay, till, bedrock, etc) at the site. To draw Geologic interpretation layers, the polygon draw
tool must be used, and the polygon must be digitized manually using the mouse.
Follow the directions below:

· Activate (make it editable) the Geology interpretation from the layer manager;

· Select the  (Polygon) button from the toolbar
· Place the mouse cursor at the desired location of the first vertex of the intended geology

layer;
· Click once on the left mouse button to add a vertex and start digitizing the polygon in the

desired direction;
· Add more vertices by clicking on the left mouse button at desired locations. Move the

mouse cursor to an interval on a desired station; the mouse cursor will snap the vertex of
the polygon to the nearest station interval. A vertex can also be added anywhere on the
cross section by clicking on the left mouse button.

· Double click anywhere on the cross section using the left mouse button to close the
polygon; the following dialog will appear:

· In the dialog that appears, enter a Name for the layer, a brief Description, and select a soil
Pattern. If the geologic layer you have just digitized in the current cross section has already
been created, you may select it from the list, instead of typing a new name. Click on the
blank area beside Pattern to load the pattern options, as shown below:
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· Select a pattern, then click [OK]

Repeat the same sequence of operations for other layers within the active cross section. The
result will be a layered structure of the geological domain. The cross section may contain
some gaps where polygons do not completely touch adjacent polygons; this can be easily
fixed by selecting a vertex on a polygon, and using the pointer tool to re-position the vertex.
Alternately, gaps between polygons can be filled by using the Link Vertex option. These
options are explained below.

Once a layer is created in one cross section, it will be available for selection in all other cross
sections that you might have for your project. Altering the properties of a given layer will be
reflected in all cross sections.

Editing Layers
Once the interpretation layers are drawn, it may be necessary to modify the positions of one
or more vertices, or fill in the gaps between any two adjacent layers, to create a continuous
layered structure.

To move a vertex,

Select the  (pointer) tool from the toolbar
Click on one of the vertices of the polygon
Drag the vertex to a new location.

To add a vertex,

Select the  (pointer) tool from the toolbar
Click once anywhere on the polygon to activate the object
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Select the  (Add Vertex) tool from the toolbar
Place the mouse cursor at the desired location; the mouse cursor will change to a pen
Click once with the left mouse button at this location to add a vertex
Geologic interpretation layers can have a free form, and do not have to conform to a
conceptual model (e.g. a sand layer may appear more than once in an individual cross
section). Layers may not have to continue from first to last borehole. However, to have a
meaningful view of your cross sections in the Scene Viewer, you must avoid creating
overlapping interpretation layers.
When defining Geologic interpretation layers, there is an option to snap the vertices of one
polygon to adjacent polygons. For instance, if after drawing polygons and the cross section
still contains gaps, the gaps may be filled in by linking the vertices of the polygons, using the
Link Vertex option.

To use this option, please refer to the "Link Vertex" in the Edit menu.

NOTE: Moving a vertex of a selected polygon will also move the linked vertex of any polygons
(or lines) that might have been linked through the "Link Vertices" operation.

15.3.3 Hydrogeologic Layer Interpretations

This option allows for drawing layers that define the hydrogeologic layers (Aquifer1, Aquitard1,
Upper Unconfined Aquifer, etc.) based on relevant data in the stations that are displayed in a
cross section. The hydrogelogic layers must be drawn using the polygon tool.
The procedure for drawing and editing these layers is identical to drawing geologic layers, as
explained above.
The position of the hydrogeologic interpretation layers may be defined based on the position
of any Geological interpretations that may already be available. 

Translating Geology Interpretations into Hydrogeology Interpretations
A hydrostratigraphic unit will generally include one or several geologic layers and the
boundaries of a hydrostratigraphic unit will usually conform with the boundaries of the
geologic layers. As such, you can copy one or more of your geologic interpretation layers and
use them as a startup for hydrogeologic interpretation layers.
To do so:
Select the Hydrogeology option from the Layer Manager, to make this layer visible
Right mouse click on this interpretation layer, and select Copy from Geologic Layers, and the
following dialog will appear:
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In this dialog, select one or more geologic interpretation layers to copy
For each layer to be copied, provide the name, pattern and description of the corresponding
hydrogeologic interpretation layer (Aquifer or Aquitard)

Once this is complete, the cross section editor draws the selected hydrogeologic
interpretation layers.

15.3.4 Model Layer Interpretations

This option allows for defining the unique model layers (Model Layer 1, Model Layer 2, etc.)
for the displayed stations. Model layers can be used for numerical groundwater flow models,
or for general purposes. The layer positions for model layers must be drawn in manually with
the mouse, using the Line tool.

15.3.4.1 Defining Model Layers

Before drawing model layers, the layer attributes must first be defined.

To do so,
Select Tools > Model Layers from the main menu
This will load the Model Layers dialog as shown below.
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In this dialog, you can specify the total number of model layers, and set properties for each
layer. In addition, the layers can be numbered in a particular order. Layers will be numbered
starting with 1 for the top most layer and increase with depth. The top most layer represents
the top surface for the first layer while the bottom most layer represents the bottom surface of
the last layer. (i.e. each model line defines the bottom of the model layer). Once the layers
have been defined, additional layers may be inserted at any location, at any time.

15.3.4.2 Drawing Model Interpretation Layers

Before starting to draw model interpretation layers, please ensure that you have defined the
model layer settings explained in the previous section.

You will see that the top of layer 1 (ground surface) is drawn in automatically for each new
cross section.This layer can be modified by moving it through its existing vertices, adding
new vertices at desired locations or deleting existing vertices.

To draw model layers, follow the directions below:
Activate the Model Interpretation Layer in the Layer Manager;

Select the Line draw button  from the toolbar. As soon as this option is selected, the
following Model Layers dialog will appear
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In this dialog, choose the desired model layer by selecting the radio button from the first
column in this grid. Each model layer may be selected and assigned only once. Interpretation
layers that are already drawn in the cross section are colored in orange and are not
selectable.

Click [OK] to continue

Place the mouse cursor at the left boundary at the desired depth of the intended model layer;
when the mouse cursor becomes close enough to the boundary line, the cursor will snap to
the boundary.

Click once on the left boundary to add a vertex at this location, and start the line. Slowly
move the mouse cursor (to the right) across the cross section to the interval in the first
station which represents the model layer. When the cursor is within the specified buffer
distance from the station's lithology interval, snapping will be activated.

With a left mouse click, add a vertex at desired and appropriate locations both within and
outside station intervals.
Continue to move the mouse cursor across the cross section, using the left mouse button at
each station to add a vertex at the desired location for the model layer.

At the right cross section boundary, click once more with the left mouse button to add a
vertex and complete the line; when the mouse cursor becomes close enough to the boundary
line, the line will snap to the boundary. The selected model line will be drawn at the specified
location.
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NOTE: The model line is drawn using the attributes that were defined for it at the time it was
created. Most attributes of a model interpretation layer can be modified by right-clicking on
the desired model interpretation layer and choosing Properties from the pop-up menu.

A dialog similar to that shown below will appear.

Provide a Description, Line Style, Line Color, Fill Pattern for the model interpretation layer;
the Name for the layer cannot be modified, as the name is defined in the Model Layer Options
dialog.
Click [OK] to close the dialog.

Once this is finished, repeat the same sequence of operations for other model layers within
the cross section domain.

Restrictions on Model Layers
The following restrictions apply when drawing model interpretation layers:
· The model layer line must start at the left boundary and end at the right boundary.
· The line must be drawn from left to right, and may not go backwards (i.e. no vertices can be

drawn left of a previously drawn vertex.)
· Model layer lines cannot intersect each other.
· Model layers need to be drawn in the order they are created. For instance the bottom of

model layer 3 can not be drawn between model layers one and two.

15.3.4.3 Snapping Vertices to Other Model Layer Lines

While drawing a model layer interpretation line, it is possible to snap to part of, or all of, the
vertices of an already drawn model layer line. This can be helpful for defining geologic layers
that pinch out (i.e. have zero thickness in some parts of the site).

Snapping between two selected vertices
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Whenever a model layer line is drawn, and the vertex of the line is within the buffer for a vertex
of an adjacent model layer line, a blue box will appear outlining the vertex on the adjacent
line. If the mouse is clicked on this vertex, the vertex will snap to the existing vertex. The line
vertex will change to an orange color to indicate the vertex is linked (shared) between the two
model layer lines. You can link to as many vertices as desired by repeating the above step.

However, if snapping to a series of consecutive vertices is desired, you may click on the first
and the last desired vertices. The cross section editor will create the necessary number of
vertices on the model layer line being drawn and link them to their respective vertices. For
instance, if there are five vertices on the existing model line layer between the selected first
and last vertices, six vertices will be created on the current model layer line. Linked vertices
will move together, and can be separated if needed. The following figure depicts an example of
a model layer pinching out around the middle of the cross section.

Snapping to the end of the cross-section line
If the model layer pinches out from any given point on the cross section to the end of the
cross-section line, the cross-section editor can draw the model line from that given point on
for you. To do this, double-click on the first vertex. The model line will automatically be
created for you. See the bottom most layer in the figure above.

In this example, the model layer pinches out at the right side of the cross section.

15.3.4.4 Editing Model Layers

Editing Model Layers
Once the model interpretation layer lines are drawn, it may be necessary to modify the
positions of one or more vertices or add more vertices.
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To move a vertex,

· Select the  (Pointer) tool from the toolbar
· Click once on the desired model layer line to activate
· Click on the vertices to be moved
· Drag the vertex to a new location.

To add a vertex,

· Select the  (Pointer) tool from the toolbar
· Click once anywhere on the line to activate the line

· Select the  (Add Vertex) tool from the toolbar
· Place the mouse cursor at the desired location on the line; the mouse cursor will change to

a pen;
· Click once with the left mouse button at this location to add a vertex

Adding Multiple Vertices
To insert multiple vertices along a model line, follow the steps below:
· From the layer manager panel, enable edit mode for the Model interpretation layers.
· Select a model interpretation line from the cross section.
· Right-click the line and select Insert Vertices along Line. The following dialog will display:
·

You can insert multiple vertices in one of the following two ways:
· By number: inserts a specified number of vertices along the model line, at regularly spaced

intervals.
· By distance: inserts a vertex at a specified distance interval (e.g every 50 metres), along

the entire model line.

Select the desired method, specify a value and click [Ok] to insert the vertices.
Other properties of model layers (such as name, pattern and description) can be edited by
using the Tools > Model Layers menu option described in the "Model Layers".



Hydro GeoAnalyst Help344

© 2017 by Waterloo Hydrogeologic

15.3.5 Remove Stations from Cross Sections

When working with a cross section in the Cross Section tab, one or more stations can be
removed from the cross section line by right-clicking on the cross section and selecting the
Remove Stations option. Then simply click on a station to remove it from the cross section.
Stations can also be added to/removed from a cross section line in the Map tab, as described
in Defining a Cross Section Line .

15.4 Querying Cross Section Interpretations
In earlier versions of HGA, the cross section interpretations were saved in shapefiles and
along the cross-section line. The cross section editor now saves the interpretation results to
the database, for various uses including:
· displaying the results of each interpretation in HGA
· querying the interpretation table for any desired surface(s) or thickness data, that can be

used for groundwater modeling applications

The final interpretation results may be queried for information such as layer thickness at
selected station(s), top elevation(s), bottom elevation(s), layer type, name and description. 

When you create a Data Query in the Query Builder, and expand the Description data
category, you will see the Interpretation Results table, as shown below:

The Interpretation Results table is read-only (also known as a View), and stores data from the
cross section interpretations. By default, the following fields are included:
· Station ID
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· Station Name
· X (using project coordinates)
· Y (using project coordinates)
· Slice Name
· Layer Description
· Top Elevation
· Thickness Below Slice
· Interpretation type

Simply select the desired fields from the tree view, and move these into the Display Fields, or
Conditions as required. When you are finished, Generate and Execute the query. An example
of the results is shown in the screenshot below.

For more details on using the Query Builder, please see Query Builder section .

15.5 Adding Annotations to the Cross Section
Text labels, lines, and shapes can be added to any layer in the cross section. To add
annotations, you must select the layer, but NOT make it active (i.e. do not check the active
(edit) check box). Once the layer has been selected, right-click and select Annotations from
the list of options. The Edit options shown in the following screenshot can be used to add,
edit, and delete text, lines, and polygons.
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To add an annotation, select the appropriate option from the list to enter Edit mode, then click
the corresponding button from the toolbar. You can then user your mouse to select the
location to add your annotation. After adding an annotation, you will need to click on the
corresponding button again to add another annotation of the same type.

NOTE: If you are adding/editing/deleting one annotation type, you must right-click on the
selected layer and either switch between annotation types, or de-select the current
annotation type, otherwise you will remain in Edit mode for the selected annotation type.
Upon deselecting/switching annotation types, you will be prompted to save your changes.

Add Text

To add text:
Select the Edit Text option from the pop-up menu.

Click on the  Text button on the toolbar
Click on the desired text location in the cross section window
Enter the text in the Input text window that appears.
Once a text box has been created, it can be moved by clicking-and-dragging, or edited by
double-clicking on the existing text. Text can be deleted by right-clicking on a text box and
selecting the Delete option. All text added to a layer can be deleted by right-clicking and
selecting the Delete-All option.

Add Lines
To add Lines:
Select the Edit Lines option from the pop-up menu

Click on the  Draw Line button on the toolbar
Click once on the desired line location in the cross section window, and simply drag and click
to create a line with several vertices.
A vertex can be added to an existing line by right-clicking on a line and selecting the Add
vertex option. A line can be deleted by right-clicking on a line and selecting the Delete option.
All lines added to a layer can be deleted by right-clicking and selecting the Delete-All option.

Add Polygons
To add polygons or rectangles,
Select the Edit Polygons option from the pop-up menu
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Click on the  Draw Polygon or Rectangle buttons on the toolbar
Insert the mouse cursor at the desired location
Click-and-drag the mouse to create the desired shape (double-click in the case of a polygon
to finalize the shape).

Settings
The Settings dialog for Annotations is displayed below:

For each Annotation type, you may show/hide using the Visible check box, or edit the
display properties by clicking on the preview in the Symbol column. You can modify the
standard properties for Text, Line and Polygons.
To save the annotation changes you have made, you can either deselect/switch annotation
types, or click the Save button from the button bar.

15.6 Limitations
Although the cross section component currently allows creating complex, overlapping, zig-
zagging interpretations, these types of interpretations are not suitable for the purpose of
saving (and later querying) in the database. As such, the following rules/limitations are
enforced to avoid saving such results in the database:

· A given layer may not be allowed to intersect a given station more than twice. When this
rule is violated, HGA will consider the two top-most intersection points as defining the layer

· All layers in a cross section must be uniquely identified by the layer name. HGA may pick
the top most layer and ignore all other layers with the same name.

· If a station is removed from a cross section, related saved interpretations (contacts) are
removed as long as this station is not involved in any other cross sections;

· If a layer is deleted from a cross section, all related interpretations (contacts) are removed
from all stations that are involved in the cross section as long as this layer does not appear
in another cross section for any of the stations involved in the current cross section;

· If a given well appears in more than one cross section, interpretation results are updated
with interpretations from the cross section that is last updated.
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16 Scene Viewer

The Scene Viewer allows you to visualize your data in 3D space to get a better understanding

of your entire project. Launch it by selecting the  button in the main toolbar and it will
launch as a tab. Unlike other modules in HGA you are able to launch multiple scene viewers
at once - so you can visualize multiple scenes at once!

Data you can load: 
· Station Groups 
· Cross Sections 
· Plumes 
· Site Maps
· Surfaces 

If you previously had 3D Views saved in your project they will be updated to Scenes when you
open your project in HGA 2016 or later.
Your Cross Sections will not be dynamic - meaning they will show you the most up to date
information in the database - as opposed tot he static view they were previously in the 3D
Explorer.
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16.1 Scene Viewer Interface
When you launch a new scene in the Scene Viewer it will appear empty and ready for you to
add data to it.

You will find the following options in the toolbar above the Scene tree:

 provides you with options for adding data to the scene

 allows you to delete the selected item from the scene

 lets you save the scene so it can be recalled later

 lets you save the current scene with a new name

 allows you to save the current scene as an image file (*.bmp)

 allows you to print the current scene to a Power Point template
 

 allows you to refresh the Scene tree



Hydro GeoAnalyst Help350

© 2017 by Waterloo Hydrogeologic

 allows you to filter for anything in the Scene tree - simply start typing the name of the
item you are looking for

 allows you to clear the filter on the Scene tree

 allows you to dock the Scene tree on the left

 allows you to dock the Scene tree on the right

 allows you to collapse all branches in the Scene tree

 allows you to expand all branches in the Scene tree

There are additional options available in the toolbar above the Scene:

 allows you to zoom in

 allows you to zoom out

 lets you rotate on the axes within the scene

 lets you pan within the scene

 resets the view back to home

  allows you to show or hide the axes within the scene

You also have the option to adjust the vertical exaggeration of the scene 

.  

Once you have loaded a plume into the scene you will find additional options available in the
toolbar above the scene:

There are sliders for both the current time as well as the speed option

 allows you to play the plume in a continuous loop

 provides options for time settings including the start and end dates as well as label
options
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16.2 Adding Data to a Scene
Once you have opened/create a new scene you will want to add data into it. You can drag
and drop your Station Groups or Cross Sections (one at a time) from the Project Tree into the

scene. Or you can use the  button to add multiple items at once.

This dialog allows you to add project items like Station Groups, Cross Sections, and Plumes
in the top half of the dialog.
Double clicking on an item will move it from the Project Items over to the Scene Items. You

can also use the blue arrows (  or  ).
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In the bottom half of the dialog you can add external files like:
· DXF files (*.dxf)
· Surface files (*.asc, *.txt, *.grd, *.dem)
· Image files (*.bmp, *.tif, *.jpg, *.png)
· Shape files (*.shp)

You can add multiple external files by selecting the  and browsing to them. Select multiple
files at once and they will all be added to the dialog and then to the scene when you select
OK.

Cross Sections

Plumes

DXF files

Image files

Shape files

Surfaces

16.2.1 Station Groups

When you load a station group into a scene an item will be placed into the Scene tree under
the Stations Groups branch and this is where you can access the settings for how that
particular Station Group is displayed in the scene.

These settings include whether or not to show labels (station names) the size and colour of
the labels as well as an option to show the Lithology of the stations (based on the soil type
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field in the Lithology table (Geologic Description category) and the Material Specification set
for the project).

Angled or deviated stations can be displayed in the Scene - the inclination and azimuth are
taken from the Drilling Protocol table (Well Construction category) to display these wells.

The settings for the legend for ALL Station Groups loaded into the scene will be found by
selecting the Station Groups branch of the Scene tree.

These settings include whether or not the legend is visible as well as the size of the items in
the legend background colour and location of the legend in the scene. The location can be
adjusted using the Horizontal location and Vertical location settings by entering values
between 0 - 100 as a percentage of the Scene window.

16.2.2 Cross Sections

When you load a Cross Section into a scene a node will be added under the Cross Sections
branch of the Scene tree for each cross section. The main Cross Sections branch of the
scene gives you access to the Interpretation type setting as well as the settings for the
Legends. When you load a Cross Section into a scene you will notice there are 2 legends.
One for the Cross Sections (interpretations) and one for the Stations.
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The Legend for the Cross Sections displays the material images that were used for the
interpretation of the cross section. While the Legend for the stations displays the soil type
images for the stations that are used in the cross sections. The legend for the stations of the
cross section are combined with the legend for any Station Groups that have been loaded into
the scene.

The interpretation type can be adjusted to display any of the available interpretations done for
the cross sections - Geology, Hydrogeology or Model.
The settings for the legends include the title, size of the legend entries, text colour,
background colour etc. Also the location of the legend can be adjusted using the Horizontal
location and Vertical location settings by entering values between 0 - 100 as a percentage of
the Scene window.
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When you load a cross section you will be able to toggle the stations and the interpretations
on and off with the check box for each of these items as they are sub nodes for each cross
section.
And you can turn the entire cross section off by using the visibility check box beside the
name of the cross section.

16.2.3 Plumes

You can load one or more plumes into a scene. Each plume will have its own node under the
Plumes branch of the scene tree. By default when you load a plume an isosurface will be
created and loaded for this plume. Here for example is the BTEX plume from the Demo
Project.

When select you select the name of the plume in the scene tree you will find the settings for
the Legend including the title, colour, entry size and location. As well as the options to add
Isosurfaces and colour maps.
Additionally you have options to edit the default colour scheme that has been generated for
the plume.

When selecting to add an isosurface you will simple need to provide a name and a value and
then you can select the colour for the isosurface - or by default the colour from palette will be
selected. This means depending on the value you enter for the isosurface - the appropriate
colour will be selected.
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The Show border option when selecting will mean that the isosurface is shown as a
continuous object even when it extends outside the bounds of the grid using during the
creation of the plume.
You can add as many isosurfaces as you would like to the scene. Once you have created an
isosurface these same settings can be found by selecting the isosurface sub node on the
scene tree. You will also find an estimate of the volume of the isosurface in the settings.

When selecting the add a colourmap you will have several options.
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You can create colourmaps on a North-South slice or an East -West slice. Additionally you
can create a Horizontal slice colour map. And finally you can also use a Cross Section
(which has been loaded intot he scene) to display your colour map.
Once you have created the colour map another sub node is added to the plume node. From
here you will find the settings to adjust the colour map line and labels.
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You will also find the settings for the transparency of the colour map and the clip value. When
you enter a clip value - any part of the colour map below the clip value will be removed. Here
for example you can see the BTEX colour map clipped at 5000.

To edit the color map palette select the ... button and you will find the following dialog:
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From this dialog you can adjust the number of classes and adjust the style from Stretched
(where the colors blur from one to the next) to Classified (where there are distinct bands of
colors).
You will also find preset options for Equal intervals, Log intervals as well as an option to return
to the default settings.

Once you have added a (transient) plume to the scene you will also notice that some
additional options are available on the toolbar on top of the scene window.

It displays the current time on a slider bar and gives an option for you to play  the plume

through time. There is also a loop option which will continue the animation over and over
until the pause button is selected. There is also a slider bar option to adjust the speed of the

animation of the plume. As well as an option to adjust the time settings :
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The Time tab of the Time Settings displays the start and end of the plume (or if multiple
plumes have been loaded the start of the earliest plume and the end of the latest plume). As
well as an option for the number of intervals along the timeline to display. Less intervals will
make the animation skip through time quicker while more intervals will mean more steps
through the timeline.
The label tab gives you the settings to adjust the time label size, colour location etc.

16.2.4 DXF files

When you load DXF files into the Scene they will appear under the Site Maps node of the
Scene tree. Each DXF file will have its own node.
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When you select the name of the dxf you will find the associated settings. By default it will
load with the colour designated within the file - however you can change this by selecting Yes
for Custom Colour and then select a new colour to use for displaying the DXF. Similarily the
DXF will display using the elevation designated within the DXF file - however you can overwirte
this by selecting Yes for Use custom Elevation. This allows you to place the DXF file at any
elevation within the scene.
You can also change the name of the dxf (by default it uses the file name).

The scene viewer supports 3D DXF files as well as the following DXF entities:
 LINE
 POLYLINE
 LWPOLYLINE
 FACE3D
 SOLID
 CIRCLE
 ARC
 BLOCK
 INSERT
 TEXT

 If you are encountering difficulties displaying your DXF it may be due to unsupported
entities (like SPLINE or 3DSOLID) or the DXF was created by a third party writer that does
not adhere to AutoCAD DXF standards or was created in a very old version of AutoCAD.

16.2.5 Image files
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When you load image files into the Scene they will appear under the Site Maps node of the
Scene tree. Each image file will have its own node.

When you select the name of the image file you will access the associated settings. You can
enter adjust the transparency as well as the elevation. By default if nothing else is loaded into
the scene an image will load at an elevation of 0. Otherwise it will load at the bottom of
whatever other items have been loaded into the scene.

 Please note: Image files must have the associated georeferencing file in the same
folder as the image in order to be brought into the scene.

16.2.6 Shape Files

When you load Shape files into the Scene they will appear under the Site Maps node of the
Scene tree. Each Shape file will have its own node.
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When you select the name of the shape file you will access the associated settings. You
have 3 options for the elevation - by default it loads using the source elevation. However, you
can adjust this to use a specified value or you can drape the shape file over a surface which
is already loaded into the scene.
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All elements of the shape file have associated settings including the Labels, Lines, Points
and Polygons. You can turn each element on or off, adjust the colour, size/width.

16.2.7 Surfaces

When you load surface files into the Scene they will appear under the Surfaces node of the
Scene tree. Each surface file will have its own node.
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When you select the name of the surface you will access the associated settings. Under the
Colors section you can choose to display the surface as a color map or using a custom color
- and you can set the custom colour. By default surfaces are displayed as color maps. You
can adjust the color map palette from the colours selected by default. You can also set a
transparency for the surface.

To adjust the color map palette select the ... button and you will find the following dialog:
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From this dialog you can adjust the number of classes and adjust the style from Stretched
(where the colors blur from one to the next) to Classified (where there are distinct bands of
colors).
You will also find preset options for Equal intervals, Log intervals as well as an option to return
to the default settings.

You will also find settings for the Labels (size, color etc) for the Legend (title, color, entry
size, location etc.) and Lines (color, width, style etc).

16.3 Saving and Recalling Scenes
Scenes can be saved so that they can be recalled later. When you save a scene you will find
it in the Project tree under the Scenes branch.
To recall (or reload) a scene simple double click on it from the Project tree. And remember
you are able to open multiple scenes at once!
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17 The Report Editor

The Report Editor included with the Hydro GeoAnalyst package is used to create professional
reports containing data, and 2D and 3D-views you have generated for your projects. This
chapter presents information on how to transfer stations, grids, query results, maps, cross
sections, borehole log plots, and 3D views into a printable report format, which can be printed
or exported for convenient transfer to your colleagues and/or clients.

The Report Editor provides the following features:
· Create and save Report Layout Templates
· Create and Manage Reports
· Import Reports
· Design and Preview Reports
· Save, Export, and Print Reports
· In addition the report editor:
· Provides an easy-to-use Office-like designer environment
· Supports VBScript and JScript events and expressions
· Provides Barcode control
· Allows report bookmarks and internet hyperlinks

NOTE: This chapter provides a brief overview of the features that the Report Editor offers. For
more details, refer to the Active Reports on-line help file. This file is named AR2Std.CHM, and
is found in the report folder of the HGA installation folder; (The default is \Program
Files\Common Files\Data Dynamics\Active Reports\AR2Std.chm). Simply double-click on the
.CHM file to load the help file.

17.1 About the Interface
The Report Editor may be launched from HGA in several ways:

Select Project / Report or click on the  (Report) button in the Map Manager or Cross
Section Editor modules. When this option is selected, if there are report templates available
for this module, there will be a prompt to Select a Report Template, before proceeding.

The Report Editor may be loaded from the Project Tree in the main window; simply double-
click on an existing Report or Report template under the Reports node

The report editor consists of two main windows:
· The Designer Window
· The Viewer Window
Each component of the Report Editor comes with its own set of toolbars and icons that
perform specific tasks related to the window. The following few sections present a detailed
description of the toolbar icons for each component.

17.2 Report Designer Window
The Report Designer allows you to design the contents, as well as looks, of your reports. All
report designs can be saved and opened for editing and/or generating the final report. A
sample of the designer view is shown below (with a report template loaded for demonstration
purposes).
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The designer window contains the following items:
Property Toolbox: provides the tools that can be used to edit properties of the report and all
its sections including any controls that the report may contain.
Toolbar: provides multiple buttons for functions in the designer
Explorer: allows you to browse through the controls that are placed on the currently opened
report. It facilitates selecting a control for further editing.
Layout window: provides the interface for designing the report
Fields: allows you to select one or more data fields, for displaying data. Simply drag and
drop the selected field into the desired section of the report.

17.2.1 Report Designer Toolbars

The figure below shows a closer view of the toolbars used in the Report Designer window:
.

The following sections describe the toolbar buttons of the designer window.
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Main Toolbar

 New Report: Allows you to create a new report;

 Report Wizard: Allows you to create a new report using the report wizard

 Import MS Access Reports: Allows you to import reports that are created in MS Access

 Open Report: Allows you to open an existing report

 Save Report: Allows you to save the active report

 Save Report As: Allows you to save the active report with another name and/or format
(i.e. as a report template, if desired)

 Page Setup: Allows you to edit the page setup properties

 Printer Setup: Allows you to configure printer settings

 Print Report: Allows you to generate the report and send it to a printer

 Preview Report: Previews the report before printing

 Undo: Cancels the last operation

 Cut: Cut selected text or object from the report designer

 Copy: Copies selection to clipboard

 Paste: Pastes contents of the clipboard to the report designer

 Delete: Deletes current selection

 Reorder Groups: Displays the groups order dialog

Display Settings Tools

 Report Explorer: Displays/hides the control that displays all report elements placed on
each section of the report;

 Fields: Displays/hides the control that displays a list of fields available for the report

 Properties: Displays/hides the properties control for the report

 Toolbox: Displays/hides the toolbar hosting the toolbox icons

 Grid: Displays/hides grid lines on the Designer

 Script Editor: Launches the VBScript editor that may be used to enhance report
automation

Formatting Tools

 Text Style: Selects a format style

 Font: Selects a font for the selected object

 Font Size: Sets the font size for the selected object

 Bold: Sets the bold status of the selected text

 Italics: Sets the italics status of the selected text

 Underline: Sets the underline status for the selected text

 Detailed Font: Launches a dialog that allows setting font details
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 Left Align: Aligns selected text on the left margin

 Center Align: Centers selected text

 Right Align: Aligns selected text on the right margin

 Bulleted List: Formats the selected paragraph in the RTF control as a bulleted list

 Outdent: Outdents the selected paragraph in the RTF control as a bulleted list

 Indent: Indents the selected paragraph in the RTF control as a bulleted list

 Background color: Sets the background color of the selected control

 Text Color: Sets the forecolor of the selected text

 Line Color: Sets the line color of the selected control

 Line style: Sets the line style of the selected control

 Border: Sets the border style of the selected control

General Tools

To insert any of the items listed below into your report, select the item from the toolbar, and
in the designer window, draw a box in the position where you wish that object to appear.

 Select: Selects a control (object) on the Designer

 Label: Allows you to put headings and labels in your report

 Field: Insert it and link to a data field to display specific data from the project. Field also
allows you to put text in your report

 Check box: Add a check boxes to a report; can be used to create check lists in your
report

 Image: Add logos, maps, and other images to your report. You can link it to a data field
in your project, or to an image file outside of the project

 Line: Add simple lines in your report

 Shape: Add shapes (rectangle, square, circle,...) to the report

 Rich Text Control: Add a text box with a RTF text to your report

 Frame: Add a frame in and/or around the report. Similar to the square Shape tool,
however the emphasis is on the border, not fill.

 Subreports: Add any number of subreports to the report. The subreport will be limited by
the width of the control, but the height will grow to accommodate the length of the subreport.

 Page Break: Add a page break in the report at a desired location

 OLE Object: Add an OLE (Object Linking and Embedding) object (such as a picture) to
the report

 Bar Code: Insert a bar code into the report

 ADO Control: Click on it to add a ADO (ActiveX Data Object) datasource control on the
report

 Chart Object: Drag it to the designer to add a chart to the report

 Well Profile: Add a borehole log plot to the report

 ActiveX Controls: Add any ActiveX control that is registered on the current computer to
your report
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Alignment Tools

 Bring To Front: Move the selected item to the front of the overlay view

 Send to Back: Move the selected item to the back of the overlay

 Align Left: Aligns selected controls to the same left coordinate of the last selected
control.

 Center Align: Aligns selected controls to the same center coordinate of the last selected
control.

 Right Align: Aligns selected controls to the same right coordinate of the last selected
control.

 Align Top: Aligns selected controls to the same top coordinate of the last selected
control.

 Align Middle: Aligns selected controls to the same middle coordinate of the last selected
control.

 Align Bottom: Aligns selected controls to the bottom coordinate of the last selected
control.

 Align to Grid: Aligns the selected controls to the closest grid point

 Size to Same Width: makes all selected controls the same width as the last selected
control

 Size to Same Height: makes all selected controls the same height as the last selected
control

 Size to Same: makes all selected controls the same height and width as the last
selected control

 Lock Controls: Locks all controls on the designer so that they will not be resized or
moved from their original location

17.2.2 Toolbox options for General Tools

This section is designed to help familiarize you with the different options available in the
toolbox for various tools. The Toolbox is dynamic, and changes depending on the object
currently active in the Report Designer. The vital options of select tools are described in this
section, however if you require further information, please refer to the ActiveReport help file
included with the installation in the Reports folder.

17.2.2.1 Label

Angle
Allows you to change the angle at which the text appears in the label.

ClassName
Sets the overall text style of the label caption (e.g. Heading1)

Hyperlink
Allows you to change the label into a hyperlink. To do so, enter an internet address inside the
Hyperlink field.
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Left
Determines how far (in pixels) from the left edge of the report the object is located. You can
either enter the pixel value manually or elect the object and drag it to the desired location.

Multiline
Allows you to set whether you want the text to move to the next line when it reaches the right
border of the object (Multiline = "True") or if you want to force the text into a single line
(Multiline = "False").

Top
Determines how far (in pixels) from the top edge of the report the object is located. You can
either enter the pixel value manually or select the object and drag it to the desired location.

Vertical Alignment
Allows you to set how the text is aligned in the object vertically. "Top" will start the text at the
top of the object and the cursor will move down with every new line, while the text is
stationary. "Bottom" will start the text at the bottom of the object and the cursor will remain
on the same line with every new line, while the text moves upwards. "Middle" will start at the
vertical midpoint of the object and the cursor will move down with every new line, while the
text will expand equally upwards and downwards.

17.2.2.2 Field

Custom
Allows you to change the object output format to General, Number, Currency, Date, Time,
Percentage, and Custom. It also allows you to specify the line/border style.

CanGrow
Allows you to set whether you want the text field to become larger if the entered text does not
fit within the allotted frame.

CanShrink
Allows you to set whether you want the text field to become smaller if the text does not fill up
the allotted frame.

DataField
Allows you to attach the field to a datafield in a project through a DataControl (e.g. ADO). If
the field is linked to a DataControl, select the desired data field from the drop-down menu. All
fields linked to a DataControl in a current report are listed in the Fields window under the
Report Navigator tree.

SummaryDistinctField
Specify the field name of the field used in a distinct summary function.

SummaryFunction
Set the function to be used for aggregating data.

SummaryGroup
Set the name of group section for summarization.

SummaryRunning
Determines whether the summary is a running value or not.
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SummaryType
Determines the type of summary to be used.

17.2.2.3 Check Mark

Value
Allows you to determine whether the starting condition of the checkmark is "True" (checked)
or "False" (unchecked).

17.2.2.4 Image

LineColor/Style/Weight
Set the properties of the lines/borders for the object.

Picture
Select the picture you wish to display in the frame. Supported graphics formats are *.bmp,
*.ico, *.cur, *.jpg, *.gif, and *.wmf.

SizeMode
Specify how the picture will be displayed in the frame. "Clip" will display the picture at original
size and if the frame is larger than the frame, it will be cut off. "Stretch" will adjust the image
proportions to fit the frame (even if it means distorting the picture. "Zoom" will adjust the size
of the picture until the entire image is visible in the frame and there is the least amount of
unfilled space possible.

17.2.2.5 Line

AnchorBottom
Anchors bottom of vertical lines to section bottom.

x1, y1, x2, y2
Specify the coordinates (in pixels) of the start and end of the line.

17.2.2.6 Shape

Shape
Specify which shape you wish to display - rectangle, ellipse, or rounded rectangle.

17.2.2.7 Rich Text

MaxLength
Specifies the maximum number of characters a user can enter in the control. The default for
MaxLength is 0, indicating that the text is limited only by available system resources. Any
number greater than 0 indicates the maximum number of characters.

17.2.2.8 Frame

CloseBorder
Specify whether or not the bottom border line will be displayed if the frame spans across
multiple pages.
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17.2.2.9 Sub Report

ReportName
Sets/gets name for the sub-report.

17.2.2.10 Page Break

Enabled
Allows you to enable or disable the page-break.

17.2.2.11 OLE

PictureAlignment
Set the alignment of the contents within the frame.

17.2.2.12 Barcode

BarWidth
Set the width of the thinnest line in the code.

Caption
In barcode, the caption is the set of symbols (alphanumeric) you want to code.

Direction
Set the direction in which the code will be written.

EnableCheckSum
Set whether the checksum is used when the code is rendered.

17.2.2.13 ActiveReport

DocumentName
The document name appears in the print spooler and can be used to easily identify the report.

MaxPages
Sets or returns the maximum number of pages ActiveReports will process. Once the number
of maximum pages is reached, ActiveReports will stop processing the report.
This property can be used to limit the number of output pages when running large reports and
distributing the results over a slow connection.

WaterMark
Adds a specified image to the report's background. The watermark image can be positioned,
sized, aligned and placed on specified pages by using the other watermark properties.

17.2.3 Using the Report Designer

Report Explorer
The Report Explorer (as shown in the figure below) allows you to browse through the controls
of the active report and facilitates selecting controls for further editing. The Report Explorer

windows can be accessed by clicking on the Explorer icon  on the toolbar.
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The explorer provides quick access for selection of controls on the report. Selecting a control
in the Report Explorer activates the corresponding control on the report. This makes the
control ready to be formatted or moved to another location.
The explorer lists at least three nodes under the "MainReport" node, namely:
· PageHeader: refers to the page header for the current report
· Detail: refers to the section that hosts the details of the report
· PageFooter: refers to the page footer for the current report

Any item placed on the page header and footer of your report will be displayed on all pages of
the report. In addition to these sections, one or more sections named Group Headers and a
corresponding Group Footer sections, can be added to the report. In the figure depicted above
the data on the report is grouped by stations. That is, the data for each station is displayed
together. Group Headers can have their own header and footer that will be displayed above
and below each group's data respectively.

Data Fields Explorer
For most report types, the Report Editor takes data directly from the database, based on the
design, and generates the desired report. Access to the data in the database is provided
through the connection string and SQL Statement. These inputs result in a list of fields that
are available for the current report. These fields are listed in the Fields Explorer (as shown

below) that can be displayed by clicking on the Fields icon  on the toolbar.
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One or more fields in the fields explorer can be selected and dragged and dropped into the
desired section of the report if displaying data from these fields is desired.

Report Properties Toolbox
The Report Properties toolbox (as shown in the figure below) provides the tools that can be
used to edit properties of the report and all its sections including any controls that the report

may contain. This window can be accessed by clicking on the Properties icon  on the
toolbar.
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This window serves to access the properties of the controls that are present on the report,
and it contains an orderly list with the names and values of the properties of the objects in the
report, presented in the first and second column respectively.
A combo box with the list of objects whose properties can be edited is provided in the upper
part of the window. Additional information for the selected property is provided at the bottom of
this window.

Designer: Advanced Controls and Settings
Types of Controls
The runtime Report Designer allows you to add several types of controls to your reports.
These controls range from those that are currently shown on the toolbar to all controls that
are present on your computer. The types of controls that are provided on the toolbar can be
grouped as follows:
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Data Access Controls: ADO data control: Provides access to the database using information
provided to it. Only one ADO control can be added to a given report. This control can be

added to the report by clicking on the "Insert ADO Data control icon (  ) on the toolbar

Data Display Controls: Controls that can be used to display information that is either
coming from the data source (database) or provided on the Report Designer. The controls that
fall into this category include:
· Label
· Check box
· RTF Text
· Graphics (Image, Line, Forms, OLE objects, Barcodes, etc.)
· Page break
· Sub reports

Adding Controls
Except for ADO data control, all controls can be added to the report in the desired section. To
add a control to a report:
select the desired control by clicking on the icon on the toolbar
position the cursor at the desired location and click-and-drag to define the size of the control
Depending on the selected control, specific dialog boxes may be displayed requesting
information. Once the control is placed on the report, its properties could be altered by
activating the [Properties Explorer] window and modifying the desired property.
The position of the controls can be changed by selecting and moving the selection to the
desired location. Controls can be moved this way only within a given section. Cut and paste
can be used to move controls to another section.
Some controls have special properties that require the user's attention; these controls are
described below.

Altering Borders of Controls
Border properties of one or more controls can be modified by selecting the controls first and

either clicking on the  (Borders) button on the toolbar or selecting the option from the pop-
up menu.

Modifying Data Source information of the ADO data control
The ADO data control mainly uses the connection string and SQL statement as its input to
provide access to the data stored in your project's database. Currently HGA provides basic
inputs for this control.

However, advanced users may want to modify these inputs in order to produce advanced
reports that are supported by the Report Editor. One interesting feature provided by the
Report Editor is that of generating a report based on specific values. For example, a report
that displays chemical data for all stations can be modified to only generate reports for a
given station and/or chemical.

The SQL statement is usually composed of the following four parts:
SELECT Field1 [, Field2, Field3,...]
FROM Table Name
WHERE Condition1 [AND/OR Condition2]
ORDER BY Field1 [, Field2, Field3,...]
where the highlighted words are internal to the SQL language, and the terms in the brackets
([]) are optional.
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To modify the data source information of the ADO control in your report:
· Select the ADO control by clicking on the appropriate icon on the toolbar
· Display the Properties explorer window if it is not already visible
· Select the Custom properties option by clicking on the button next to this item
· A dialog will appear. Provide or modify the desired options

17.3 Report Viewer Window
The Viewer allows you to visualize the final report as it would be printed. It can be considered
a print preview of your reports. Once your report arrives at the viewer it is ready to be printed,
saved in the native binary format of the Report Editor, or exported to the various formats. A

report preview can be generated by clicking on the  (Preview) button from the Designer
window's toolbar.
A sample of the Report viewer window is shown below (with a report template loaded for
demonstration purposes).

The Report Viewer contains three main components:
· Report Navigation Toolbar: provides a number of toolbar icons that allow you to interact with

the report (described in detail below)

· Table of Contents: can be displayed by clicking on the TOC icon (  ) on the toolbar. The
table of contents allows you to jump to any desired section in the report.

· Main Body of the Report (Preview): The main body of the report displays the final report as
per the report design and data.
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17.3.1 Report Viewer Toolbars

The Report Editor Viewer offers an extensive list of navigation tools; the figure below shows
the toolbars used in the Viewer window.
The following describes the toolbar buttons of the viewer window.

 Open Static Report: Opens a previously saved static report

 Save Static Report: Saves the current report in the Report Editor's native format

 Export Report: Exports the current report to the desired format

 Report Designer: Displays the Report Designer window

 Print Report: Sends the current report to printer

 Show TOC: Displays the table of contents for the current report

 Show Ruler: Displays a ruler

 Search Text: Allows you to provide text to search for

 Find Text: Searches for text provided in the "Search Text" text box

 Copy Page: Copies the current page to windows clipboard

 Show Single Page: Displays report one page at a time

 Show Multiple Pages: Displays multiple pages of the report at once

 Zoom in: Zooms in to a selected area of the report

 Zoom in percent: Sets the zoom level to that selected in here

 Zoom out: Zooms out the report

 First Page: Moves to the first page of the report

 Previous Page: Moves to the previous page in the report

 Page: Moves to the page specified in this text box

 Next Page: Moves to the next page in the report

 Last Page: Moves to the last page in the document

 Back: Moves back to the previous page in a list of recently accessed pages

 Forward: Moves forward to the next page in a list of recently accessed pages

17.3.2 Using the Report Viewer

Once a report is generated and displayed on the Viewer, it can either be saved in the Report
Editor's native binary format, printed, or exported to various formats that are supported by the
Report Editor.

Using the  button on the toolbar, reports can be exported to:
· Portable Document Format (PDF)
· Microsoft Excel
· TIFF
· Hyper Text Markup Language (HTML)
· Rich Text Format (RTF)
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Saving Reports

Saving the report design as opposed to the final report is preferable as the design requires a
smaller storage space (for most reports) and the reports that are generated from a saved
report design are dynamic - they are up to date with the data stored in your database.
However, reports that are saved from the Viewer are static, and they may not reflect the exact
content of the current data.

To save the report, press the  (Save button) from the Viewer window's toolbar. The Report
will be saved as a .RDF file (archive file).
HGA stores and manages all report designs in your project database. All reports that are
created for your project will be retrieved from the database and are listed in the Project Tree
when your project is loaded into HGA.

17.4 Report Settings

The Report Settings dialog can be accessed by clicking the Page Report button  from the
Main Toolbar. This dialog consists of four sections: Page Setup, Printer Settings, Grid
Settings and Styles. Each section is described below.

The Page Setup section allows you to set the page margins of your report page. Set the Top,
Bottom, Left, Right and Gutter margins by using the appropriate vertical scroll bars. Margin
values can be set in quarter increments (1440 = 1 inch). You may also choose to mirror the
margins of facing pages by selecting the Mirror Margins check box.
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The Printer Settings section allows you modify the printing options. Here you can select the
paper size from the Paper Size dropdown list box. You can manually specify the paper size
by using the Width and Height vertical scroll bars.
The Orientation frame allows you to specify the paper orientation.
You may also choose to set the options for Collate, Duplex and PaperBin by using the
appropriate dropdown list box.
Selecting Printer Default for any of the printing options will assign the default setting of the
selected printer, for that particular print option.
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The Grid Settings section allows you to modify the grid appearance of the designer window.
You can set the visibility of the grid by enabling/disabling the Show Grid checkbox. Selecting
the Align Controls to Grid checkbox will automatically snap controls to the nearest grid
column. Set the number of Grid columns and Grid rows by using the appropriate vertical scroll
boxes.
You can change the units of the ruler that appears above the designer window by clicking on
either the Inches or Centimeters radio button.
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The Styles section allows you to create, remove and modify text styles, which can then be
selected from the Text Style dropdown box, and applied to your text controls. Text styles are
useful for applying many text characteristics (font, size, bold, italic, underline etc) to your
text, in just one simple task.
Click the New and Delete button to create a new style and delete a current style,
respectively. The Font, Color and Misc settings in the right frame allow you to set and modify
the text characteristics of the selected style.
Using non-default page dimensions

If you wish to print to any non-default paper size (e.g plotter paper), you must first specify the
page dimensions in three different areas within the Report Designer. To do so, follow the
steps below:
1. In the Report Designer, select the Page Setup button from the main toolbar.
Select the Printer Settings button.
Specify the page size from the PaperSize dropdown box. Alternatively, define the page
dimensions by selecting Custom Paper Size from the PaperSize dropdown box, and then
entering the Width and Length values below.
Click [Ok]
2. Select the Printer Settings button from the main toolbar.
Select the desired plotter from the Name dropdown box.
Again, specify the paper size.
Click [Ok].
3. Manually define the page size within the Report Designer, by increasing/decreasing the

page extents with the mouse cursor.
Now you are ready to print your report.

Limitations

Although the Report Designer provides a detailed interface for customizing reports and
templates, it is limited in the following ways:
· You cannot print multiple copies within one print event
· You cannot select specific pages to print
· You cannot select a page range to print
If you wish to print your reports using these settings, you can always export the report as a
PDF and print the report(s) from a PDF Reader.

17.5 Creating Reports
Reports for your project can be created from the various modules within HGA including:
· Data Grids
· Data Query
· Time Series Plots
· Borehole Log Plots
· Map Manager
· Cross Section Editor
· 3D Explorer

HGA comes with several prepared report templates for most database schemas.
The first two report types listed above can be created through HGA's main interface, while the
remaining types are created only while using the respective modules of HGA. The following
few sections present detailed descriptions on creating each report type.
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17.5.1 Creating Reports in HGA-Main Window

The main interface of HGA allows you to create reports in one of the following two ways:
· From a Grid: create a report with the data in the selected grid
· From a Data Query: create a report using the results of a query

Creating Reports from a Data Grid
Follow the directions below to create a report containing a data grid.
Select the desired grid in HGA (for example, select the Stations List grid, or select the
desired table)

Press the Print button  from the toolbar.
The report will be displayed in the Preview (Viewer) window, by default. To change to the

Designer Window, press the  (Designer) button from the toolbar. This will allow you to
make any desired modifications.
The fields in the selected grid will be added to the report designer; and the ADO data control
is automatically created. An example is shown below for the Lithology table:

The layout of the report can then be modified, and unwanted fields can be removed from the
design. If the fields do not immediately show up in the Design window, press the Refresh
button in the Fields frame, as circled above. To see the ADO Data control for the report, click

on the button  (ADO button) in the Detail section of the Report body design (also circled
above). Then, right click, and select Properties. A dialog similar to the one shown below will
appear.
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In the ADO properties, under Source SQL, you can see that the SQL string has been
automatically created for you, based on the table selected in HGA. In this example, the SQL
string basically states: Select all fields from the Lithology table, where the Station ID is 27,
and order by Station. If you are familiar with the format, you may modify the SQL string here,
and update the report design.
After the report is saved, a node will be created in the Project Tree, under the Reports node
with the appropriate report file name. Currently HGA requires that all reports be saved under
the "Reports" folder, which in turn is created within the project folder. Although the Report
Manager allows you to open reports from any folder, only those saved under the "Reports"
folder of your project will be displayed in the Project Tree.

Creating Reports based on a Data Query
Follow the directions below to create a report containing a Data Query.
Select the desired Data Query from the Queries node in the Project Tree (if no queries are
available, create a Query using the Query Manager).
Execute the Query in order to see the results.

Press the Print button  from the main toolbar, or select Project / Report. (This item is
enabled only if a grid is visible and active and has at least one row of data.)
The report will be displayed in the Preview (Viewer) window, by default. To change to the

Designer Window, press the  (Designer) button from the toolbar. This will allow you to
make any desired modifications.
As in the previous type of report, the report will appear in the Project Tree once it is saved.

17.5.2 Creating a Report Containing a Map Project

Follow the directions below to create a report containing one or more map layers from the
Map Manager.
Start the Map Manager, and open a Map Project
Show/hide the desired layers in the map project (all visible layers will appear in the report)
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Press the Print button  from the toolbar, or select Project / Print from the main menu of
the Map Manager.
The report will be displayed in the Preview (Viewer) window, by default. To change to the

Designer Window, press the  (Designer) button from the toolbar. This will allow you to
make any desired modifications.

The Report Editor allows you to either create a new report for the current map project or add it
to an existing one. If you choose to add to an existing report, the report editor adds the new
map to the report. As such, multiple views of your map project(s) can be sent to a report one
by one.

Each view of your map project is created with its associated scale bar. The map project can
be resized and repositioned as desired on the runtime Report Designer. Note that resizing a
map project on the runtime Report Designer adjusts the scale that is associated with that
specific view of your map project.
The report will appear in the project tree once it is saved.

17.5.3 Creating a Report Containing a Cross Section

Follow the directions below to create a report containing one cross section created in the
Cross Section Editor
Start the Cross Section Editor, and open a Cross Section
Show/hide the desired interpretation layers in the cross section (all visible layers will appear
in the report)

Press the Print button  from the toolbar, or select File / Print from the main menu.
The report will be displayed in the Preview (Viewer) window by default. To change to the

Designer Window, press the  (Designer) button from the toolbar. This will allow you to
make any desired modifications.

The report editor allows you to either create a new report for the current cross section or add
it to an existing one. If you choose to add the current cross section to an existing report, the
report editor adds the new cross section to the report. As such, multiple cross sections can
be sent to a report one by one. In order to be able to add the current cross section to an
existing report, you must first open the existing report.

Each cross section is created with its associated legends and key map indicating the cross
section location in plan view. The cross section can be resized and repositioned as desired
on the runtime report designer.
The report will appear in the project tree once it is saved.

17.6 Managing Reports

Opening an Existing Report
All reports saved in your project are listed under the "Reports" node in the Project Tree. To
open a report, you may either double-click on the desired report or select the "Open Report"
pop-up menu item by right-clicking on the desired report.
All reports are opened in the Report Designer by default. The designer displays the report
layout and allows you to modify it before generating the report. The print preview of the report

can be generated by clicking on the  (Print Preview) button on the toolbar.
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Deleting a Report
To delete a report that is registered with HGA, select it in the Project Tree, right click on it,
and select Delete from the pop-up menu. The selected report will be deleted both from the
tree view, as well as from the file.

Saving a Report
A report can be saved at any time by clicking on the "Save" icon on the runtime report
designer. An existing report will be saved using the same file name. When saving new
reports, your will be prompted for a file name.

Saving a Report As...

To save a report with a different name and/or as a report template, click on  (Save As)
icon on the Report Designer's toolbar. You will be prompted for a file name and type. The
report or report template will be saved to the "Reports" sub folder of the folder storing your
project related information. The report or report template will also be saved in the project's
database, and will be made available in the appropriate node in the Project Tree. The report or
template can be deleted from the Project Tree if you choose not to store it in the database.

Exporting generated reports
Once a report has been generated, it can be exported to various formats, as well as being
saved in the Report Editor's native format. The native format stores reports with an RTF file
extension.

To export a report, click on the  (Export Report) icon on the toolbar. A dialog similar to
that shown in the figure below will be displayed.

Select the desired export format, provide a file name and path, specify settings relevant to the
format as desired and click on the [OK] button.
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Reports that are saved or exported from the report viewer are not directly managed by HGA
and as such will not be listed in the Project Tree.

17.7 Creating and Managing Report Templates
The Report Editor contains pre-defined templates which allow users to quickly and easily
create professional reports. Report templates can be edited, saved, and managed in the
Report Editor, and new templates may be created and saved for future use.

This feature allows users to have different report layout options for headers and footers and to
share them between two or more reports. This allows users to have as many report designs
as desired. For example, one or more report templates can be prepared for each client with
the specific header and footer. Another advantage of having a report template is that if the
header information using a certain template changes, the change will automatically be applied
to all reports that use the template without the need to reopen the report. For example, if the
client company's telephone number changes, the user needs to change only the template
instead of changing each report.

Each time a new report is created, previewed, or printed it will use the active report's layout
unless a template is specified.
Creating A Report Template

The Report Editor allows you to save the active report's design as a report template for future

use. Once you are satisfied with the design of the currently opened report's layout, click 
(Save-As button) to save it as a report template. In the dialog that is displayed, provide the
name for the template, check the box beside "Save as template" and click on "Save".

The template saves the header, the footer as well as the background for the detail section of
the current report. The detail section may have background watermarks such as "DRAFT",
"CONFIDENTIAL", etc. at desired angles and locations. The header and footer may contain:
relevant information for your company and/or client including logo, name, Address, Telephone,
Fax, e-mail, and web site address. The user can also configure properties such as: font,
alignment, etc. for the template.

Once a report template is created, it will be listed under the "Reports" node in the Project
Tree of HGA.
Opening a Report Template

Report templates can be opened by double clicking on them in the Project Tree of HGA. A

template can also be opened using the report editor directly by selecting the Open button 
from the Designer window's toolbar and setting the file filter to "*.WTP". Once a report
template is opened, it can be edited and saved.
Deleting a Report Template

In HGA, right-click on a report template in the Project Tree, and select the Delete option from
the menu, to delete the template. The selected template will be deleted both from the Project
Tree as well as from storage.
Setting a Report Template as Default Template
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To set a selected template as the default template, right click on the template and select the
"Set as default" option from the pop-up menu in HGA. The selected template will be set as
the default template.
Every time a new report is created, the default template will be used to furnish the header and
footer sections.

17.8 Import Reports from MS Access
The Report Editor allows you to import reports that are created in an MS Access 2000
database environment. This may be useful in cases where you migrate existing data from
MS-Access into HGA, and want to import existing reports as well.

The MS Access Importing wizard can be activated by clicking on the  (Import Access
Report) button on the Designer's toolbar. The wizard guides you through a number of steps to
import the desired report. These steps are explained in the following sections.
The following figure depicts the first screen of the wizard that presents some introductory text.

Clicking on the [Next] button displays the second dialog, requesting the MS Access
database name that will be used as a source for the reports to be imported. Provide the
database name by clicking on the Open Database [...] button to the right of the text box, or
alternately type in the name including the full path.
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Click on the [Next] button to display the next dialog, listing all reports that are available in the
selected database. Select the desired report and click on the [Next] button to proceed.

The dialog shown below will be displayed. It allows you to specify some settings that will alter
the converted report. The default values are fine unless a change is desired.
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Click on the [Next] button to start converting the report to the Report Editor's native format. A
dialog will appear displaying the progress of the report conversion. Once conversion is
completed, the dialog displays the summary report as shown in the following figure.

Click the [Finish] button and the converted report will be displayed in the runtime designer.
Once all desired modifications are done to the report, it can be saved using the procedure
discussed earlier.
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The final report can be visualized by clicking on the  (Report Preview) on the toolbar.
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18 Appendices

Appendices

18.1 Appendix A: Project Files and Directory Structure
An HGA project consists of many different files and folders related to the different
components within HGA. Please refer to the information below to determine what data is
stored in which folder:

Project Folder:
Project.vbh is a text file and contains the information on the connection string to the HGA
project, such as SQL server name, database catalog name, etc.
Project.vbh.bak is a backup of the .vbh file.
Project.vbx is a text file and contains the geotransformation settings of the project.

Map Subfolder:
The map folder contains all of the shapefiles associated with the map project. In the root, you
will find MapProjectName.VMP. This is an XML file that contains details on the map project,
such as the projection system, renderers, settings, cross-section lines, intersections, etc.
Each map project has a unique .VMP file.
Selection
When you create a new map layer from an HGA station group (or selected stations), a new
points shapefile is created and saved in this directory (i.e. boreholes.shp, boreholes.shx,
boreholes.dbf).
Data
When you create a new map layer from an HGA data query, or a map project, a new points
shapefile is created and saved in this directory. (e.g. Chem_Exceedences.shp,
Chem_Exceedences.shx, Chem_Exceedences.dbf)

Plumes Subfolder:
The plumes folder contains all of the files associated with the plume data once the 3D
interpolation has been conducted on a query.  The created .nc files are used when viewing the
plumes in the Scene Viewer.

Surfaces Subfolder:
The surfaces folder contains all of the gridded surfaces (.GRD files) created in the map project
by interpolating the current layer.  The gridded surfaces can also be used in the Scene
Viewer.

V3D Subfolder:
The V3D folder was used by the 3D Explorer module which has been replaced by the Scene
Viewer. 

XSection Subfolder:
The xsection folder contains all of the cross-section information from your project.  In the
xsection folder there is a subfolder for each cross section created in the project (i.e. AA, BB,
etc.).  The subfolders contain all the shapefiles associated with the cross section. 
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XInter
The XInter subfolder contains the shapefiles from the map project for the cross-section line.
BHLP
The BHLP subfolder contains image files for any well profiles drawn on the cross section. The
images are saved as .EMF format.

18.2 Appendix B: Advanced Interpolation Settings
INVERSE DISTANCE

The Inverse Distance Squared method is a very fast and efficient, weighted average
interpolation method. The weighting factor applied to the data depends on the distance of the
point from the grid cell, and is inversely proportional to the distance squared. Consequently,
the greater the distance the data point is from the grid node, the smaller the influence it has
on the calculated value.

The Inverse Distance Squared method for interpolation may generate patterns similar to a
"bull's-eye" surrounding points of observations. Selecting a larger number of nearest
neighboring data points may smooth this effect, but if the bull's eye pattern is undesirable,
then other methods of interpolation, like Natural Neighbor and Kriging, are recommended.

The Interpolator Options for the Inverse Distance Squared method is described below.
Start X Minimum X co-ordinate for the interpolation grid.
End X Maximum X co-ordinate for the interpolation grid.
X_Nodes Number of grid nodes in the X-direction.
Start Y Minimum Y co-ordinate for the interpolation grid.
End Y Maximum Y co-ordinate for the interpolation grid.
Y-Nodes Number of grid nodes in the Y-direction.
Use Log Interpolation Flag to interpolate the log values of the data. This setting is useful for
where some measured values are many orders of magnitude higher than the majority of the
other values. In such cases, the large values dominate the interpolation process and details in
the low concentration zones are removed. If this setting is selected, the log of each data value
is taken prior to performing interpolation. By interpolating the log of the data set, small values
are given more weight than otherwise.
Restrict Min Value Flag to restrict the minimum value of the interpolated data.
Restrict Max Value Flag to restrict the maximum value of the interpolation data.
Value Min Minimum value of the interpolated data. Any interpolated data less than Value Min
will be assigned a value of Value Min.
Value Max Maximum value of the interpolated data. Any interpolated data greater than Value
Max will be assigned a value of Value Max.
Real Min Real minimum value of interpolated data.
Real Max Real maximum value of interpolated data.
Num_Neighbors Number of nearest data points to use when calculating interpolated value for
each grid node.
Z_Only Allows the user to select between outputting the original X and Y values, plus the
interpolated value (x,y,f(x,y)), or the interpolated value only (f(x,y)). Note: This has no effect on
the actual contour output, and can be ignored.

NATURAL NEIGHBOR

The Natural Neighbor method (Watson, 1994) is based on the Thiessen polygon method used
for interpolating rainfall data. The grid node for interpolation is considered a new point, or
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target, for the existing data set. With the addition of this point, the Thiessen polygons based
on the existing points are modified to include the new point. The polygons reduce in area to
include the new points, and the area that is taken out from the existing polygons is called the
"borrowed area". The interpolation algorithm calculates the interpolated value as the weighted
average of the neighboring observations where the weights are proportional to the borrowed
areas. The Natural Neighbor method is valid only with the convex hull of the Thiessen polygon
formed by the data points, and values outside the hull extrapolation should be used with
caution.

The Natural Neighbor interpolation scheme may be visualized as a taut rubber sheet
stretched to satisfy all the data points. The interpolated value at any location is a linear
combination of all Natural Neighbors of that location, and the resulting surface is continuous
with a slope that is also continuous. Combining the gradients or slopes with the linear
interpolation provides results that are more smooth, and may anticipate the peaks and valleys
between data. Singularities and other undesirable effects may be lessened by incorporating
the gradient factor.

The gradient influence on the results can be manipulated by two tautness parameters that the
user can enter. These parameters allow the interpolated surface to vary from purely linear
interpolation to one which is well rounded and has the gradient factor. In all cases the slope
discontinuities are removed and the resulting surface has slope continuity everywhere.

The advanced settings parameters for the Natural Neighbor method are described below:
Start X: Minimum X co-ordinate for the interpolation grid.
End X: Maximum X co-ordinate for the interpolation grid.
X_Nodes: Number of grid nodes in the X-direction.
Start Y: Minimum Y co-ordinate for the interpolation grid.
End Y: Maximum Y co-ordinate for the interpolation grid.
Y-Nodes: Number of grid nodes in the Y-direction.
Use Log Interpolation: Flag to interpolate the log values of the data. This setting is useful
for where some measured values are many orders of magnitude higher than the majority of
the other values. In such cases, the large values dominate the interpolation process and
details in the low concentration zones are removed. If this setting is selected, the log of each
data value is taken prior to performing interpolation. By interpolating the log of the data set,
small values are given more weight than otherwise.
Restrict Min Value: Flag to restrict the minimum value of the interpolated data.
Restrict Max Value: Flag to restrict the maximum value of the interpolation data.
Value Min: Minimum value of the interpolated data. Any interpolated data less than Value
Min will be assigned a value of Value Min.
Value Max: Maximum value of the interpolated data. Any interpolated data greater than
Value Max will be assigned a value of Value Max.
Real Min: Real minimum value of interpolated data.
Real Max: Real maximum value of interpolated data.
Mag_X: X co-ordinate magnification factor
Mag_Y: Y co-ordinate magnification factor
Mag_Z: Z co-ordinate magnification factor
No_Value: Value assigned to nodes located outside the convex hull of the data points (where
interpolation is not performed)
Allow_Extrapolation: Is a flag to use extrapolation for nodes outside the convex hull of the
polygon formed by the data points. In this case linear regression is used to fit a plane through
the data set and calculate the interpolated value. This should be used with caution since
extrapolation is less reliable than interpolation.
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Sdip: Calculate the aspect and slope at each grid node. This can be used to augment the
elevation information. The aspect is measured in degrees or radians clockwise from north,
and the slope is measured positively below the horizontal plane in degrees or radians.
Tautness_1: Controls the influence of the gradient on the results and may be used to smooth
the interpolated surface.
Tautness_2: Controls the influence of the gradient on the results and may be used to smooth
the interpolated surface.
Use_Gradient: Blends the gradient calculation and the linear interpolation calculation to
produce a smoother surface.

KRIGING

Kriging is a geostatistical method that produces visually appealing maps from irregularly
spaced data. Anisotropy and underlying trends suggested in raw data can be incorporated in
an efficient manner through Kriging. The program used, called kt3d, is available in the public
domain from the Geostatistical Software Library (GSLIB), distributed by Stanford University,
and is well-documented by Deustch and Journel (1998). The program kt3d from GSLIB
performs simple Kriging, ordinary Kriging, or Kriging with a polynomial trend, and uses the
standard parameter file used by GSLIB. If the semi-variogram components have already been
modeled by the user, they can be incorporated into the program by choosing the appropriate
set of parameters in the parameter file. The semi-variograms available include Spherical,
Exponential, Gaussian, Power, and the Hole effect models. If the variogram information is not
available, the default linear variogram with no nugget effect should be used. This option is a
special case of the Power model with the exponent equal to 1.
The Interpolator Options window for the Kriging method is shown in the following figure, while
each of the settings parameters is described below
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Start X Minimum X co-ordinate for the interpolation grid.
End X Maximum X co-ordinate for the interpolation grid.
X_Nodes Number of grid nodes in the X-direction.
Start Y Minimum Y co-ordinate for the interpolation grid.
End Y Maximum Y co-ordinate for the interpolation grid.
Y-Nodes Number of grid nodes in the Y-direction.
Use Log Interpolation Flag to interpolate the log values of the data. This setting is useful for
where some measured values are many orders of magnitude higher than the majority of the
other values. In such cases, the large values dominate the interpolation process and details in
the low concentration zones are removed. If this setting is selected, the log of each data value
is taken prior to performing interpolation. By interpolating the log of the data set, small values
are given more weight than otherwise.
Restrict Min. Value Flag to restrict the minimum value of the interpolated data.
Restrict Max. Value Flag to restrict the maximum value of the interpolation data.
Value Min. Minimum value of the interpolated data. Any interpolated data less than Value
Min. will be assigned a value of Value Min.
Value Max. Maximum value of the interpolated data. Any interpolated data greater than
Value Max. will be assigned a value of Value Max.
Real Min. Real minimum value of interpolated data.
Real Max. Real maximum value of interpolated data.
Min. Trimming Limit Minimum bound for the interpolated data if the Restrict Min. Value
option is not selected by the user.
Max. Trimming Limit Maximum bound for the interpolated data if the Restrict Max. Value
option is not selected by the user.
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The Points per block along X, Points per block along Y, and Points per block along Z values
allow the user to choose Block Kriging used for interpolation, as compared to Point Kriging.
Block Kriging is based on the premise that since Kriging is a linear algorithm, direct
estimation of the block average is possible for user-defined blocks. The default values for
these parameters are 1, and in this case the default method is Point Kriging. If Block Kriging
is being used, the user needs to enter the Min. points for block Kriging and Max. points for
block Kriging.

The Octant Search option is an exhaustive search option available to make sure that data are
taken on all sides of the point being estimated, and is especially recommended for 3D data. If
the user specifies Max. points per octant to be greater than 0, an Octant Search is employed
to find the neighborhood of points for interpolation.

The Max. radius and Min. radius defines the search distances, in user specified units, in the
maximum horizontal direction and the minimum horizontal direction for determining the
neighborhood of points for interpolation. For isotropic data, the two radii are the same. Enter
the Vertical Radius value if 3D Kriging is to be performed. If the total number of points in the
data is large (>200), computation time for Kriging may be reduced by specifying a smaller
radius for the search.

The Angle1, Angle2, and Angle3 parameters define the search ellipsoid for situations in which
anisotropy is present in the data.

The Kriging type options are:
· Stationary simple Kriging with SK mean
· Ordinary Kriging
· Nonstationary simple Kriging with means from an external file
· Kriging with external drift

The following guidelines are recommended for selecting the type of Kriging.

Choose Stationary simple Kriging with SK mean, if the mean value is known and is constant
throughout the area.

Select Ordinary Kriging if the mean is not constant everywhere, and needs to be recalculated
dependent on the location of the neighborhood.

Choose Nonstationary simple Kriging with means from an external file if the mean is not
constant and has to be read from an external file.

Select Kriging with an external drift when only the trend component needs to be estimated,
and not the residual component, where the variable is assumed to be the sum of the trend
and the residual component. This option is also referred to as Universal Kriging.

For most situations, Ordinary Kriging is recommended and is the default option.

The SK Mean defines the global mean of the data if Stationary simple Kriging is performed.

The Drift term defines the drift components if Kriging with external drift is performed. Nine drift
components are possible:
· X = linear drift in x
· Y = linear drift in y
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· Z = linear drift in z
· Xq = quadratic drift in x
· Yq = quadratic drift in y
· Zq = quadratic drift in z
· XY = cross quadratic drift in xy
· XZ = cross quadratic drift in xz
· YZ = cross quadratic drift in yz

The Variable/Trend Estimate allows the user to choose between estimating the variable or the
trend. The default is Estimate variable.

The Nugget constant quantifies the sampling and assaying errors in the data. In a Variogram
plot the nugget constant is the y-intercept value.

The Use variograms option allows the user to select the type of variogram to be used. The
Variogram models available include:
· Spherical
· Exponential
· Gaussian
· Power
· Hole Effect

If the variogram information is not available, the default linear variogram with no nugget effect
should be used. This option is a special case of the Power model with the exponent equal to
1.

18.3 Appendix C: Map Manager: ISO Codes
None
1250: ANSI Central Europe, Latin 2
1251: ANSI Cyrillic, Slavic
1252: ANSI Latin 1
1253: ANSI Greek
1254: ANSI Latin 5, Turkish
1255: ANSI Hebrew
1256: ANSI Arabic
1257: ANSI Baltic Rim
1258: ANSI Vietnamese
437: OEM US, Latin
708: OEM Arabic, ASMO 708
720: OEM Arabic, Transparent ASMO
737: OEM Greek, formerly 437 G
775: OEM Baltic
850: OEM Western Europe, Latin 1
852: OEM Central Europe, Latin 2
855: OEM Russian, IBM; Cyrillic
857: OEM Turkish, IBM
860: OEM Portuguese, MS-DOS
861: OEM Icelandic, MS-DOS
862: OEM Hebrew
863: OEM Canadian Frech, MS-DOS
864: OEM Arabic
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865: OEM Nordic, MS-DOS
866: OEM Russian, MS-DOS; Cyrillic II
869: OEM Greek 2, IBM Modern Greek
8859-1: ISO Latin 1; West European-Danish, Dutch, English, Faeroes, Finnish, French,
German, Icelandic, Irish, Italian, Norwegian, Portuguese, Spanish, Swedish
8859-2: ISO Latin 2; East European-Albanian, Czech, English, German, Hungarian, Polish,
Rumanian, Serbo-Croatian, Slovak, Slovene
8859-3: ISO Latin 3; Southeastern European-Afrikaans, Catalan, Dutch, English, Esperanto,
German, Italian, Maltese, Spanish, Turkish
8859-4: ISO Latin 4; North European
8859-5: ISO English & Cyrillic-Based; Bulgarian, Byelorussian, English, Macedonian,
Russian, Serbo-Croatian, Ukrainian
8859-6: ISO Arabic
8859-7: ISO English & Greek
8859-8: ISO Hebrew
8859-9: ISO Latin 5; Western European & Turkish
8859-13: ISO Latin 6; Lativan and Lithuanian
ANSI: Uses the system code page
OEM: Uses the OEM equivalent of the system code page
ISO: Uses the ISO equivalent of the system code page
BIG5: Uses the ANSI 950 code page, also known as Big5; Chinese Taiwan, HongKong SAR,
PRC
SJIS: Uses the ANSI 932 code page, also known as Shift-JIS; Japanese
EUC: Uses the EUC(ISO) equivalent of the system code page

18.4 Appendix D: Online GIS Data Resources
U.S Bureau of the Census
http://www.esri.com/data/download/census2000_tigerline/
Data: Census 2000 TIGER/Line Data
Format: Shapefile
Geographic Coverage: United States, Puerto Rico, U.S Virgin Islands, American Samoa,
Guam, The Commonweath of Northern Mariana Islands, and the Midway Islands
Datum: NAD 83
Layer: Roads, Railroads, Rivers, Lakes, Legal boundaries, Census Statistical Boundaries etc.

NASA
ftp://e0srp01u.ecs.nasa.gov/srtm/
Data: Shuffle Radar Topography Mission (SRTM)
Format: Raster (SRTM)
Geographic Coverage: Global, SRTM1 (30m) for USA, SRTM3 (90m) World
Datum: WGS84/NAVD88
Layer: DEM

Natural Resources Canada
http://geogratis.cgdi.gc.ca/download/
Data: CGDI Warehouse
Format: Vector and Raster
Geographic Coverage: Canada
Datum: Various
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Layer: Landsat, RADARSAT, Canada Atlas, Canadian Geographic Information Systems
(Land Use), National Scale Frameworks, Census Data; Ontario Land use Cover, Canadian
Conversation Areas Database, State of Canada's Ecosystem.

CGIAR Consortium for Spatial Information (CGIAR-CSI)
http://srtm.csi.cgiar.org/
Data: Shuttle radar Topography Mission (SRTM)
Format: Geotiff or Arcinfo
Geographic Coverage: Global (90M)
Datum: WGS84/EGM96
Layer: DEM

Global Land Cover Facility
http://glcfapp.umiacs.umd.edu:8080/esdi/index.jsp
Data: Land Sat. TM Images
Format: GeoTiff
Geographic Coverage: Global, Up to 30m
Datum: WGS84
Layer: Landover Images

Land Information Ontario
http://lioapp.lrc.gov.on.ca/lids/welcome.asp
Data: NRVIS Data
Format: Coverage
Geographic Coverage: Ontario, Canada
Datum: NAD83 CNT
Layer: Airport, Annotation, Building, To Scale, Building As Symbol, Concession, Contour,
Crown Game Preserve; Drainage Line; Drainage Point; MNR District; MNR Region; Municipal
Park, National Wildlife Area; OBM DTM; Park Zone Reg; Pit or Quarry; Provincial Park Zone
Regulated; Railway Segment; Spot Height; Tank; Tower; Transport Line; Transport Point;
Utility Line, Utility Site; Water Edge; Water Structure; Waterboy Segment; Wooded Area.

GeoCommunity
http://data.geocomm.com/catalog/
Data: GIS Data Depot
Format: e00 format (coverage)
Geographic Coverage: Each Country; USA, each State and County.
Layer: DEM, NWI, DLG, LU/LC, and TIGER are available for free.

United States Geological Survey
http://seamless.usgs.gov/
Data: GIS Data Warehouse
Format:
Geographic Coverage: World, each country; USA, any scale and seamless:
Datum: NAD83
Layer: US National Elevation Dataset (up to 10 M), National Land Cover Dataset, High
Resolution Orthoimagery, Layer extent, Transportation, Boundaries, Hydrography.

Florida Department of Environment Protection
ftp://ftp.dep.state.fl.us/pub/gis/data
Data: GIS Data
Format: Shapefile
Geographic Coverage: Florida
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Datum: FDEP custom Albers projection in the HPGN datum
Layer: Environmental Data, Basemap Data

Global Forest Watch Canada Warehouse
http://www.globalforestwatch.ca/datawarehouse/datawarehouse.htm
Data: GIS
Format: Shapefile, GRID, XLS
Geographic Coverage: Canada
Datum: North American Datum of 1927
Layer: Forest related data; basemap data

GeoPlan Center, University of Florida
http://www.fgdl.org/
Data: Florida Geographic Data Library (FGDL)
Format: Shapefile
Geographic Coverage: Floridawide and County
Datum: FDEP custom Albers projection in the HPGN datum
Layer: Various

St. Johns River Water Management District
http://sjr.state.fl.us/programs/data.html
Data: GIS data
Format: Shapefile and Raster
Geographic Coverage: St. Johns River Water Management District, Florida
Datum: NAD83
Layer: Basemap, Natural Resources and Images

United States Geological Survey and USA Environmental Protection Agency
http://nhd.usgs.gov/index.html
Data: National Hydrography Dataset
Format: Geodatabase
Geographic Coverage: USA
Layer: Surface water features such as lakes, ponds, streams, rivers, springs and wells

United States Environmental Protection Agency
http://www.epa.gov/OWOW/watershed/landcover/lulcmap.html
Data: Land Cover Digital Data
Format: Coverage
Geographic Coverage: USA Statewide
Layer: Satellite, Land Cover

National Atlas (USA)
http://www.atlas.usgs.gove/atlasftp.html
Data: National Atlas Map (Warehouse)
Format: Shapefile, Geotiff, DBF
Geographic Coverage: USA
Datum: NAD83
Layer: Agriculture, Biology, Boundaries, Climate, Environment, Geology; History, Map
Reference, People, Transportation, Water.

United States Department of Agriculture
http://datagateway.nrcs.usda.gov/
Data: Natural Resources Data (Warehouse)
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Format: Shapefile and Raster
Geographic Coverage: USA
Datum: NAD83
Layer: Orthoimagery, Soils, Common Land Units, Cultural and Demographics, Governmental
Units and Place names, Elevation, Hydrography, Cadastral, Transportation (Roads), Digital
Raster Graphic (DRG) Scanned USGS quads, Land Cover/Vegetation/Plants, Watershed
boundaries (10-12 digit hydrologic units), Wetlands and Floodplain Easements, Climate -
Precipitation and Temperature, Flood hazards, USDA Office Information Profile (OIP), Applied
Conservation Practices, Water Control Infrastructure/National Inventory of Dams.

Grand River Conservation Authority
http://www.grandriver.ca/index/document.cfm?Sec=63&Sub1=16&sub2=0
Data: GRCA data
Format: Shapefile and Raster
Geographic Coverage: Grand River Watershed
Datum: NAD83
Layer: Airphoto, Topographic and Thematic Data

Ministry of Energy, Mines and Petroleum Resources, BC
http://www.em.gov.bc.ca/Mining/Geolsurv/MapPlace/geoData.htm
Data: Geology, Geochemistry
Format: Shapefile
Geographic Coverage: British Columbia
Datum: NAD83 and either BC Albers or Geographic (Decimal Degrees)
Layer: Geology, Geochemistry

Canadian Council on Geomatics
http://www.geobase.ca/geobase/en/index.html
Data: Geobase
Format: Shapefile and raster
Geographic Coverage: Canada
Datum: NAD83
Layer: Administrative Boundaries, DEM, Geodetic Network, Landsat, National Road Network

Ministry of Sustainable Resource Management, BC
http://srmwww.gov.bc.ca/gis/arcftp.html
Data: Warehouse
Format: Coverage, Raster
Geographic Coverage: British Columbia
Layer: Administrative Boundaries, Hydrology, Forest and more.

Alberta Geological Survey
http://www.ags.gov.ab.ca/mapserver/map236/download/download_gis.htm
Data: Geology, Geochemistry
Format: Shapefile
Geographic Coverage: Alberta
Datum: Geographic, NAD83
Layer: Geology

Alberta Community Development
http://www.cd.gov.ab.ca/preserving/parks/lrm/index.asp
Data: Parks and Protected Areas
Format: Shapefile
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Geographic Coverage: Alberta
Datum: NAD83
Layer: Parks and Protected Areas

Department of Provincial Treasury
http://www.gov.pe.ca/gis/index.php3?number=77868
Data: Warehouses
Format: Shapefile and MIF (Mapinfo)
Geographic Coverage: Price Edward Island
Datum: NAD83
Layer: Administrative Boundaries, Road, Forest, Hydrology

Department of Natural Resources, Nova Scotia
http://www.gov.ns.ca/natr/meb/DOWNLOAD/UTMNAD83.htm
Data: Natural Resources Data
Format: Shapefile
Geographic Coverage: Nova Scotia
Datum: NAD83
Layer: Natural Resources

New York State GIS Clearinghouse
http://www.nysgis.state.ny.us/
Data: New York State GIS
Format: Shapefile and Raster
Geographic Coverage: New York State
Datum: NAD83
Layer: Provinces and territories, census divisions, economic regions, census metropolitan
areas and census agglomerations, census consolidated subdivisions, census subdivisions.

Ontario Geological Survey
http://www.mndm.gov.on.ca/mndm/mines/ogs/draftbedrock_e.asp
Data: Digital version of the Paleozoic bedrock of Southern Ontario compilation map
Format: Geodatabase
Geographic Coverage: Ontario
Layer: Geology

Statistics Canada
http://www12.statcan.ca/english/census06/geo/index.cfm
Data: Road Network file; Boundary files for provinces and territories, census divisions,
economic regions, census metropolitan areas and census.
Format: Shapefile
Geographic Coverage: Canada
Datum: NAD83
Layer: Road and Administrative Boundary

18.5 Appendix E: Frequently Asked Questions (FAQ's)
Waterloo Hydrogeologic maintains an online Hydro GeoAnalyst FAQ:

http://www.waterloohydrogeologic.com/resources/hydro-geoanalyst-resources/hydro-
geoanalyst-faq

http://www.waterloohydrogeologic.com/resources/hydro-geoanalyst-resources/hydro-geoanalyst-faq
http://www.waterloohydrogeologic.com/resources/hydro-geoanalyst-resources/hydro-geoanalyst-faq
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If you cannot find the answer, please contact our technical support 
support@waterloohydrogeologic.com and they will be happy to assist you. 

18.6 Appendix F: Configuring Geotransformation Settings

Introduction
A Geotransformation is a mathematical operation that takes the coordinates of a point in one
geographic coordinate system and returns the same point in coordinates of another
geographic coordinate system.
Hydro GeoAnalyst supports one stage horizontal geotransformations between different
geographic coordinate systems. This is required for the following two reasons:
Hydro GeoAnalyst stores all spatial data, i.e., station x-y coordinates, in the GCS WGS 1984
projection system (lat and long coordinates). When data is imported, Hydro GeoAnalyst
converts the spatial data into GCS WGS 1984 coordinates. Likewise, when data is displayed
in HGA, it converts the data from GCS WGS 1984 to the original projection system defined in
the project settings. In order for HGA to store and display your data correctly, an appropriate
geotransformation has to be defined.
In some cases, it may not be possible to obtain certain geographic data in a coordinate
system that is consistent with the rest of your project data. In this case, a geotransformation
can be applied to express the data according to your project's coordinate system.
Note: Currently, Hydro GeoAnalyst does not support vertical (elevation) datum shifting.
Please ensure that your elevation data is consistent before importing into HGA.
Geotransformations can potentially occur in Hydro GeoAnalyst in any of the following
scenarios:
· When station data is displayed in the main Hydro GeoAnalyst window
· When data is imported into Hydro GeoAnalyst
· When data is displayed in Map Manager
· When data is imported in Map Manager
· When a projection system is defined in the new project wizard
As such, you may be prompted to specify geotransformation settings in any of the
aforementioned scenarios. Configuring a geotransformation is very simple and is described in
the following section.

Configuring Geotransformations
When Hydro GeoAnalyst detects that a geotransformation is required, it will check the
internal geotransformation settings to determine if the geotransformation has already been
defined. If not, it will prompt you with the following dialog:

mailto:support@waterloohydrogeologic.com
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From the Please Select Area dialog, choose the geographic area which best describes the
data extent.
Click [Ok] to save the settings. In subsequent scenarios when this geotransformation is
required, Hydro GeoAnalyst will automatically perform the geotransformation on-the-fly. In
other words, geotransformations only need to be specified once for the Hydro GeoAnalyst
project.
In some cases, such as importing data into HGA or loading a shapefile in Map Manager, if
the geotranformation has already been defined, you may be prompted to confirm the default
geotranformation (shown below).

When presented with this dialog, select [Yes] to accept the default geotranformation.
Otherwise, select [No] to return to the Please Select Area dialog (shown at top of page) to
select a new geographic area.
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19 Troubleshooting

When encountering difficulties with Hydro GeoAnalyst you may try reviewing the following
pages to try and resolve the issue.
We will be updating these page with additional information on a regular basis.

19.1 Connection Problems
There can be several different reasons for having difficulties connecting to a SQL Server
database.

1. Server not Running - you need to ensure that the SQL server is in face running or you will
not be able to connect to it. You can do this by typing services in the start menu. If you
see the prompt to Start the service that means it is not yet running. 

2. Permissions - you need to ensure that you have permission to the SQL Server and the
database you are trying to connect to. You may require your IT professional or Database
Admin to give you permission to a database if you are trying to connect to a Network SQL
server.

3. Local Database - did you want to try and connect to your local database that is installed
when you install HGA? You can do this in Management Studio just like you connect to
other SQL Servers. The naming convention is : (localdb)\instance name 

    You need to ensure that the localdb is within brackets.

4. If you are getting a message indicating your SQL Server does not have permission to
restore database from specified location it may be due to your SQL Server Properties
(found in your local services). Consider changing the Log On properties to Local System
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account and ensure Allow service to interact with desktop is checked on.  
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